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Implementation Notes
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Party_Open_Source_License_Information_for_FARO_Products#Overview

FARO Technologies Inc. Internal Control File Locations: \CONTROL\RECORDS\05MANUFA\PARTSPEC\07-SOFTWARE\..........
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Chapter 1: Introduction

SCENE is a comprehensive 3D point cloud processing and managing 
software tool for the professional user. It is specially designed for viewing, 
administration, and working with extensive 3D scan data obtained from high 
resolution 3D laser scanners such as the FARO Focus X.

SCENE processes and manages scanned data highly efficiently and easily by 
offering a wide range of functions and tools, such as filtering, automatic object 
recognition, scan registration, as well as automatic scan colorization.

After SCENE has prepared the scan data, you can begin evaluation and 
further processing right away. For this, it offers functions from simple 
measuring to 3D visualization through to meshing and exporting your scan 
data into various point cloud and CAD formats.

With SCENE, you may also create and upload SCENE WebShare Cloud data 
from your scan projects. With SCENE WebShare Cloud, your scan projects 
can be published on the Internet and viewed with a standard Internet browser. 

Customer Service If you have any questions or need further instructions for any procedure, 
contact your Customer Service representative by phone, fax or email. You can 
also reach the Customer Service Applications and Training group through 
email at the following addresses:

• support@faro.com

• applications@faro.com

• training@faro.com

Visit the FARO Customer Service area on the Web at www.faro.com to search 
our technical support database, which is available 24 hours a day, 7 days a 
week.

You may also find various online tutorials in the Internet at 
tutorial.faroeurope.com.

1.1 System Requirements

In order to use SCENE seamlessly, your computer should have the following 
specifications:

Minimal Specifications Recommended Specifications

Processor
• 64-bit (x64) with at least 2-gigahertz

(GHz) (For example, Intel Core i7)
• Quad-core x64

• Intel Core i7/Xeon, 8 physical cores
12
Chapter 1: Introduction



SCENE 2018 User Manual
Graphics Card

• OpenGL 4.1, or higher

• At least 2GB Memory.
For VR Rendering:
• NVIDIA 1060GTX or similar
• Oculus with Oculus Touch

Controllers or HTC VIVE
• SteamVR

• OpenGL 4.1, or higher

• At least 4 GB Memory

• Dedicated graphics card
For Stereo Rendering:
• NVIDIA Quadro
For VR Rendering:
• NVIDIA 1080GTX or similar
• Oculus with Oculus Touch

Controllers or HTC VIVE
• SteamVR

Main Memory At least 16GB 64GB

Hard Disk
256 GB Solid State Drive 512GB Solid State Drive + Regular 

HDD

Display 1366 x 768 1920 x 1080

Operating 
System

64-bit Windows 7 SP1 or higher

Accessories
Mouse with 2 buttons and a scroll wheel
Network connectivity is required for licensing 
13
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Chapter 2: Installation and Licensing

2.1 Installing the Software

1. Insert the installation USB stick supplied with the scanner.

2. Select the product and follow the installation instructions on the screen. An
installation wizard will guide you during installation.

Figure 2-1 SCENE installation startup

NOTE: You must belong to the group of administrators to install 
the software.

NOTICE

Uninstall any third-party software that interacts with SCENE 
and OpenGL software. This includes but is not limited to 
GPU performance and overclocking tools, gaming overlays, 
FPS counters and various streaming and recording tools. 
These tools are known to cause random SCENE crashes 
when working with 3D views.

The following third party software are not compatible with 
SCENE:

• Nahimic

• MSI Afterburner

• Lavasoft Web Companion

• Trimble Connected Community Explorer
14
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3. Read and accept the license.

4. Decide if you would like to have the User’s Manual installed with the
software.

5. If desired, create a new default folder.

Figure 2-2 Select Additional Tasks

6. Install Adobe FlashPlayer: You may clear the checkbox if you’ve already
installed the latest version. If you’re not sure about the installed version we
recommend to install FlashPlayer.

7. Decide if you want to be informed about SCENE updates. You will then be
notified if a newer SCENE version is available than you are using. A dialog
appears that shows the used version, the new version and a link to
download the .exe file for the new version. After downloading, you have
install the software manually.

8. If the new version is a major release (first or second number has been
incremented) you may need another license to use the new version. Select
the „Don‘t ask me again” checkbox if you don’t want to be informed again
about this new version, for example, if you want to download later.

9. Create a desktop icon: Select, if you would like to have the SCENE button
shown on your computer’s desktop.

10.Register file extensions (.lsproj,.fws, .fls): Decide if you want to open
scan projects by clicking the file name in Windows Explorer.

2.2 SCENE Licensing
Once installed, you may fully test SCENE for 30 days without the need of a 
software license. After the trial period, you need a permanent license to 
continue using SCENE.
15
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When purchasing SCENE you can select between two kinds of permanent 
licenses:

• Single-User Licenses

• Network Licenses (Floating Licenses)

Both types of licenses can be locked either to the computer where the 
software is installed (soft lock) or to a USB dongle (hard lock). An USB dongle 
is a device that you attach to the computer’s USB port.

You can buy Single-User Licenses and Network Licenses (Floating Licenses) that 
are linked to a software product key. Or you can obtain a USB dongle that 
already carries one single-user license or one or more network licenses.

If you already have a license and a maintenance contract and you want to 
update to a new version of SCENE follow the steps described in chapter 
Network Licenses (Floating Licenses).

2.3 License Manager
The License Manager provides an overview over all licenses available for the 
currently running SCENE version and helps you manage them. It offers the 
possibility to activate your product and to update licenses stored on your 
computer or on the plugged-in USB dongle. 

The License Manager is available under Settings > License Manager.

Figure 2-1 License Manager

The list in the dialog provides information about all the licenses available on 
your computer and in the network:

Stored On – Indicates where the license is stored on:

 License is stored on your computer.

 License is stored on a computer in the network (on a floating license 
server).
16
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 License is stored on the plugged-in dongle.

Feature – The licensed SCENE feature. Basic is the feature required to run 
SCENE.

License Type – Type of the license:

Trial – Limited trial license.

Perpetual – Full, unlimited and unrestricted license.

Other – Other types of licenses, for example full licenses that expire after a 
certain period of time.

Days Left – Days left until expiration (for trial licenses or time-restricted 
licenses).

Product Key /Host Name – If the license was activated with a product key, the 
product key will be shown. If the license is stored on a floating license server 
somewhere in the network, it will show its host name:

 Indicates that the displayed content is a product key.

 Indicates that the displayed content is the host name of a license server.

To get more information about the licenses, for example the licenses of other 
SCENE versions, follow the link in the dialog. This will open the Sentinel 
Admin Control Center.

To refresh the license list click the  button. New licenses will be highlighted.

Update Licenses

To update existing licenses stored on your computer or the attached USB 
dongle to a new version of SCENE, click the Update Licenses button. 

Transfer Licenses

To transfer a single-user license from one computer system to another, click 
the Transfer Licenses button. This opens a PDF document with details about 
how to transfer a SCENE, SCENE Process, or SCENE App license. The 
FaroRUS tool, that is required to perform the transfer, is also opened. Follow 
the process specified in the document to transfer the license.

To add a new license linked to a product key, click the Add Product Key button.

2.4 Single-User Licenses
The SCENE product key consists of not more than 18 characters, including 
numbers, letters and special characters. You may get a product key from:

• The back of the package

• Per mail if you bought from the FARO 3D App Center (3d-app-
center.faro.com)

• From FARO Customer Service.
17
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Once received, you must validate the key and use it to activate the SCENE 
license. To do this, take the following steps:

1. Start SCENE.

2. Open the License Manager which is available under Settings >
License Manager (if the trial period has expired will automatically open this
dialog at startup).

Figure 2-1 License Manager

3. Click the Add Product Key button to open the product activation dialog.
The Product Activation dialog opens.

Figure 2-2 Activation dialog – Automatic Activation

4. Select the tab Automatic Activation to use an automatic activation
method via Internet.

5. Enter your product key and click the Activate button.

6. SCENE will contact FARO’s license server to validate the entered key.
Depending on the Internet connection, this process might take up some
time.
18
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After key has been successfully validated, the license linked to the product key 
is permanently locked to your computer and SCENE is activated. The new 
license will show up in the license manager.

If the automatic activation fails, check your Internet connection or enter the 
product key again and retry. If activation still fails, you may activate SCENE 
manually. 

2.4.3 Manual Activation with a Product Key

Use the manual activation method if the automatic activation as described 
above fails. 

1. Start SCENE.

2. Open the License Manager under Settings > License Manager (if the trial
period has expired, SCENE will automatically open this dialog at startup).

3. Click the Add Product Key button to open the product activation dialog.

4. Select tab Manual Activation:

Figure 2-4 Activation dialog – Manual Activation

5. Enter your product key and click the Send button to create an activation
request file (a file with the file extension .ar) which must be sent to FARO
(this activation request file does not contain any private data):

NOTE: If your single-user license is locked to your computer and if 
you change your hardware, or if you want to use SCENE on a 
different computer, you will have to renew the license because it is 
bound to some hardware components of your computer. Contact 
customer service for assistance.
19
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• If an email client is properly installed on your system an email with the
activation request file attached will automatically be generated. Just
send this email to the provided address.

• If an email client is not installed on your system, you will be prompted to
save the file to your hard disk. Attach this file to an email and send it to
the provided email address.

After the email has been sent to FARO, you will receive an automatic email 
with an activation file (a file with the extension .v2c). 

Save this file to your hard disk, add it to the Manual Activation dialog under 
Process Activation File, and then click Activate. Your product should now be 
activated and have a permanent license.

If you do not have an Internet connection, you may contact FARO’s customer 
service team to receive an activation file.

2.4.5 Licensing with an USB Dongle

This licensing option is not bound to a single computer and adds mobility of 
the license between multiple computers. The license is recorded into an USB 
dongle which can be attached to an USB port on any computer running 
SCENE. After it is attached, SCENE has a valid license and can be used as 
normal; validation and activation over the Internet are not necessary.

2.5 Network Licenses (Floating Licenses)
Network licenses are hosted by a license server computer and will be shared 
to client computers over the network. If you start SCENE on any computer in 
your network it will search the network for available licenses. If one is found, it 
will use this license for the time it is executed. When closing SCENE, the 
license will be released again and will be available to other SCENE 
installations in the network.

Network licenses can either be locked to a dongle attached to the server’s 
USB port or to the computer where the licensing software is installed.

2.6 Updating Licenses to a New Version of SCENE
Customers with maintenance contracts can automatically update existing 
licenses if SCENE was updated to a new version and a new license is 
required for that version. 
20
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To update existing licenses stored on your computer or USB dongle for a new 
version of SCENE, open the License Manager under Settings > 
License Manager: 

Figure 2-1 License Manager

Click the Update Licenses button. SCENE will contact FARO’s license server 
and search for a valid maintenance contract. Depending on the Internet 
connection, this process might take some time. 

After a valid contract is found, an updated license for the currently running 
SCENE version will be locked to your computer or dongle. The license for the 
new version of SCENE will show up in the License Manager.
21
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Chapter 3: Starting up with the Projects Overview

3.1 Starting SCENE
SCENE always starts with the Projects Overview window. This chapter 
describes how it works and how you can change its view.

The Projects Overview presents all the scan projects which are saved in your 
project folder. When you start SCENE for the first time, this may mean that you 
will not see any projects.

3.1.1 Updates and News

When SCENE starts for the first time, the Updates and News window is 
displayed. This window provides you with the latest information from FARO 
about SCENE, including information about software updates, training, apps 
and so on. If you want to see the information again next time you start SCENE, 
click CLOSE. If you don’t want to see the information again click DISMISS and 
then CLOSE. The information is always available from the Check for Updates 
button on the Settings page.

3.2 Known projects
SCENE will verify all known projects at startup. Only existing projects will be 
shown in the Projects Overview.

Figure 3-1 Projects Overview window

1. Search field. Start typing, and SCENE will automatically show scan projects
which names fit to what you type.

2. Show the scan projects either as a list view, or as a tile view.
22
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3. Scan projects shown with preview image. Hover with the mouse to see a
short description of the scan project. This short description corresponds to
what you see in the list view.

3.2.2 Opening scan projects

• In the tile view, click the project's preview image.

• In the list view, click the line of the scan project.

• Drag and drop a scan project file (ending: .lsproj) from a file system into the
Project Preview.

• Drag and drop a scan file (ending: .fls) from a file system into the Project
Preview. A new scan project will be created and opened.

3.3 Project Details
After the scan project is opened, the Project Details will be shown.

Figure 3-1 Project preview with two status tiles

Modifying preview 
picture

If the preview image is not the one you want to see at this place, you can 
replace it by another one. Only images in .jpg or .jpeg format are allowed.

1. Hover over the preview image. The Change Image button appears.

2. Click the Change Image button.

3. Browse to a folder, and select the image.

4. Click the Open button to replace the image.

Number of scans The number of scans belonging to the scan project.

Recording period Date and time when scanning was started, and date and time when scanning 
was finished. Times shown here are in local time.
23
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Modified Date and time when the scan project was modified for the last time.

Location Add a position to your project to make the Google Maps View feature 
available. 

The coordinates must be entered in decimal notation, first the latitude, then 
the longitude.
Here are some example coordinates:

Google Maps

If positional information is provided for a project, the Google Maps View 

button  becomes available in the project’s preview. Clicking this button will 
open a Google Maps view of the project’s location in your default web browser.

Path The path of the folder in which the scan project is saved.

Description You can enter a description of your scan project.

Read-only projects Projects that can not be opened with write access are read-only. This happens 
for example if the project is opened by another SCENE instance. In this case, 
SCENE will show a message box while loading the project.

After the loading is finished, the project will be shown as read-only with a 
warning message at the top of the project dashboard. The Save button is 
disabled. As an additional hint for the user, the SCENE title bar contains a 
read-only hint. 

3.4 Status tiles
Depending on your scan project, different status tiles may be shown. The 
order of the status tiles corresponds to the workflow steps in the Workflow bar.

Each status tile shows the status regarding one specific step of handling a 
scan project.

A status tile may typically consist of color coded badges, a description text, 
and an action button.

Depending on the status of the tile, the action button is disabled or enabled. 

Moscow: 55.758032 37.617188

Sydney: -33.870416 151.204834

Rio de Janeiro: -22.902743 -43.214722

Seattle: 47.606163 -122.332764

NOTE: The status tiles and their buttons are meant as information, 
and offer a short way to access a specific function. It is not 
mandatory to click the buttons, you can likewise click one of the 
toolbar buttons.
24
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3.4.1 Status Tile „Processing“

Figure 3-2 Processing Tiles

The Processing status tile shows the current processing status of the scans 
inside the project. 

The colored badges in the Processing Tile categorize the scans of the project 
into three categories:

Green: The Scan has been processed and has an up-to-date Scan Point 
Cloud.

Yellow: The Scan has been processed but does not have an up-to-date Scan 
Point Cloud. 

Red: The Scan has not been processed yet.

Processing Status 

The processing status of scans is displayed as follows: 

• The status color of the tile is gray if there are no scans in the project.

• Tile and badge are green if all scans are processed and have the updated
Scan Point Clouds.

• The status color of the tile is yellow if the yellow badge is visible and the red
badge is not visible. This means that all scans in the project were
processed, but for some scans, Scan Point Clouds must be regenerated.

• The status color of the tile is red if the red badge is visible, when there is at
least one scan that was not processed at all.

Click the Process Scans button to start processing. 

The  task will open. For more details, see Processing Settings

3.4.3 Status Tile „Registration“

The Registration status tile shows the current registration status of the scan 
project. 

The tile will show different badges which show the number of clusters for each 
registration state. 

NOTE: Scans that have been processed with SCENE 6.0 or lower 
must be processed again to have an up-to-date Scan Point Cloud, 
and to utilize the full functionality of SCENE 7.1.
25
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An additional badge showing the mean point error is displayed if all clusters 
were successfully registered. 

All information corresponds directly to the information shown in the registration 
dashboard and the registration report.

Each badge type has a tool tip with additional information.

The tile can have three different states which correspond directly with the 
current state of the workspace in the Registration dashboard. These states are 
symbolized by colors:

Grey

• The currently open project does not contain any clusters or scans.

• The Registration button is disabled.

Orange

There are still clusters which need some user interaction in order to be 
successfully registered.

• Red badge: the number of unregistered clusters.

• Orange badge: the number of incomplete clusters.

• Green badge: the number of finished clusters.

 Click the Registration button to switch to the registration dashboard.

Green

All clusters are successfully registered.

• Green badge: the number of finished clusters.

• Red, orange, or green badge will show the overall mean point error. This
number is also shown in header of the registration report with the same
color coding, which depends on how high the error is.

 Click the Show Report button to switch to the registration report.

3.4.4 Status Tile „Project Point Cloud“

The Project Point Cloud status tile shows the current processing status of 
Project Point Cloud (PPC). 

Status colors

Tile and badge are gray if no Project Point Cloud exists for this project. 

Click the Create button to create the Project Point Cloud.

NOTE: The workspace itself is not considered a cluster.
26
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The Point Cloud Creation dialog will open.

Orange: A Project Point Cloud in a legacy format exists.

Click the Update button to update the Project Point Cloud.

First, the legacy Project Point cloud will be deleted, and the new Project Point 
Cloud is created afterwards.

Green: A Project Point Cloud in the current format exists.

A green badge will show the total number of scan points within the Project 
Point Cloud.

Click the Explore button to switch to the Explore category where the Project 
Point Cloud is shown in a 3D View.

NOTE: If the registration is not yet complete, i.e., the registration 
tile is not green, a warning message is displayed which 
recommends finishing the registration before creating the Project 
Point Cloud.
27
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Chapter 4: Navigation

4.1 Introduction
This chapter introduces to the toolbars and buttons which help you to navigate 
through a scan or point cloud.

 Composition of the SCENE Window

After you have opened a scan project, the SCENE window appears. This 
window is made up of the following areas:

Figure 4-1 Composition of the SCENE window

 Workflow Bar 

The Workflow Bar guides you through a series of steps to process a scan 
project. All steps are structured in a similar way which will help to get familiar 
with all the functions.

NOTE: SCENE LT 7.2 provides all the features needed to finish 
typical scan projects. For some advanced features, however, you 
must switch to the classic style user interface by clicking Switch UI 
in the Settings toolbar.
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 Toolbar

The Toolbar provides a quick and easy way to access features.

 Structure Window

The Structure Window displays the structure of the workspace, including all 
folders and objects. If you click the name of those folders and objects with the 
right mouse key, a so-called context menu will open which offers specific 
functions.

By default, the Structure Window is folded away. If you want it to stay visible, 
click the Structure button, then click the thumbtack button.

 Scan and object views

Shows the visual presentation of the scan data and other objects. Scans and 
objects can either be displayed in a Quick View, a detailed Planar View, or in 
3D View.

If you click the scan data and objects with the right mouse key, a context menu 
will open which offers specific functions.

 Navigation toolbar (3D view only)

Offers a quick and easy way to a number of navigation modes. Offers several 
view, for example gap filling or point sizes.

 Coordinate axes

Shows the viewing direction by means of x, y, and z coordinate axes.

 Status bar

Displays command and scan point data details.

4.2 Workflow Bar
The Workflow bar and its buttons provide easy access to the usual steps with 
which a scan project is processed. Working through the steps from the left to 
the right should lead to a satisfactory result.

Figure 4-1 Workflow Bar

 Select the Save icon to save the currently open scan project.

 Select the Project category to find the features for your entire scan project.

There are two sets of tool bars, one that shows up when no scan project is 
opened, and one that shows up when a scan project is opened.

 Select the Import category to import scans, projects, images, or SCENE 
WebShare Cloud data.

      
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 After importing, select the Processing category to determine how the raw 
scan data will filtered, colorized, and otherwise modified to make it more 
useful.

 Select the Registration category to open the Registration features. 

Select the Explore category to add annotations, measurements, viewpoints, 
or clipping boxes.

Select the Export category to export scan points, the point cloud, or the scan 
project. You can create data for SCENE WebShare Cloud, and upload this 
data afterwards.

 This icon opens the Apps feature.

This icon opens the Settings for the categories.

 Click the Help icon to open this document.

 Click the Knowledge Base icon to create and monitor support cases, 
access asset information, update contact information, submit product 
ideas, and more.

4.3 Tasks and Task Steps

Figure 4-1 Task steps
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 The task that is currently being executed, and the several steps of that task 
that are performed sequentially.

 Completed Step

 Completed Step you can go back to. You can go back only one step at a 
time. Changes will not be reversed (for example, the result of a 
registration).

 Active Step

 Upcoming Step

 Navigation Buttons

• Cancel button exits the current task. It does not undo changes.

• Continue button is only active (green) if all necessary prerequisites of the
current step are fulfilled. It either goes to the next step, or finishes the
task.

 Name of currently active task step.

 Optional description and tools of currently active task step.

 Work area, for example 3D Views and additional information …

4.4 Color Coding
While you are working with SCENE, you will notice different colors, for 
example header lines, buttons, traffic light symbols, or messages. Those 
colors are meant to be an additional information.

Figure 4-1 Color coding 

Blue: stands for an information, or shows an active step.

Green: all is fine! For buttons: you can now click it to continue.

Yellow: something is not working properly, or there is legacy data. Check and 
fix.
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Red: something went wrong, or some step was not processed yet. Check and 
fix.

4.5 Navigation Toolbar (3D View only)
A navigation toolbar is displayed only with the 3D scan view. 

Figure 4-1 3D Navigation toolbar

The following options are available in the 3D navigation toolbar. For details, 
click the links: 

View Modes 

Camera Modes

View All

Predefined Views

Center of Rotation

Last Camera Position

Align Camera on Point

Toggle Clipping Boxes

Supersampling 

Gap Filling 

Clear View

Adaptive

Point Sizes

4.5.2 View Modes

Figure 4-3 View Modes
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Examine Mode Clicking the Examine Mode button  starts the object-based navigation, it 
seems as if the objects move while you stand still.

Smart Mode The Smart Mode  combines different navigation modes. 

A ring is used to divide the view into different zones. When starting the actual 
navigation by clicking the mouse button, different navigation modes will be 
used depending on the zone.

Figure 4-4 SCENE with activated Smart Mode

The navigation ring disappears when the mouse is not moved anymore, or 
while you are clicking and moving the view. It appears again as soon as you 
hover with the mouse.
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2 Zone navigation (default)

A thin ring visualizes the two zones. The cursor of the mouse gets updated 
depending on the position of the mouse cursor.

Figure 4-5 2 Zone navigation

 Fly Mode: activated if the mouse cursor is in the inner of the ring.

 Examine mode: Activated if the mouse cursor is in the outer area of the 
ring.
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3 Zone navigation

A thick ring visualizes the three zones. The cursor of the mouse gets updated 
depending on the position of the mouse cursor.

Figure 4-6 3 Zone navigation

 Fly Mode: Activated if the mouse cursor is in the inner of the ring.

 Roll Mode: Activated if the mouse cursor is on the ring.

NOTE: To set the 3 Zone navigation, you must switch to the 
SCENE 5 style user interface by clicking Settings > Switch UI. In 
the old UI, select Tools > Options, then click the Navigation tab.
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 Examine Mode: Activated if the mouse cursor is in the outer area of the 
ring.

Figure 4-7 Scenery with Roll mode

To do this, click the ring and drag the mouse in any direction. A circle will 
appear in the middle of the view, indicating the rotation angle.

Fly Mode The Fly Mode  of the observer-based navigation simulates flying through 
the 3D world.

• Clicking and dragging the 3D View with the mouse simulates a flight around
the scanner’s position.

• The cursor keys left, right, up, and down turn your head to the left, the right,
forward, and backwards.

• The keys page-up and page-down move you up and down.

• In addition, you can press the shift key to accelerate these movements.

Pan Mode There is no turning available in this navigation mode. Mouse movements are 
interpreted as observer movements.

Walk Mode The Walk Mode  of the observer-based navigation is similar to the fly mode 
but you are constrained by the XY plane, you travel along the XY plane. For 
example, the walk mode is useful to stay at the same height.

4.5.8 Camera Modes

Figure 4-9 View Modes
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Perspective Normally, the 3D View displays the scan points and objects with the correct 
field of view, in other words, objects of the same size appear smaller with 
increasing distance. 

Orthographic You can also change the view to an orthographic representation. Then, objects 
of the same size always appear the same size, regardless of how far away 
they are. This type of representation is common in a lot of CAD systems.

4.5.10 View All

(Not available in the Quick View)

Figure 4-11 View All

Changes the position of the observer in such a way, that a view on all the 
objects is achieved.

4.5.12 Predefined Views

Figure 4-13 Predefined Views

Changes the position and viewing direction to view the complete SCENE from 
top, bottom, right, front, back, or in an isometric view.

4.5.14 Center of Rotation

The center of rotation (rotation point) is somewhere in the 3D world. It is set 
automatically by some functions, for example, when using the object-based 
navigation.

In the Fly mode, the center of rotation is set to the position of the observer.

NOTE: Double-click a scan point to fly to a location. SCENE will 
then zoom into the SCENE and close to the selected scan point. 
Cancel the movement by clicking and moving the view with the 
mouse, or with the respective keys.
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To set it manually, click the Set rotation point button , then click the scan 
point or object.

4.5.15 Last Camera Position

The Last Camera Position button  moves camera to the last camera position.

4.5.16 Align Camera on Point

Click the Align Camera on Point button , then pick a point in the 3D View to 
align the camera position to an estimated surface. The center of rotation will 
be set to the picked point.

4.5.17 Supersampling 

Switches supersampling on or off. 

Supersampling renders the point cloud with a resolution higher than the 
resolution of your screen, and then shrinks the point cloud to fit the screen 
resolution. 

This reduces anti-aliasing effects and gives the point cloud a smoother visual 
appearance. Fine and filigree structures look sharper, and stray points will 
appear less annoying. Set the resolution of the initially rendered point cloud 
compared to the screen resolution by selecting one of the options 2x2, 3x3, or 
4x4.

For example, selecting 2x2 means that the point cloud will be rendered with a 
resolution that is 4 times the resolution of your screen.

4.5.18 Gap Filling 

Switches gap filling on or off.

If switched on, it will fill gaps between scan points that are physically close to 
one another. Gap filling can be defined as a predefined setting.

4.5.19 Clear View 

Switches Clear View on or off. Clear View can be defined as a predefined 
setting.

NOTE: Objects like walls might appear transparent when using 
small point sizes in combination with supersampling.

High supersampling resolutions like 4x4 require large amounts of 
graphics card memory.
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4.5.20 Toggle Clipping Boxes 

If there are Clipping Boxes (3D View) placed in the 3D View, you can switch 

these on or off with the Toggle Clipping Boxes button .

4.5.21 Point Sizes

Figure 4-22 Point size settings

Toggles adaptive point size mode, and switches through three different point 
size settings.

4.5.23 Adaptive

 Adaptive point size means, that if activated, the displayed size of each 
point adapts to its distance to the observer. The closer a point is to the 
observer, the larger it gets. 

If adaptive point size is deactivated, points always are drawn with the same 
size in pixels. They get displayed with the same size on screen, no matter how 
distant from the observer they are located.

The three point size buttons scale the size of the points on the screen and can 
be used to influence the density of point visualization.

The 3D View is used just like the other views. In addition, in the 3D View you 
can position yourself at arbitrary positions in space and have a look at the 
scan points and CAD models. The mouse is used to define the turning 
movements you want to perform, and with the keyboard you define the actual 
movement in space.
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Chapter 5: Settings

5.1 Settings Page
The Settings page provides options to specify or edit all SCENE settings in one 
place. All changes (except language changes) are immediately visible and 
applied after returning to a scan project.

Figure 5-1 Settings button

1. Click the Settings icon  on the right side of the Workflow Bar.

2. Check the settings. If one of the settings is shown collapsed, click the
header line to open it.

3. Modify the settings, if required.

4. Move to another setting. Your changes are immediately applied.

5.2 Settings Toolbar
The Settings toolbar offers some more functions:

Figure 5-1 Settings features

5.2.2 License Manager

The License Manager provides an overview over all licenses available for the 
currently running SCENE version and helps managing them.

5.2.3 Switch User Interface

To access some SCENE functions, you must switch to the SCENE 
Classic user interface.

Back button 

Click the Back button to exit the Settings page, and to return to the Workflow 
Bar.

NOTE: Settings are valid for all scan projects. As soon as you start 
working on a new scan project, it might be necessary to adjust 
some settings.
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Reset All Settings button 

Resets all SCENE settings to their predefined values.

A confirmation box similar to the reset of the individual categories will be 
shown. 

5.2.4 Check for Updates

Click this button to open the Updates and News window. This window provides 
you the latest news from FARO about SCENE and SCENE Apps, 
demonstration videos, software updates, and more. This information is also 
displayed when you start SCENE, but you can see it any time by clicking this 
button.

NOTE: Reset All Settings does not only reset the settings visible 
and accessible in the new UI, but also all settings only accessible 
in the SCENE classic style user interface. Hidden and 
undocumented registry settings are also removed/set back to their 
predefined status.
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5.3 General Settings
The General Settings page offers settings which are typically made only once 
and which are valid for all scan projects, for example country-specific settings, 
or the folder in which scan projects are to be saved.

Figure 5-1 Settings: General Settings

5.3.2 Language

Select the language of the user interface. 

5.3.3 Units

Select the units in which length and angle values are displayed.

The following options are available: 

Length

Select one of the units of length:

• metric: Millimeter [mm], Centimeter [cm], Meter [m], or,

• Imperial: Inch [in], Feet [ft], Yard [yd], or,

NOTE: The new language will be applied after a restart of SCENE. 
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• US surveyor: Inch [in US], Feet [ft US], Yard [yd US].

The predefined setting is “Meter [m]”.

Small sizes

Select one of the units for defining sizes. The options available are same as 
those for the Length option.

The predefined setting is “Millimeter [mm]”.

The small sizes setting is used when presenting dimensions that are very 
small, such as the tensions the registration reports.

Angle

Select one of the units of angle: Degree [°], Radian [rad], or Gon [gon].

The predefined setting is “Degree [°]”.

5.3.4 Project Folder

The project folder is in the predefined folder where scan projects will be saved. 
All projects listed in this folder will be displayed in the Project Selector. When 
you first open SCENE, the predefined project location will be a folder in 
C:\Users\<YourName>\Documents\FARO\Projects. 

1. Click the Browse button  to open the file system browser. You can not 
enter a project folder path directly into the field.

2. Browse to the folder, or create a new folder.

5.3.5 Log File

In case of technical problems with SCENE, the FARO customer service may 
ask you for log files.

Enable logging if you experience problems during operating, and specify a 
folder in which the log files shall be saved to. When you first open SCENE, the 
predefined log file location will be a folder in 
C:\Users\<YourName>\temp\SCENELogs. 

1. Select the Enable Logging check-box.

2. Click the Browse button  to open the file system browser. You can not 
enter a log file path directly into the field.

3. Browse to the folder, or create a new folder.

NOTE: Only one folder can be defined as project location. If you 
need to have additional project locations, you can use symbolic 
links to refer to those locations. 

The symbolic links must be placed your project folder and can 
point to an arbitrary folder (for example, on another drive).
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SCENE will then create log files which will be placed in the selected folder. 

There will be one SCENE log file which contains overall information.

For operations like SCENE WebShare Cloud Export and Upload, separate log 
files are created.

5.3.6 Temporary Data Folder

This folder is used to buffer data during complex processes, for example the 
creation of point clouds. Therefore, sufficient disk space should be available.

When you first openSCENE, the predefined project location will be a folder in 
C:\Users\<your name>\AppData\Local\Temp\SCENETemp. 

1. Click the Browse button  to open the file system browser. You can not 
enter a temporary data folder path directly into the field.

2. Browse to the folder, or create a new folder.

5.3.7 Reset General Settings

The Reset General Settings button will reset all the settings of this page. 

1. Click the Reset General Settings button. A message box will be opened.

2. Confirm the reset by clicking the OK button.

The settings will be reset and the UI will automatically update to reflect the 
new settings.

5.3.8 User Interface

This section provides the option to activate or deactivate Scanning category or 
Tab in the user interface.

Check the Show Scanning Category option to activate Scanning.

5.3.9 Updates

SCENE version update checking can be enabled or disabled in the SCENE 
settings.

Check the Enable Automatic Update Checking option to activate update 
checking.

When enabled, the update checker checks directly at startup, if there is a new 
SCENE version available. Internet connection must be active on your system, 
for this option to function.

5.3.10 FARO Customer Experience Improvement Program

When you install SCENE, you are asked if you want to participate in the 
Customer Experience Improvement Program. If you click yes, anonymous 
usage statistics are sent to FARO. We collect the following information:
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• The version number of the SCENE instance.

• The date and time that SCENE started and stopped. This allows us to
detect crashes.

• The execution of some specific commands where we want to get more
information about how they are used.This helps us to improve the software
in the future and helps us understand what may have caused a crash.

• Tracing information that we have added to the software in order to help us
investigate defects that have been reported, but which we cannot
reproduce.

We use this information to help us understand how customers use SCENE so 
we can continue to make the software better. On the settings page, you can 
change your decision at any time.

5.4 Import settings
When importing scan data, it is often necessary to define the unit of length. In 
the Import settings page, you can set a default unit of length which is required 
for the import of some file format. Other determining parameters are to be set 
in the respective Import dialogs.

Figure 5-1 Settings: Import

5.4.2 Units

Default unit of length

Select one of the units of length:

• metric: Millimeter [mm], Centimeter [cm], Meter [m], or,

• Imperial: Inch [in], Feet [ft], Yard [yd], or,

• US surveyor: inch [in US], Feet [ft US], Yard [yd US].

The default setting is “Meter [m]”.

5.4.3 Reset Import settings

The Reset Import Settings button will reset all the settings of this page. 

1. Click the Reset Import Settings button. A message box will be opened.

2. Confirm the reset by clicking the OK button.
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The settings will be reset and the screen will automatically update to reflect the 
new settings.

5.5 Processing Settings
The Processing settings will be applied when a Process operation is started 

through the Process Scans button , or the Process Scans command in the 
context menu of a scan or cluster.

Figure 5-1 Settings: Processing, General
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5.5.2 General

Colorize Scan

If enabled, the scan will be colorized using the camera pictures. 

Create Scan Point Clouds

If enabled, a scan point cloud for each scan will be created as last part of the 
processing.

Automatic Registration

Select that the project should be registered with an automatic registration after 
the processing of scans finished successfully.

The method used for the automatic registration is the method selected on the 
page.

5.5.3 Filters

In order to identify an inaccurate scan point, the filters compare the scan point 
with the scan points in the surrounding area. Some of them are filtering is 
performed based on information from the point. The surrounding area is 
oriented towards the scanner's recording technique, in other words, it is 
oriented towards the rows and columns, as they can be seen the Planar View.

Figure 5-4 The area surrounding a scan point, in a 2D grid

In Figure 5-4 the surrounding area oriented towards the recording point is 
shown. The single scan point marked has the scan points within the 
surrounding square in its near vicinity. Using filters, you can set what should 
be regarded as the surrounding area. In this example, the value 5 was set, 
which means the edge length of the surrounding square is 5.

NOTE: The Colorize Scans and Create Scan Point Clouds 
settings are enabled per default. Changing these settings 
will change the default values that are used for processing 
scans. 

Evaluated 
pixel
Evaluated 
pixel
Evaluated 
pixel

Grid size 

(5x5 pixel)
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Dark Scan Point Filter

The Dark Scan Point Filter removes points based on a reflectance value. 
Reflectance Threshold: indicates the minimum reflectance value a scan point 
must have. The Reflectance Threshold range is: 0 to 2048.

This criterion is useful because with a dark scan point, only a very small 
amount of light entered the scanner and therefore the measurement will have 
an increase in noise.

Distance Filter

The Distance Filter simply removes all scan points which are outside of a 
certain distance range. All points with a distance less than the Minimum 
Distance will be deleted, as well as all points that have a larger distance than 
the Maximum Distance.

Stray Point Filter

The Stray Point Filter checks if the 2D grid cell of a scan point contains a 
sufficient percentage of points with a distance similar to the scan point itself.

Grid Size: the size of the surrounding area used for comparison. For each scan 
point of the scan or selection, the filter takes the valid scan points of this 
surrounding area and counts how many of them are at a distance to the 
scanner which is approximately the same as the distance of the scan point 
currently being viewed. 

Distance Threshold: A scan point is counted if the difference in distance is 
smaller than the Distance Threshold. 

Allocation Threshold: If at least the percentage of scan points indicated by the 
Allocation Threshold in the surrounding area is also within this distance 
threshold, the scan point remains in the scan. Otherwise it is removed.

Edge Artifact Filter

The Edge Artifact Filter is enabled by default. The filter is especially useful to 
remove artifacts at the edges of objects.

5.5.5 Find Targets

In the Find Targets section you indicate what types of targets, if any, that 
SCENE will try to find in the scans during processing. The target types are 

NOTE: This filter is not applicable on colorized scan points.

NOTE: The Stray Point Filter is very well suited to correcting 
incorrect scan data. It also works well, if the Allocation Threshold is 
below 50%. However, the filter must not be applied on surfaces 
that were strongly inclined versus the scanner’s laser. The filter is 
always applied to the whole scan. It is not possible to apply it only 
in selected areas.
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checkerboards, markers, planes, and spheres. For information about which 
types of targets are best for your situation, how to position them, etc., see 
Targets on page 102.

Active Sphere Radii Create a global list of sphere sizes. These sphere sizes will be used for target 
detection.

This list of user-defined sphere sizes will be shown in the settings page for 
future processing runs. 

Inactive Sphere 
Radii

Specify additional sphere radii for sphere detection. 

Drag & drop the sphere radii that are not required for the SCENE project, from 
the Active Sphere Radii to the inactive Sphere Radii list. 

You can easily move items between the two lists and manage the sphere radii 
throughout the different scan projects.

5.5.6 Reset Process Scans Settings

The Reset Processing Settings button will reset all the settings of this page. 

1. Click the Reset Processing Settings button. A message box will be opened.

2. Confirm the reset by clicking the OK button.

The settings will be reset and the user interface will automatically update to 
reflect the new settings.

5.6 Registration Settings
Adjustments made in the Registration settings page will affect the quality of 
the registration result. 

NOTE: Finding targets is time consuming and should be enabled 
only when scans are registered with the Target Based registration.
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Besides incorporating sensor data, SCENE supports two sophisticated 
registration methods that can also be used in succession.

Figure 5-1 Automatic registration, Manual registration, and sensor settings

5.6.2 Automatic Registration

Registration method that will be used when performing the automatic 
registration task. Select among 3 options: Top View based registration, Cloud 
to Cloud registration, Top View first and Cloud to Cloud afterwards, or Target 
Based registration.

5.6.3 Manual Registration

Select, if you want to optimize each registered pair of scans with Cloud to 
Cloud registration or not. This optimization is always done before you are 
asked to select another pair of scans.

5.6.4 Sensors

The scanner‘s sensor data that will be used during registration. 

• The inclinometer data will be used for Top View based and Cloud to Cloud
Registration.

• The compass data will be used for Top View based registration.

Inclinometer Normally, inclinometer data is available, and this is used by default to level the 
scans during registration.

Leveling ensures that the z-axis of the registered scan corresponds to the z-
axis defined by the inclinometer. By this technique one reference can be 
replaced during registration.

When registering with inclinometer data, this will be used as fully trusted 
information and all other registration objects will be used with lower priority.

NOTE: Sensor data can only be used when the sensors were 
enabled during scanning.
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Compass If the scans were recorded with a FARO Focus Scanner equipped with a built-
in compass, orientation information is available for the single scans. Enable 
this option to use this information as auxiliary information for the 
correspondence search. If the correspondence search cannot find any 
correspondences that are consistent with the compass data, this may be an 
indicator that the compass was influenced by environmental interference and 
the compass data will be ignored. If you disable this option, no compass data 
will be used for correspondence search at all.

5.6.5 Cloud to Cloud Registration Method

Subsampling

The result of the Cloud to Cloud registration can be adjusted through the 
subsampling rate. The value defines the size of the grid in which scan point 
homogenization is performed.

 Set the slider to the value which should bring the desired result. As soon as
you move the handle, the set value will be shown.

5.6.6 Top View Based Registration Method

Subsampling

The result of the Top View based registration can be adjusted through the 
subsampling rate. The value defines the size of the grid in which scan point 
homogenization is performed.

 Set the slider to the value which should bring the desired result. As soon as
you move the handle, the set value will be shown.

Reliability

The reliability value determines the amount of additional checks on a 
registration. It filters out results that could be contested. Higher values allow 
for more certainty, but could affect the time complexity of the algorithm.

 Set the slider to the value which should bring the desired result. As soon as
you move the button, the set value will be shown.

5.6.7 Target Based Registration Method

Find correspondences for scan positions

Select this check-box, if the position of a scan is known, for example by a 
surveyed reference point, or by a reference sphere representing the position 
of the scanner in other scans.

Force correspondences by target names

Select this check-box, if you want to force correspondences by target names.

The targets in each scan must be named according to their counterparts in the 
other scans.

This feature requires that targets were already detected by SCENE. In 
Settings > Process, select a target search, then run Process. After that, open 
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the cluster or the scans in Explore. You can then click the target‘s names the in 
Structure View and rename them. 

Use Checkerboard Normals

Select, if you want to use normals of checkerboards for correspondence 
search.

Uncheck, if the direction of checkerboards has changed from one scan to 
another. For example, if you use checkerboard targets that can be tilted and 
turned for a precise orientation to the scanner.

Target Distribution Threshold slider

This slider sets the limit for registration. If targets are too near to one another, 
registration will be refused. In this case, lowering the limits gives you a result.

 Set the slider to the value which should bring the desired result. As soon as
you move the handle, the set value will be shown.

5.6.8 Registration Report

Thresholds for point error color coding

Values below the first threshold are shown in green color, and values above 
the second threshold are shown in red color. Values in between are shown in 
yellow color. The color codes are used in the Registration Report, the Project 
Dashboard, and the Scan Managers.

 Set specific thresholds by clicking into the field and entering a new value.

Thresholds for overlap color coding

Values above the first threshold are shown in green color, and values below 
the second threshold are shown in red color. Values in between are shown in 
yellow color. The color codes are used in the registration report.

 Set specific thresholds by clicking into the field and entering a new value.

5.6.9 Reset Registration Settings

Click the Reset Registration Settings button to reset all registration parameters 
to their predefined values.
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5.7 Views settings
The Views settings page provide settings for the 3D View, Quick View, and 
Planar View.

Figure 5-1 Views settings

5.7.2 General 

Explore

Check the Automatically Open 3D View option under Explore category. When 
you switch to explore category, a new 3D view is opened. You can uncheck 
this option if the 3D view takes a lot of time to load.
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Measurement Properties

The Measurement Properties provides settings to set the displayed 
measurement distances for all views. 

The following options are available:

• Overall Distance: This is the default setting. The overall distance measured
between two points is displayed.

• Horizontal Distance: The horizontal measurement of the point-to-point
distance is displayed.

• Vertical Distance: The vertical measurement of the point-to-point distance is
displayed.

The selected distance measurements will be shown in 3D View, Quickview, 
and Planar View.

The chosen distance value will be displayed in all new measurement objects. 

However, to change the displayed measurement distance for each individual 
measurement, use the Measurement Object Properties dialog.

5.7.3 3D View

The settings for the 3D View are separated into Display and Navigation 
settings. All these settings will be applied when a new 3D View is opened. 
These settings will not be applied to views which are already opened. 
Changing these settings will be used as new defaults for opening a 3D View.

Navigation

Default Mode Select the navigation mode which shall be activated when you open a new 3D 
View. You can select among Fly, Examine or Smart mode as default 
navigation modes.

Invert Mouse Wheel Changes the forward and backwards movement by the mouse wheel. The 
default behavior of the mouse wheel is: spinning it forward will move the view 
backwards in space and vice versa.

Default Speed Change the speed of the left, right, forward and backwards movement 
triggered by pressing the cursor keys.

Accelerated Factor This is the factor which is used to determine the accelerated speed. The 
accelerated speed is the factor multiplied with the default speed.

The accelerated speed is used by pressing the cursor keys in combination 
with the shift key.

The settings invert Mouse Wheel, Default speed and Accelerated Factor” will be 
applied to the opened view.

Display Settings

Effects Supersampling – Supersampling renders the point cloud with a resolution 
higher than the resolution of your screen and then shrinks the point cloud to fit 
the screen resolution. This reduces anti-aliasing effects and gives the point 
cloud a smoother visual appearance. Fine and filigree structures look sharper 
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and stray points will appear less annoying. Set the resolution of the initially 
rendered point cloud compared to the screen resolution by selecting one of 
the options 2x2, 3x3, or 4x4. For example, choosing 2x2 means that the point 
cloud will be rendered with a resolution that is 4 times the resolution of your 
screen.

Figure 5-4 Supersampling turned off (left) and turned on (right)

Gap Filling – The gap filler fills gaps between scan points that are physically 
close to each other.

Clear View – In the clear view mode, points in areas with low point density will 
be displayed more transparently and points in areas with a high point density 
will be displayed more brightly.

It adds transparency to the otherwise completely opaque point cloud 
rendering. This allows for viewing through walls or ceilings and may give a 
much better impression of the spatial structure of the underlying point cloud. 
Points in areas with low point density will be displayed more transparently and 
points in areas with a high point density will be displayed more brightly.

Background Select either a Background Image for a 3D View: Environment Map, or a gradient 
background color. 

NOTE: Objects like walls might appear transparent when using 
small point sizes in combination with supersampling.

High supersampling resolutions like 4x4 require large amounts of 
graphics card memory.

NOTE: Changing the effects will be applied if a new 3D View is 
opened. The effects which can be changed directly in the 3D View 
are only applied to the 3D View which is opened.

Gap filler or clear view can only be activated if supported by 
hardware.
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The gradient background color starts with the selected top color and 
transitions linearly to the selected bottom color. 

1. Click the Top Color button to open the color selector dialog.

2. Select the color with which the background shall start at the top of the
display.

3. Click the Bottom Color button to open the color selector dialog.

4. Select the color with which the background shall end at the bottom of the
display.

5.7.5 Reset Views Settings

Click the Reset Views Settings button to reset all View settings parameters to 
their predefined values.

5.7.6 Background Image for a 3D View: Environment Map

SCENE offers solid or gradient color backgrounds in a 3D View. These are 
suitable for editing of point clouds, but when a realistic visualization is needed 
(like for capturing a video of an outdoor scene in the Video App), the result 
would look somewhat boring.

To make such scenes or videos look more realistic, you can add a so-called 
Environment Map as a background image.
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The background image selected last will be used as a default setting for a new 
3D View.

Figure 5-7 3D View with a solid gray background

Figure 5-8 Environment Map showing a cloudy sky
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Figure 5-9 3D View with Environment Map
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How to add an 
Environment Map

The usage of Environment Maps can be enabled in the Visibility Settings 
dialog of a 3D View. 

1. Click the Settings button on the right side of the Workflow Bar, then select
the View page.

Figure 5-10 Selecting an Environment Map in Settings
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2. To select a new Environment Map, click the Browse button . A dialog 
opens with the folder “Environment Maps”.

3. Select your new background image and click Open. The file name is now
shown in the View tab.

The selected Environment Map will be saved with the project. So, when 
another person on another machine opens the project, the Environment Map 
will again be shown as background image.

Limitations At the moment, the Environment Map is only available for 3D Views with a 

perspective camera  setting. For views with orthographic cameras, it is 
disabled.

Creating individual 
Environment Maps

If you need a special background image for your scan project, you can create 
it yourself.

It has to fit the following conditions:

• Aspect ratio 2:1, which means that it is twice as wide as it is high.

• The lower half of the image shall show “ground” and should not show too
much structure.

• The image is later mapped to an imaginary spherical firmament.

• should look distorted because it is meant to texture a sphere. Professional
graphics editors offer a feature called “Spherics” which may help in creating
suitable images.

• The left and the right end of the image must fit.

You can save the newly created Environment Map into the folder SCENE 
7.2\EnvironmentMaps, but you can save it to any other folder as well.

Scan Data Load 
Behavior

Select the default scan load behavior to be used to load a scan for Planar or 
Quick View. By default, the scan is loaded in color mode.

5.8 Export settings
The Export settings page provides Units settings for exporting SCENE data.

5.8.1 Units

Set the default unit of length used to export data. 

Select one of the units of length:

• Millimeter [mm], Centimeter [cm], Meter [m], or,

• Inch [in], Feet [ft], Yard [yd], or

• Inch [in US], Feet [ft US], Yard [yd US].
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The default setting is “Meter [m]”.

Figure 5-2 Export settings

5.9 SCENE WebShare Cloud settings
The SCENE WebShare Cloud settings page provides settings to login to 
SCENE WebShare Cloud.

5.9.1 Login

The login credentials will be used to automatically log in every time a 
connection to SCENE WebShare Cloud is required for Import or Export 
process.

Figure 5-2 SCENE WebShare Cloud Settings

Domain – Enter your organization’s subdomain name on SCENE WebShare 
Cloud.

User Name (email) – Enter the user name to log in to SCENE WebShare 
Cloud.

Password – Enter the password with to log in to SCENE WebShare Cloud.

Login and Save Credentials – Click to save the login credentials to SCENE 
WebShare Cloud button. If the login is not successful, an error message is 
displayed and the credentials are not saved.

NOTE: Some export formats like PTX do not support user-defined 
Unit settings. They support only the metric system.
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Chapter 6: Project 

6.1 Introduction
The Project category provides the features for your entire scan project.

There are two sets of tool bars, one that shows up when no scan project is 
opened, and one that shows up when a scan project is opened.

6.2 Project Features when no Scan Project is Opened

Figure 6-1 Project toolbar when no scan project is opened

Create Project: Create a new scan project from scratch.

Open Project: Open an existing scan project. Clicking the little arrow opens a 
drop-down menu with the recently loaded scan projects.

Project Transfer: Transfer scan data from an SD Card, or from any other place.

6.3 Create Project
Create a new scan project. The new scan project and its project workspace 
are initially empty and you must fill them.

There are different ways to create new scan projects:

1. Click the Create Project button  in the toolbar. The Create New Scan
Project dialog appears:

Figure 6-1 Create a new project

2. Enter a location, or click the Browse button  to open the file manager.

3. Enter a project name.
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4. Click Create. All necessary files and structures will automatically be
created at the selected location.

The scan project can be identified by the.lsproj file which is accessible in 
the folder of the scan project. It is usually named like the scan project itself.

6.3.2 Open Project

There are different ways to open new scan projects:

Recently loaded 
scan projects

1. Click the little arrow besides the Open Project button  in the toolbar. A
drop-down menu with the recently loaded scan projects opens.

2. Click one of the listed scan projects to open it.

Open existing 
project

1. Click the Open Project button  in the toolbar. The Open Existing Project
file manager is opened.

2. Enter a path, or browse to find the folder.

3. Click Open.

6.3.3 Read-Only Projects

Working with the 
project workspace

Working with the project workspace means working on the scan project 
directly; you can modify, create, add or delete any kind of data a scan project 
can have. Saving your changes will immediately modify the data of the 
centrally provided scan project. Scan projects maintain a history of changes of 
their data. Every save operation will create a new revision of the project.

Write-lock A write-lock for all shared data of the scan project will assure that only one 
user is able to modify shared data at a time. All modifications made to the scan 
project will be visible to other users after are saved.

When users try to access the scan project while a write lock already exists, the 
scan project will only be opened in read-only mode.

NOTE: When creating a new scan project from scratch, it will have 
an empty project workspace and you must fill it first with the 
appropriate scan files. SCENE offers several Import features to do 
that.

NOTE: You may also create a new project by transferring scan 
data from an SD Card, exporting an existing scan project, a 
cluster, or a single scan to a different location. For this, use the 
Export features.

NOTE: The scan project can be identified by the .lsproj file 
which is accessible in the folder of the scan project. It is usually 
named like the scan project itself.
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• The SCENE title bar contains a new additional read-only warning string
between the project name and the SCENE version.

• When trying to save a read-only project, the option to save a workspace is
only available in the recent user interface.

• When trying to save a project opened in read-only mode, the message box
informs that you must open the project with write access to be able to
persist modifications.

6.3.4 Project Transfer

The Project Transfer task can be used to transfer scan projects (laser scanner 
and Freestyle3D projects) from a source folder to a target folder.

A typical example for a project transfer is the SD card import. If an SD card is 
inserted, the SD Card Transfer task will open automatically, and the SD card 
will be used as predefined source folder.

Transfer scan 
projects from a 
storage medium

1. Select the source folder. If you wish to change the predefined folder, carry
out the following steps:

• Click the Browse button  to open the file system browser. You can 
not enter a project folder path directly into the field.

• Browse to the folder.

2. Select the target folder.

3. Select the Process check-box if the imported project shall be processed
automatically after the import is finished.

4. Click the Start Transfer button to open the Configure Project Transfer dialog.

Transfer scan 
projects from SD 
card

If you insert an SD card and SCENE is already running, the SD Card Transfer 
dialog will be shown after some seconds.

If a scan project is already opened, this scan project has to be closed before 
the SD Card transfer can start. In this case, the SD Card Transfer dialog will 
show a warning.

 Click the Yes button to start the SD Card Transfer task.

1. Select the scan projects to be transferred by unchecking the Transfer
check-box of those which shall not be transferred.

2. Select the Process check-box if the imported project shall be processed
automatically after the import is finished.

3. Select the target folder. If you wish to change the predefined folder, carry
out the following steps:

NOTE: If you do not only wish to process the scan project but even 
to register its scans afterwards, check Settings > Processing.
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• Click the Browse button  to open the file manager. You can not enter 
a project folder path directly into the field.

• Browse to the folder.

• In the folder, select the scan project file, which is a file with the file ending
.fws or .lsproj.

Figure 6-5 Project transfer dialog

For every project to be transferred, SCENE will search for a matching 
project name in the predefined project folder. 

• If a matching project is found, the target folder will point to the folder of
the project and an Import project icon  is shown. The transferred 
project will be merged into the existing project.

• If no matching project is found, the target folder will be a new folder in the
project folder based on the name of the project. In this case, an Add

project icon  is shown.

4. Click the Start Transfer button to start the transfer and finish the task.

After the transfer was performed, the task gets closed and a message is 
shown in which all projects are listed.

6.4 Project Features for an Opened Scan Project

Figure 6-1 Project toolbar for an opened scan project

Close Project: Closes the currently opened scan project. Before, you will be 
asked if you want to save the scan project. If you click Yes, you can enter a 
comment, and the author‘s name. You can also select if the project point cloud 
shall be updated before closing the scan project.

Project History: Shows all revisions of a scan project.
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Wipe Project History: Deletes the project history, which means, that all revisions 
will be lost.

6.4.2 Project History

All revisions of a scan project are available in the Project History.

Click the Project History button  to open the history of a scan project.

Figure 6-3 Project History

The project history shows all revisions of a scan project, together with a user 
name, and the information that had been entered when the scan project was 
saved.

6.4.4 Wipe Project History

As a project grows over time, numerous revisions may accumulate in the scan 
project history. Thus it may become necessary to reduce the number of 
revisions and the amount of stored data, for instance when an important 
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milestone has been reached and the individual steps are no longer needed. At 
this point you may delete all revisions, and save a new revision.

1. Click the Wipe Project History button. After confirming a warning message,
the Share Changes dialog opens.

2. If required, modify the entry.

3. Click the OK button. SCENE will then start to create a new revision.

6.5 Project Workspace 
The project workspace contains all the objects required to process the scans, 
making the analysis comprehensible. This typically includes:

• Links to the scan files.

• Scan folders or clusters which define the structure of a scan project. They
organize many scans into a manageable arrangement.

• Geometric objects identified in the scans as well as their fit objects.

• Reference to external coordinate systems.

• Documentation objects, which provide information about user defined
points of interest in the scans or in the point cloud.

• Measurements

• CAD models for comparing scanned reality with the existing plans.

6.5.1 Scans

Scans are the scan files as they are recorded by the scanner with their millions 
of data records that include position, reflectance, and color for single scan 
points. Scans consist of scan points that were recorded from a single scanner 
location. They are organized in a row column order.

6.5.2 Scan Point Clouds

Scan point clouds are an alternative representation of the scans and must be 
created from the single scans. Scan point clouds are organized in a spatial 

NOTICE

The scan project history is deleted. 

All information about the history of a project will be lost. You 
will no longer be able to revert the project to a previous 
revision afterwards.

NOTE: If revision history is critical, you should use the Export 
features to export the scan project. Exporting the scan project will 
perform a cleanup and compact function but stores the results in a 
new scan project. The revisions of the original project will be kept.
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data structure that facilitates fast visualization of scan points and automated 
point loading based on point visibility. They may facilitate and accelerate the 
processing of the scan points.

6.5.3 Project Point Cloud

The result of a scan project in SCENE typically is a comprehensive project 
point cloud of the scanned object.

Unlike scans and scan point clouds, the project point cloud consists of the 
points of all the scans within your scan project and can be seen as a 
comprehensive point cloud of the complete scan project. It is typically created 
from all the single scans in your project after they have been preprocessed, 
colorized and registered.

Like the scan point clouds, the project point cloud is optimized for fast 
visualization of large amounts of scan points in the 3D View and is organized 
in a spatial data structure that facilitates fast visualization of the scan points. 
The project point cloud consists of the points of all the scans within you scan 
project and can thus be seen as a comprehensive point cloud of the complete 
scan project. For this reason, the amount of points in a project point cloud can 
be enormous. Unlike scan files, such large amounts of points cannot be 
loaded into physical memory at once. Therefore, the points of the project point 
cloud are automatically loaded and visualized on demand based on the 
camera position and point visibility. The automated point loading of the project 
point cloud is able to visualize hundreds of scans at once. This empowers you 
to actually see all scans of a scan project at once regardless of whether they 
fit into your computer’s physical memory or not. Manual scan file loading is not 
necessary. 

As the point cloud visualization technique is constantly loading scan points 
from the hard disk drive based on point visibility, the overall performance 
strongly depends on the speed of your hard disk drive. While project point 
clouds outperform all other visualization methods (including scan point clouds) 
on regular hard disk drives, we recommend using a solid state drive for 
maximum performance. Using a solid state drive will also speed up the 
process of creating the project point cloud.

The benefits of the project point cloud are:

• Very fast visualization of large amounts of scans at once

• One optimized single spatial data structure for all scan points in a project

• Can be accessed from all local workspaces associated with the project.

6.5.4 SCENE WebShare Cloud Data

SCENE WebShare Cloud data is created from the scans and consists of 
panoramic scan images which can be put on the Internet, thus enabling you to 
share scan information of your scan project with others.

6.6 Creating New Workspaces
You can create a new workspace by
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• drag & drop a scan file (with the extension .fls) from a file system browser
into SCENE. SCENE will then open a new workspace which contains only
this scan.

• drag & drop a raw scan folder from a file system browser into SCENE.
SCENE will then open a new workspace which contains the scans of this
folder.

• double-clicking on a scan file (with the file extension .fls). SCENE will then
open a new workspace which contains only this scan.

A new workspace initially only exists in SCENE and not as a file in the file 
system, nor is it associated to a scan project. For this, you must explicitly save 
the workspace.

6.7 Local Workspaces

Local data Local data is owned and maintained by users and is not visible to others until 
changes are shared with the scan project. Scan data becomes local data once 
it is modified and stays local until the changes are shared with the scan 
project.

Local workspaces A local workspace is saved in the file system as a file with the extension .fws 
(scan files have the extension .fls). Each local workspace has an associated 
folder in which local changes to scan project data will be stored. This folder 
has the same name as the local workspace and is created in the sub-folder 
“Workspaces” of the folder of the local workspace file.

After creating a new local workspace, this folder will contain a predefined 
folder structure but otherwise will be empty. No project data is copied until 
changes have been made and saved.

By default the local workspace will access the shared data of the latest 
revision of the associated scan project.

NOTE: When importing workspaces and scan projects, data will 
be imported from the current revision.

NOTE: To create a local workspace, switch to the recent user 
interface by clicking the Switch User interface button in the 
Settings toolbar.

In the further course of this document the general term 
“workspace” is used, when the described functionality covers both, 
the local workspace as well as the project workspace; else it will 
be distinguished between both and the terms “local workspace” or 
“project workspace” will be used.
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6.8 Workspace Structure
All objects in the workspace are arranged in a hierarchy so that they are easier 
to find. This is similar to the file system, where the files are placed in folders, 
which can also be nested hierarchically.

On the top level of the workspace hierarchy, you can find the following folders:

Documentation – contains the documentation objects.

References – contains survey data and any self made reference points.

Measurements – contains the measurement logs.

Models – contains CAD models.

Scans Folder Contains scans.

This folder is usually named according to the name of your scan project and 
might have several scan subfolders depending on the structure of your scan 
project.

In the Structure View, you can see the hierarchy of the objects.

Figure 6-1 Structure View

Cluster folders The Scans folder may contain folders which again contain scans. Such a 
folder is called Cluster. A cluster again may contain other cluster folders.

Scan A scan is also essentially a folder which, apart from scan points, can also 
contain additional information, like objects (however, no further scans).

With the exception of the scans in a scan group, you can rearrange the objects 
within the hierarchy. To do this, select an object and using drag & drop, move it 
to the folder in which you require it to be located. You can do this in the 
Structure View and in the Planar View. If you use the left mouse button, the 
properties of the object will not change. Especially the local coordinates will 
not change. But because of the hierarchy of coordinates it may have changed 
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its Global Coordinates. If you use the right mouse button, an additional context 
menu opens with which you can decide what should happen with the object.

Figure 6-2 Structure View: Drag & drop object with right mouse button

Here you can select that the object should keep its global position.

Layers Apart from this hierarchy, the objects are also assigned to layers. Layers are 
used to group objects independently of their hierarchy and to control the 
visibility of these object groups. For example, in your CAD model, you can 
place the interior walls of a building on a separate layer. If you then make this 
layer invisible, you very easily obtain an impression of the available floor 
space in the building.

6.8.3 Naming conventions

Workspace The workspace itself is named like the scan project. If it is a local workspace, it 
is named ‘Workspace’.

Objects You can give most objects their own names, which may only contain letters, 
numbers, the point ‘.’ and the underscore ‘_’. 

Scans Scans cannot be renamed.

References The References folder should not be renamed because it is used for 
registering the scans.

Screenshots The Screenshots folder can be renamed.
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Chapter 7: Import

7.1 Introduction
This chapter gives an overview of the formats that are supported by SCENE to 
import scans, projects, objects, or images.

Figure 7-1 Import features

• Import Scans will import scans and point clouds. This includes FARO
Laser scanner files (FLS), E57 files, PTZ files, PTX files, and unstructured
point data in ASCII XYZ. With PTX and ASCII XYZ files, you must make
sure that the scan points in the scan file are arranged so that they
correspond to the row or column-oriented recording process of the scanner.
You also must make sure that the scan was not registered.

• Import Projects will import SCENE Projects and Workspaces into existing
projects. Note that this is different from simply opening a project.

• Import Objects will import VRML files and reference points.

• Import Images will import images as a layout plan, virtual scan, or simple
image.

• Import SCENE WebShare Cloud will start the SCENE WebShare Cloud
Import assistant.

7.2 Import by Drag & Drop
The easiest way to import scan projects, scans, images, or objects is by drag 
& drop a file into SCENE.

NOTE: Drag & drop is not only available in the Import window. You 
can also use it in all other steps in which the Structure View is 
available. Drag & drop a file to its place in the Workspace.
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1. Additionally to SCENE, open a file system browser, for example, MS
Explorer.

2. Click the Import button in the Workflow bar.

3. In your file system browser, select the file to be imported.

4. Drag & drop the file to SCENE in the blue Drag & Drop field. The Drag &
Drop field will change its size and its color (to green) as soon as the file is
accepted.

Depending on the type of the file, the following would happen:

7.2.1 Importing a scan project

The scans and objects of the newly imported scan project will be added to the 
currently opened scan project.

7.2.2 Importing a scan

The newly imported scan can be found in the Structure View, in the cluster the 
mouse pointer was when dropping the file. You can move it to another cluster, 
again using drag & drop.

7.2.3 Importing an image

After dropping the image file, the Import Pictures dialog will open. 

The newly imported images can be found in the Workspace, in the Pictures 
folder.

7.2.4 Importing an object

After dropping the object file, a dialog will open in which you can adjust some 
settings. Those settings depend on the file format of the object.

The newly imported object can be found in the Workspace: objects in VRML 
format in the Models folder, objects in CSV format in the References folder.

NOTE: Newer versions of the FARO Focus Laser Scanner allow 
the creation of scan groups, which are several scans created 
without moving the scanner. 

One use for scan groups is to make a complete 360° scan, and 
then to make several higher-resolution partial scans of the targets 
that are visible in the first scan. This reduces the total time needed 
to scan the area, while still getting high-quality scans of the targets 
to ensure that registration is accurate.
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7.3 Import Scans
The Import Scans feature allows to import scans and point clouds. This 
includes FARO Laser Scanner files (FLS), E57 files, PTZ files, PTX files, and 
unstructured point data in ASCII XYZ format.

1. Click the Import Scans button  in the Import toolbar.

2. Browse to select the files which you want to import.

3. Click the Open button.

After closing the file manager, SCENE will start to import the selected files and 
shows the progress. 

The newly imported scans can be found in the Workspace. You can move 
them to a cluster by drag & drop.

Cancel Import You can cancel this import process by clicking the Cancel button.

The Cancel button will not stop the import immediately, but after importing the 
current file. This is the reason why the Cancel button is not available if the 
import was started for only one file. 

When the Cancel button was clicked, it will be grayed and the status message 
is updated.

7.3.1 General Scan Data Format .xyz

An xyz file can contain different information, like row and column for each scan 
point, RGB values, and intensity values.

There are two variants to import an xyz file:

• If the xyz file contains x and y coordinate information: the data is imported
as a scan. The x coordinate, y coordinate, z coordinate and the reflection
value are specified for each scan point.

• If the xyz file doesn't contain x and y coordinate information: the data is
imported as point cloud. Two additional specifications are made for each
scan point: the row and the column in the planar representation

When importing, it is assumed that the coordinates will be received in the 
selected import unit.

When importing a xyz file that contains both, RGB and intensity values, the 
RGB values are used.

7.3.2 Scan Data Format .ptx

PTX is an ASCII based interchange format for point cloud data, which is 
usually created with the scan software Leica Cyclone.

NOTE: When importing files with a space in the file name, this 
space will be automatically replaced by an underline.
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This format is especially suited for exchanging scan points and their 
corresponding coordinate transformation. 

All values are given in ASCII and are metric. The first line states the number of 
columns, the second line the number of rows. In the next line, the translation 
part of the transformation is given (a 3D vector). After that, 3 lines with the 
rotation part follow (a 3x3 matrix). The next 4 lines contain the full 
transformation (a 4x4 matrix). Finally the scan points are written, one scan 
point per line: x, y, z, and a reflection value. In addition, 3 RGB values may 
follow. The reflection value is between 0 and 1.

When importing a PTX file, the following dialog opens:

Figure 7-3 PTX import dialog

Row/Column 
Orientation

Rows per column – The input file contains the data column-wise, i.e., it starts 
with all the rows of the first column, then all rows of the second column, and so 
on. Good when importing FARO PTX files.

Columns per row – The input file contains the data row-wise, i.e., it starts with 
all columns of the first row, then the second row, and so on.

Intensity Mapping Linear – A linear mapping of intensity values to gray values. 

Non-linear – A non-linear mapping of intensity values to gray values. Good 
when importing for example Leica PTX files.

• If the PTX file contains RGB values, intensity mapping is not done. The
RGB values are used instead.

• If the PTX file contains both, RGB and intensity values, the RGB values are
used.

Apply to all If the Apply to all check-box is selected and you click the OK button, it will 
apply the same settings for the following scans and not ask anymore.

If you uncheck Apply to all, the dialog will appear for the next scan again.

If you click the Cancel button, the import will abort for the current scan and all 
following scans. Scans that were already imported will remain.

NOTE: If your input looks like garbage in the Planar View, but 
seems to be OK in the 3D View, try to import again with a different 
row/column orientation.
75
Chapter 7: Import



SCENE 2018 User Manual
7.3.4 Scan Data Format .ptz

PTZ is the binary data format of Leica HDS scan files, which are usually 
created with the scan software Leica Cyclone.

When importing a PTZ file, the following dialog opens:

Figure 7-5 PTZ import dialog

Intensity Mapping Linear – A linear mapping of intensity values to gray values. 

Non-linear – A non-linear mapping intensity values to gray values. Good 
when importing for example Leica PTZ files.

If the PTZ file contains colors, intensity mapping is not done. The colors are 
used instead.

Apply to all If the Apply to all check-box is selected and you click the OK button, it will 
apply the same settings for the following scans and not ask anymore.

If you uncheck Apply to all, the dialog will appear for the next scan again.

If you click the Cancel button, the import will abort for the current scan and all 
following scans. Scans that were already imported will remain.

7.3.6 Scan Data Format .e57

This scan data format is a vendor-neutral standard for storing point cloud data 
produced by 3D imaging systems. The “ASTM E57 3D file format” (officially 
ASTM E2807) is a format for three dimensional imaging data such as laser 
scans. The E57 file used as shorthand for “ASTM E57 3D file format” and is a 
combination of binary data and XML (extensible Markup Language).

An E57 file can store 3D point data, attributes associated with 3D point data 

such as RGB and/or intensity values.1

SCENE supports the import of several features of the E57 file. When 
importing, the E57 file has to contain xyz or spherical coordinates as well as 
RGB and/or intensity values for each scan point. If the E57 file contains RGB 
and intensity values, the RGB values are used. 

1. The specification of the new format is available on
http://www.astm.org/Standards/E2807.htm. SCENE uses the library
libE57 V1.1.312 to write and read E57 files.
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If the E57 file doesn’t contain information about row/column ordering, the 
following dialog opens:

Figure 7-7 E57 import dialog

 Select the correct ordering of the file, then click the OK button.

Row/Column 
Orientation

Rows per column – The input file contains the data column-wise, i.e., it starts 
with all the rows of the first column, then all rows of the second column, etc.

Columns per row –The input file contains the data row-wise, i.e., it starts with 
all columns of the first row, then the second row etc.

Currently, SCENE doesn’t support import or export of associated 2D images.

Apply to all If the Apply to all check-box is selected and you click the OK button, it will 
apply the same settings for the following scans and not ask anymore.

If you uncheck Apply to all, the dialog will appear for the next scan again.

If you click the Cancel button, the import will abort for the current scan and all 
following scans. Scans that were already imported will remain.

7.4 Import Projects
The Import Projects feature allows to import SCENE scan projects and 
Workspaces.

1. Click the Import Projects button  in the Import toolbar. The file system 
browser will open.

2. Select the file format “Projects And Workspaces (*.lsproj, *.fws)”.

3. Browse to select the files which you want to import.

4. Click the Open button.

The scans and objects of the newly imported scan project will be added to the 
currently opened scan project.

NOTE: The Import Projects feature will only work if a valid SCENE 
project or workspace is already open.
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7.5 Import Images
The Import Images feature will import images as layout plan, virtual scan, or 
simple image. 

There are three ways to use images in SCENE: 

• Images can be added with their original resolution to the workspace and
thus provide additional information about the scan environment.

• Images can be added with their original resolution to the workspace and
thus provide additional information about the scan environment. These
images are imported into the 3D world into virtual scans with their full
resolution. Such images will be interpreted like a high resolution scan of a
plane surface and can be placed on arbitrary positions in the 3D world.

• Images can be used to add color information to already existing scan
points.

1. Click the Images button  in the Import toolbar. The file system browser 
will open.

2. Select the file format “Image Files (*.bmp, *.jpg, *.png)”.

3. Browse to select the files which you want to import.

4. Click the Open button.

The following dialog appears:

Figure 7-1 Import image dialog

5. Select for what you want the image to be used. If there are several images
for one application, select Apply to all, or select the appropriate ones.

7.5.2 Import high resolution pictures as virtual scans

This method allows you to include high resolution pictures (for example, digital 
photos of important details in the scan environment) into the 3D world by 
importing them with their full resolution as virtual scans. 

NOTE: File names of imported images cannot be renamed. 
Ensure that the image file has the name you want before importing 
it into SCENE.
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Such pictures will then be interpreted as a high-resolution scan of a plane 
surface and can be placed in an arbitrary position in the 3D world. 

For this, import a picture into SCENE as virtual scan (see above). 

If you choose to create a virtual scan, the picture will be placed in the scan 

folder of the Structure View and be marked with a special icon , signifying 
that it is a picture with 3D information.

Figure 7-3 Virtual Scan in the Structure View

Initially, the virtual scan is scaled in such a way that the longest side of the 
picture is equal to 1 meter. The initial position in the 3D world is in the origin of 
the coordinate system.

Figure 7-4 Virtual scan in 3D View

The main application for virtual scans is to complement existing 3D scans with 
detailed information from high resolution photos of flat surfaces. 

In this case, size and location of the virtual scan are fixed and can be 
determined by using the Place on Surface command under Operations > 
Registration in the virtual scan’s context menu.

The command Place on Surfaces scales and places the virtual scan in the 3D 
world using a plane and corresponding points in the virtual scan and a scan in 
the 3D world. The command Place in 3D places the virtual scan upright in the 
3D world.

The technique to place and scale virtual scans is similar to the one used to 
colorize existing scan points. This time, however, new points are created from 
the pixels of the picture and added at the proper position in the 3D world.

Place on Surface The position of the virtual scan is defined by a plane that has to be created in 
one of the scans at the approximate position where the virtual scan should be 
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placed. The exact position and size on this plane is then determined by 
selecting matching points in the virtual scan and in a real scan.

1. In the Structure window, right-click the virtual scan, then select View >
Planar View. A new tab opens which shows the virtual scan.

2. In the Structure Window, right-click the scan in which the virtual scan shall
be placed, then select View > Planar View or Quick View.

3. Use the Mark Plane  function to mark the area where the virtual scan
shall be placed.

Figure 7-5 Mark Plane to place Virtual Scan
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4. In the Structure window, right-click the virtual scan and select
Registration > Place on Surface.

Figure 7-6 Place and scale dialog

5. In the Structure window, click the scan, then click Use Selection in the
dialog.

6. In the Structure window, click the plane, then click Use Selection in the
dialog.

7. Click Associate Points. The mouse pointer changes and is displayed
cross-shaped.

8. Mark at least 4 suitable scan points in the virtual scan. Each scan point
position is listed in the Image column in the dialog.
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9. Mark the corresponding scan points in the scan. Take care to keep the
same order. Each scan point position is listed in the Scan column in the
dialog.

Figure 7-7 Associate points

10.When you are done selecting points, click Done to place and scale the
virtual scan.

Figure 7-8 Placed and scaled virtual scan in 3D View

11.Open the scan folder or cluster in 3D View.

12.In the Structure window, right-click the virtual scan and select Locate.

The virtual scan is now displayed at its new place.
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Place in 3D 1. In the Structure window, right-click the virtual scan, then select View >
Planar View. A new tab opens which shows the virtual scan.

2. In the Structure Window, right-click the scan in which the virtual scan shall
be placed, then select View > Planar View or Quick View.

3. Use the Mark Plane  function to mark the area where the virtual scan
shall be placed.

Figure 7-9 Arrange Virtual Scan and Scan

4. In the Structure window, right-click the virtual scan and select
Registration > Place in 3D.

Figure 7-10 Place and scale dialog

5. In the Structure window, click the plane, then click Use Selection in the
dialog.
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6. In the Structure window, click the scan, then click Use Selection in the
dialog.

7. Click Associate Points. The mouse pointer changes and is displayed
cross-shaped.

8. Mark at least four suitable scan points in the virtual scan. Try to find scan
points in all three dimensions. Each scan point position is listed in the
Image column in the dialog.

9. Mark the corresponding scan points in the scan. Take care to keep the
same order. Each scan point position is listed in the Scan column in the
dialog.

Figure 7-11 Associate points

10.In the dialog, click the Set button beneath Foot Point.

11.In the virtual scan, click a scan point that is suitable as placing point. This
coordinates are now displayed as Foot Point.

12.When you are done with selecting points, click Done to place and scale the
virtual scan.

Measure 1. Select the virtual scan.

2. Select Measure points .

3. Measure an object.
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Show positions in 
3D View

Open the scan folder or cluster in 3D View.

Figure 7-12 Laced virtual scan and camera position in 3D View

The virtual scan is now shown at its new place, not in original but plane-
shaped. To find the camera position, search the 3D View for a suitable small 
camera symbol. If you click the camera symbol, the orientation of the camera 
is displayed.

7.6 Import Objects
The Import Objects feature allows to import VRML files and surveyed 
reference points.

7.6.1 Importing VRML files

To compare the scanned reality with the models from the CAD system, you 
can import the model into SCENE. For this, the model must be the multi-
vendor-capable VRML (Virtual Reality Modeling Language) data format. A lot 
of CAD systems give you the option of exporting models this format. For this, 
read the instructions for your CAD system.

Although the VRML standard recommends a specific coordinate system and a 
specific unit of length, not all VRML files are modeled that way. The standard 
defines the unit of measure of the world coordinate system to be meters, and a 
coordinate system which the y axis points upwards.

Because many VRML files are modeled differently, you can select different.

When importing a VRML model, you can ask SCENE to combine any meshes 
the model into a single one. 

SCENE does not support all objects or object properties that are available 
VRML. The following parameters are not transferred:

• Light sources

• Textures with 8 or 16 bit per pixel (use 24 bit per pixel instead)
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• The in-line node

1. Click the Import Objects button  the Import toolbar. The file manager will 
open.

2. Select the file format

• “All Object Files (*.wrl, *.wrl.gz, *.cor, *.csv)”, or

• “VRML 2.0 (*.wrl, *.wrl.gz)”, or

3. Browse to select the files which you want to import.

4. Click the Open button.

7.6.2 Importing surveyed reference points

External Reference 
Objects

Usually external reference objects are measured with survey equipment like 
total stations. For spheres, the survey point lies the center point of the sphere. 
For circular flat papers, the survey point lies the middle of the light circle, 
which stands out clearly from the surrounding darker border. Finally, for 
checkerboards, the survey point lies the center point of the four quadrants.

Survey data can be imported .csv file format into SCENE. You can import the 
survey data to workspace level or into a specific folder or cluster. Survey data 
is displayed a Reference folder in the workspace.

In the selected location, a folder called References contains a separate object 
for each survey point with the name and coordinates from the survey file. 

External references are mainly used for pairwise registration.

Figure 7-3 Clusters: Scans, indoor, Kitchen, Living Room and Outdoor

When registering scans within a cluster, external references are not 
mandatory. Nevertheless, existent external references will be used and will 
have a higher weighting in the registration algorithm than scan references. 
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If external references are available, the Reference folder of the cluster is used 
first. If not, the Reference folder of the next available higher leveled cluster is 
used. 

For example, if you want to apply the Place Scans command to cluster 
“Kitchen” the example above, the external references the References folder 
of the kitchen folder will be used. 

Each row of the file contains one single reference point with the following 
specifications: name, x coordinate, y coordinate, z coordinate, and 
measurement quality. All four specifications must be given and must be 
separated by the same separator, which can be a blank space, a colon, a 
semicolon, or a tab. The coordinates are specified in the unit that has been 
defined in Settings > General.

1. Click the Import Objects button  in the Import toolbar. The file system 
browser will open.

2. Select the file format “Surveyed points (*.cor, *.csv)”.

3. Browse to select the files which you want to import.

4. Click the Open button.

7.7 Import SCENE WebShare Cloud project modifications back to SCENE
If you have scan projects uploaded to SCENE WebShare Cloud, this scan 
projects might be modified by, for example, adding measurements or 

NOTE: When importing survey data, SCENE uses a right-handed 
coordinate system.

External references are only used with the target based 
registration

NOTE: In some applications, scans shall be registered without 
referring to higher-leveled references. In this case, create an 
empty Reference folder on the same level as the cluster with that 
scans, or create it somewhere between the cluster and the 
Reference folder which would be used.

NOTE: SCENE uses a right-handed coordinate system.
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annotations. You can import those modifications back to SCENE. Follow the 
steps below to do this:

1. Click the little arrow in the Create SCENE WebShare Cloud Data button in
the scan project toolbar.

2. Click Import SCENE WebShare Cloud Data from the drop down menu.

Figure 7-1 SCENE WebShare Cloud import dialog – Login

Domain – Enter your organization’s subdomain on SCENE WebShare Cloud. 

User Name (email) – Enter the user name with which you log in to SCENE 
WebShare Cloud. 

Password – Enter the password with which you log in to SCENE WebShare 
Cloud.

Save Credentials – Click to save your login credentials so that you do not have 
to enter them again in the future.

Cancel Import – Click to stop importing, and return to the scan project.

Select project

Figure 7-2 SCENE WebShare Cloud import dialog – Select project

Recommended Projects – the SCENE WebShare Cloud project which is most 
similar to the one opened in SCENE will be displayed. 

Other Projects in this Domain – click the little arrow to see all the scan projects 
saved in this domain. If you want to import the contents of one of these 
projects, select it by clicking its check box.
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Quick Import – the contents of the scan project are imported with default 
settings. Click the Next Step: Apply Changes button to import the scan project.

If you want to modify those settings, clear the Quick Import check box. Two 
additional dialogs are then shown in which you can specify the import process.

Figure 7-3 SCENE WebShare Cloud import dialog – Select Object Filters

Select Object Filters User filter

Select, if you want to import the modifications you made yourself, or if you 
want to import the modifications of other users as well.

If your SCENE WebShare Cloud role is Project Manager, you will be able to 
import all the modifications, even those which were set to “private” by one of 
the other users.

Object type filter

Select, which type of objects shall be imported. Click the Select button to 
select all object types, or none of them. If you select “none”, you must re-
select at least one of the check boxes below.

Category filter

Objects without a category – select, if you want to import objects although they 
have no category.

Category name – select, if you want to import all objects which are linked to 
this category.

Tag filter
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Objects without tags – select, if you want to import objects although they have 
no tags.

Tag names – select, if you want to import all objects which are tagged with 
this tag name.

Select Objects Figure 7-4 SCENE WebShare Cloud import dialog – Select Objects

Select at least one of the objects in the list. If you need more information on an 

object, click the  button. SCENE WebShare Cloud will then open Show 
Properties for this object.

Objects to be Updated

Click the objects which shall be updated. Click the Select button to select all 
objects of one type which shall be updated, or none of them. If you select 
“none”, you must re-select at least one of the object check boxes in the list.

Objects to be Created

Click the objects which shall be created. Again, click the Select button to select 
all object types, or none of them. If you select “none”, you must re-select at 
least one of the object check boxes in the list.
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Click the Apply Changes button to start the import.

Final report

Figure 7-5 SCENE WebShare Cloud import dialog – Final report

The Final Report shows a list of what has been imported. If you need more 

information on an object, click the  button. SCENE WebShare Cloud will 
then open Show Properties for this object.

Save Report – Click this button to receive a machine readable report. A dialog 
will open in which you can browse for a saving location.

Close report – Click this button to close the report. This will not save the 
imported changes. To save the changes, use the regular SCENE saving 
function.

The Final Report also shows errors which may occur while importing, for 
example:

• The scan project in SCENE includes an object with the same name as one
in the SCENE WebShare Cloud project, but it is not the same object. Such
an object will be given a default name.
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• A parent object is missing. It may happen that you uploaded a scan project
to SCENE WebShare Cloud, and, in the meantime, deleted one of the
scans in your scan project in SCENE. If you or someone else created
objects in that scan in SCENE WebShare Cloud, these objects cannot be
imported back anymore.

Check import in 
SCENE

You can now open one of the scans to see the imported objects. These 
objects are listed in the Structure View as well.

Structure View of a scan project after importing 
it back from SCENE WebShare Cloud:

• Modifications made in the Panorama View
of a scan are listed in the folder of that scan.

• Modifications made in the Overview Map
are listed in the folder of the Overview Map.
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Chapter 8: Processing

The Processing  toolbar offers a tool to process 

• the entire scan project

• a cluster

• a scan.

Some settings are restricted, depending on the selection:

• If at least one of the selected scans has already a scan point cloud, the
creation of scan point clouds is enforced for all selected scans to ensure
data consistency.

• If a scan was selected, the automatic registration is not available. The
automatic registration option only makes sense for clusters and the
complete project.

8.1 Process

The Process Scans button in the Processing tile or the  button starts the 
processing. 

NOTE: There is a second possibility to start Processing during 
executing Explore features: in the Structure View, right-click the 
scan project, cluster, or scan, then click Process Scan.
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Processing will perform the following steps depending on the selected settings 
in the Configure Processing for each scan.

Figure 8-1 Configure Processing

8.1.2 General

Colorize Scans

If you have a scan taken by a laser scanner with the color option, this scan will 
also contain the digital pictures which the scanner took automatically during 
the scanning. These pictures will be applied to color the scan if the colorize 
option is selected. 

Create scan point cloud

Scan point clouds will be generated if the related option is selected.

8.1.3 Filters

Dark Scan Point Filter

The Dark Scan Point Filter removes points based on a reflectance value. 
Reflectance Threshold: indicates the minimum reflectance value a scan point 
must have. The Reflectance Threshold range is: 0 to 2048.
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This criterion is useful because with a dark scan point, only a very small 
amount of light entered the scanner and therefore the measurement will have 
an increase in noise.

Distance Filter

The Distance Filter simply removes all scan points which are outside of a 
certain distance range. All points with a distance less than the Minimum 
Distance will be deleted, as well as all points that have a larger distance than 
the Maximum Distance.

Stray Point Filter

The Stray Point Filter checks if the 2D grid cell of a scan point contains a 
sufficient percentage of points with a distance similar to the scan point itself.

Edge Artifact Filter

The Edge Artifact Filter is enabled by default. The filter is especially useful to 
remove artifacts at the edges of objects.

8.1.4 Find Targets

The Find Targets section allows to select targets like checkerboards, planes, 
and spheres. These will then be searched in each scan during processing. 

Find Checkerboards

An often used type of paper targets is the checkerboard target. A 
checkerboard target fit determines the center point of the target’s four 
quadrants. Select this option to find checkerboards and use them for scan 
registration.

Find Markers

Select this option to find Markers. Markers are printed targets with a unique ID.

NOTE: This filter is not applicable on colorized scan points.

NOTE: The Stray Point Filter is very well suited to correcting 
incorrect scan data. It also works well, if the Allocation Threshold is 
below 50%. However, the filter must not be applied on surfaces 
that were strongly inclined versus the scanner’s laser. The filter is 
always applied to the whole scan. It is not possible to apply it only 
in selected areas.

NOTE: Finding targets is time consuming and must be enabled 
only when scans are registered with the Target Based registration.
95
Chapter 8: Processing



SCENE 2018 User Manual
Find Planes

Select this option to find planes and use them for scan registration.

Find Spheres

Three-dimensional, white spheres that come in various sizes. The advantage 
of spheres is that they can be placed at any angle to the scanner. Select this 
option to find spheres and use them for scan registration.

The global list of sphere sizes set in the Settings > Processing page are 
displayed in the active and inactive sphere radii list. 

Active Sphere Radii Click Add New and specify new sphere radii. These sphere sizes will be used 
for target detection.

This list of user-defined sphere sizes will be used for processing the scans in 
the current processing task run. 

Inactive Sphere 
Radii

Click Add New and specify additional sphere radii for sphere detection. 

Drag & drop the sphere radii that are not required for the current project, from 
the Active Sphere Radii to the inactive Sphere Radii list. 

You can easily move items between the two lists and manage the sphere radii 
for processing the scans in the current project.

8.1.5 Automatic Registration

Perform Automatic Registration

Select this option to enable automatic registration after the processing. If the 
automatic registration is enabled, the following registration settings will 
appear.

Select among the 4 options in the drop-down list: 

• Top View based registration

• Cloud to Cloud registration

• Top View and Cloud to Cloud (top view first and cloud-to-cloud afterwards)

• Target Based registration

According to the selected options in the drop-down list, further sub-options are 
displayed for setting. For example, if the Top View and Cloud to Cloud option 

NOTE: Sphere search works with spheres meant for registration. 
Forensic spheres may not be found by this target search.
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is selected, then the General, Top View and Cloud to Cloud sub options are 
displayed.

Figure 8-6 Automatic Registration Method: Top View and Cloud to Cloud

8.1.7 Start processing

1. Start Processing by clicking the Process Scans button.

2. Select a scan, a cluster, or the entire project. Then, click the Configure
Processing button.

3. The Configure Processing dialog provides the same settings as the
Processing Settings dialog, and also some options for automatic registration.
However, here, the settings are only valid for this task.

8.2 Results
When processing is finished, a dialog is shown in which shows the results. 

The dialog is color coded:

• green: all scans were successfully processed. Clicking the result line will
show the list of scans.

• yellow: some scans were successfully processed, but there are scans
which need special treatment. This dialog would consist of two parts: a list
of scans which were processed successfully, and a list with scans which
could not be processed. Clicking the result lines will show the list of scans.

• red: no scan could be processed.
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Chapter 9: Registration

9.1 Background knowledge

What is 
Registration?

Scan points are recorded and saved in a coordinate system which is relative to 
the scanner. The point of origin for this scan coordinate system is the position 
where the laser meets the mirror. The coordinates of this point are x = 0, y = 0, 
z = 0. If you have two or more scans taken at different locations in a room, 
right after scanning each scan will only know its own scan coordinate systems. 
But of course in reality the origins of these scan coordinate systems are at 
different positions in the room, so it is necessary to determine the spatial 
relationship between them. This is called registering the scan, and the step 
from the scan coordinate system into the overall coordinate system is called 
transformation.

The scans of your scan project might have a rough initial placement derived 
from the sensors of the laser scanner (GPS, Altimeter, Inclinometer or 
Compass), but, in general, it is still necessary to perform a scan registration to 
get a more precise spatial relationship between the scans. This initial scan 
placement thereby facilitates scan registration.

9.2 Registration Dashboard
The Registration Dashboard will guide you through the registration process. 
You will always be informed of the status, and it will help you to perform the 
necessary steps to get the desired results.

The Registration Dashboard shows a hierarchical view of the registration 
relevant objects: clusters and scans.

For clusters, it includes their current registration status, and it allows 
registration relevant actions on the cluster.

Figure 9-1 Registration Dashboard

 Automatic registration: you will be asked to select the cluster, and an 
automatic registration will be executed afterwards.
98
Chapter 9: Registration



SCENE 2018 User Manual
 Manual registration: you will be asked to select the cluster, and a manual 
registration will be executed after you have marked some scan points 
which the scans in this cluster have in common.

 Recommendation button: click to execute the recommended type of action.

 Automatic registration: will register this cluster automatically.

 Manual registration: will register this cluster after you have marked some 
scan points which the scans in this cluster have in common.

 Registration Report: shows the Registration Report.

 More button: provides additional cluster handling functions.

 Hint: The hint is shown when you use the Recommendation button. It 
suggests what is the best to do next with the cluster.

To view a specific scan or cluster, collapse or un-collapse a cluster by clicking 
on it.

If you click the preview image, it will be shown enlarged.

9.2.2 Registration Status

Colors

For each cluster, the current registration status is shown with a colored line in 
front of the cluster’s name. The registration status describes how well the 
subordinate clusters or scans are registered against each other. 

The following colors are possible:

• Green

A registration was performed and successful and you verified the result.

• Yellow

• A registration was performed and successful, but you did not verify it yet.

• A registration was successfully performed and verified by the user, but
an optimization is recommended through the used registration method.

• Red

• This cluster is not registered at all.

• A registration was performed but failed.

Hints

The Registration Dashboard shows a hint, if available, for a cluster. The hint 
can help you with what is the best to do next with that cluster. The following 
hints are possible:

• Perform Manual Registration

Perform a Manual Registration on this cluster.

• Perform Automatic Registration
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Perform an Automatic Registration on this cluster.

• Optimize Registration

Optimize the registration result by performing a Cloud to Cloud Registration
or target based registration if targets exist.

• Verify registration

A registration on a cluster was performed, but you have not verified the
result yet.

9.2.3 Registration Dashboard – Filter functions

The elements shown in the Registration Dashboard can be filtered by name.

Filter by name Use the text field shown to filter by names. As soon as you start typing a 
search string, the filter is automatically applied. Clear the search field by 
clicking the Clear Entry button.

9.3 Clusters
A cluster usually collects scans which somehow belong together, for example 
scans which were recorded on the same floor of a building, or scans which 
were taken in the same room. Scan groups, created during the scanning 
process, are also automatically put into a clusters when they are imported into 
SCENE.

Clusters are marked with an  icon.

The Registration Dashboard allows to modify clusters in a fast and 
comfortable manner.

9.3.1 Add Cluster

1. In the Registration Dashboard, click the More button , then click the Add
Cluster button. A new cluster will be inserted in subordinate level below the
one in which you clicked the button.

2. If required, name the new cluster, and click the  button.

Drag and drop 
cluster

If you want the cluster at another place, drag and drop it to its new place. 
SCENE checks if it is allowed to drop the cluster at the new place.

9.3.2 Disband Cluster

In the Registration Dashboard, click the More button , then click the 
Disband Cluster button. The cluster and its scans will be added to the 
superordinate cluster. Note that clusters which are scan groups cannot be 
disbanded.
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9.3.3 Delete Cluster

1. In the Registration Dashboard, click the More button , then click the
Delete Cluster button. A warning message will be shown.

2. Click the OK button to delete the cluster and its content.

9.3.4 Mark Clusters as Finished

Sometimes clusters are already registered correctly, but SCENE keeps 
suggesting additional steps because SCENE assumes the cluster is not yet 
finished. This can happen, for example, when a project was registered with an 
older version of SCENE, or if you decline to optimize the registration.

In such cases the Mark as Finished feature can be used to force a clusters 
status to finished (green). 

 In the Registration Dashboard, click the More button , then click the
Mark as Finished button. The display of the option will be changed to look
active.

 Click again to disable the Marked as Finished status.

Figure 9-5 Finished cluster

If this feature is enabled for a cluster, the cluster will be shown as finished 
(green) and contains a hint that explains the status (to not confuse it with the 
finished status computed by SCENE).

When you click the hint, a popup is displayed. The button at the bottom can be 
used to restore the clusters registration status as it was computed by SCENE. 

NOTE: The activation works recursively. That means if you enable 
Mark as Finished for a cluster, all subordinate clusters will be also 
marked. The same applies for removing the Mark as Finished 
status. All subordinated clusters will get their “real” registration 
status back.

The Marked as finished feature does not lock the cluster or 
prevents any other manipulation of the cluster. It is just a flag that 
tells SCENE that the cluster should be always displayed as 
finished. Any registration task can be started as usual on the 
cluster, but you will not be able to see the resulting registration 
status until you remove the Mark as Finished flag.
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9.4 Targets
Targets are physical objects in the area to be scanned that SCENE can detect 
and use to register the scans. A target can be a naturally occurring plane such 
as a wall or desk, or you can use extra objects made specifically to function as 
targets. These artificial targets are spheres, checkerboards, and markers.

Planes, Spheres, 
Markers, or 
Checkerboards?

There are several things to consider when deciding which type of targets to 
use. 

• Since planes probably exist in the environment you are scanning, you don’t
have to do anything extra to use them. But you can’t be sure that your
environment will have enough planes, and you can’t document the location
of the target by other means, i.e., via GPS coordinates.

• Spheres are highly accurate at any angle to the scanner and are often used
in conjunction with GPS coordinates, but they are more expensive than
printed targets, and can be bulky to transport.

• Both checkerboards and markers can be printed with your laser printer.
They are easy to transport and replace, but they do not work if they are
placed at an oblique angle to the scanner.

• Checkerboards, when scanned at right angles, can be detected at greater
distances than other types of targets.

• Markers and planes can be automatically detected in scans made by both
the Laser Scanner and the Freestyle Scanner, so you can use one set of
targets for both types of scanner.

9.4.1 Spheres

Three-dimensional, white surveying spheres can be used as targets. A sphere 
is determined by its position and its radius, and its central point is used for the 
registration. Hence, you can add global position information to the sphere‘s 
property.

Spheres with preset 
radius

This type of sphere is particularly well-suited to fitting survey spheres, 
because their radius is known in advance. Use one of the following options to 
create spheres with a preset radius:

• During the Manual Registration, select the Mark Sphere button .

• Right-click a scan or a scan point selection, then click Find Objects. In the
menu, select Spheres.

NOTE: Sphere search works best with surveying spheres that are 
meant for registration. Forensic spheres (used for determining 
trajectories) may not be found by this target search.
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You can predefine one or more sphere radii under Settings > Processing.

Figure 9-2 Fitted survey sphere

9.4.3 Checkerboards

A frequently used type of paper target is the checkerboard target. A 
checkerboard target fit determines the center point of the target’s four 
quadrants. This point is used for scan registration.

Figure 9-4 Checkerboard target and fitted checkerboard point

Creating 
checkerboard points

• During the Manual Registration, select the Mark Checker button .

• Right-click a scan or a scan point selection, then click Find Objects. In the
menu, select Checkerboards.

9.4.5 Markers

Markers are a third type of target that can be used for registration. Markers are 
printed and used like checkerboards, but unlike checkerboards, markers are 
unique. This means that correspondences between scans are only possible 
for markers with the same ID. After installing SCENE, a PDF-file containing 
200, A4-size pages each with one marker and one unique ID can be found at:

<Installation Path>\
RegistrationMarkers\RegistrationMarkersA4.pdf

You can print the markers at a reduced size in order to cover up less of the 
area that you are scanning but this will change the maximum distance at which 
the markers can be detected. The table below shows the distances at which 
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markers can be detected depending on scan resolution and marker size. Note 
that the markers must be placed orthogonally (at right angles) to the scanning 
direction to reach these limits.

Marker IDs must be unique within a project. Ensure that you do not include 
two markers with the same ID in the scan area.

9.5 Automatic Registration
The Automatic Registration looks for similar geometric constellations in the 
scans. The result can then be viewed and evaluated in the Correspondence 
View.

Automatic Registration uses inclinometer data, if activated in Settings > 
Registration.

9.5.1 Select Cluster

There are three ways to start an Automatic Registration:

• Click the Automatic Registration button in the toolbar. You will then be
asked to select a cluster.

• Click the Automatic Registration button in a cluster line. Select the settings
to start registration.

• Click the recommendation to perform an Automatic Registration in a cluster
line. Select the settings to start registration.

Scan Resolution
Marker size 100% 15.5cm (6 

in)
Marker size 75% 11.7cm 

(4.5 in)
Marker size 50% 

 8 cm (3 in)

1/8 3 m (9 ft, 10 in) 3 m (9 ft, 10 in) 2.5 m (8 ft, 2 in)

1/4 6.5 m (19 ft, 8 in) 5.2 m (17 ft) 4.2 m (14 ft, 9 in)

1/2 16 m (52 ft, 6 in) 8.3 m (27 ft, 2 in) 5.3 m (17 ft, 6 in)

NOTE: To print the markers at 100% on 
US letter size paper, select Actual Size, 
instead of Fit or Shrink. The A4 pages 
will be trimmed slightly but the markers 
and IDs are not affected.

NOTE: Check the Registration Settings for the type of Registration 
to be executed. You can select among 4 options: 

• Target based,

• Top View based registration,

• Cloud to Cloud registration,
Top View first and Cloud to Cloud registration afterwards.
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Automatic 
Registration from 
the header line

1. Click the Automatic Registration button  in the header line. 

2. Select a cluster, then click the Select Method button on the upper right side.
The Select Method dialog is shown.

3. In the drop-down menu on the left side, select the registration method.
Available registration methods are: Top View Based, Cloud to Cloud, Target
based, and a combination of Top View Based and Cloud to Cloud
registration.

4. For Target based, a Verify Targets selection is available. Selecting this
check-box will show a list with scans located under the cluster that should
be registered. Each scan can be viewed either in a 3D View or a Quick
View. For manipulation of targets mark tools are provided. Furthermore it is
possible to delete individual targets by selecting them in the Quick View or
in 3D View, and pressing the Del key.

5. On the right side, the available settings for this registration method are
shown. This settings correspond with those in the Registration Settings page.
If necessary, modify the settings. Your modifications will now be valid for
the current registration. It will not change the settings made in the
Registration Settings.

6. Click the Register and Verify button on the upper right side.
The registration is executed. Depending on the number of scans in this
cluster, this may take some time.

7. Verify the registration.

Figure 9-2 Automatic Registration task, first step: select a cluster

Automatic 
Registration from 
the cluster line

1. Click the Automatic Registration button  in the cluster’s line. 

2. Click the Select Method button on the upper right side. The Select Method
dialog is shown.

3. In the drop-down menu on the left side, select the registration method.
Available registration methods are: Top View Based, Cloud to Cloud, Target
based, and a combination of Top View Based and Cloud to Cloud
registration.

4. On the right side, the available settings for this registration method are
shown. This settings correspond with those in the Registration Settings page.
If necessary, modify the settings. Your modifications will now be valid for
the current registration.

5. Verify the registration.
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9.5.3 Register and Verify

Figure 9-4 Registration task, verification: 3D View

A 3D View is displayed with which you can check if the registration was 
successful. 

Use the 

• Camera Mode buttons  and View buttons  in the task panel to change 
the observers view,

• View All button to get a view on all the objects,

• Unique Color button  in the task panel to switch between scan
colorization modes (“color per scan” or “original scan colors”).

Registration was 
successful

In the verification step, you are asked if the registration was successful. 

Yes: the cluster is marked as registered and you are returned to the 
dashboard. 

No: marks the registration of the cluster as failed and continues to the 
dashboard which will suggest a manual registration for the cluster.

Registration failed 
but Auto Clusters 
are found

If the automatic registration failed but could create one or more Auto Clusters 
with some partial results, the verification step for partial results will be 
displayed. 

1. Decide which of the Auto Clusters you want to keep. When the task step
opens, a 3D View showing all generated Auto Clusters is opened first.

2. Select a view to check the Auto Cluster. For this, use the 3D View or
Registration Report button for each of the generated Auto Clusters.
Additionally, there are also some tools shown in the task step that are
useful for this verification step.
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Every Auto Cluster that is not selected will be disbanded and its scans will be 
moved back to the parent cluster. The selected auto clusters will become 
normal clusters and are marked as registered.

The Finished button is colored green and clickable since this step is shown. 
Clicking this button finishes the task and returns you to the dashboard. The 
selected clusters from the verify step are shown yellow with the hint that the 
registration should be optimized.

9.5.5 Optimize Registration

Optimize Registration executes a Cloud to Cloud registration or target based 
Registration if targets are existing, with the settings you have made in the 
Registration Settings.

The result is not 
satisfying? 

Select the No check-box and click the Other Pair button. You are returned to 
the Select Scans step, and you are asked to select the next scan pair.

9.6 Manual Registration
The Manual Registration can be executed for a cluster. 

It offers the possibility to identify corresponding scan points of two scans by 
picking such scan points. As soon as there are sufficient corresponding scan 
points, SCENE will register the two scans. The result can then be viewed and 
evaluated in the Correspondence View.

Manual Registration uses inclinometer data, if set in the Registration Settings.

There are three ways to start a manual registration:

Manual Registration 
from 
recommendation

Click the recommendation to perform a Manual Registration in a cluster line. 

Manual Registration 
from the header line

1. Click the Manual Registration button  in the header line. 

2. Select a cluster.

Manual Registration 
from the cluster line

Click the Manual Registration button  in the cluster’s line. 

If there is an Optimize Registration step at all depends on the 
settings you have made in the Registration Settings. Optimize 
Registration is only available if you select Top View based 
registration for the Automatic Registration or Manual Registration.
NOTE: 
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9.6.1 Select scans

When a cluster is selected, Select Scans is shown. In this step, scans or 
clusters that must be registered with each other, can be selected.

1. Click Select Scans on the upper right of the header line. Now, the display is
divided into two columns, and each column shows previews of the scans in
the selected cluster.

• You can filter the lists by name. Enter the string in the Find name... field
above each column.

• It is also possible to sort the scans by Recording Time and Name. Click
the text to open the selection, then select the type of sorting. Click the
small field with the triangle to sort upwards or downwards.

• For the right column, it is possible to sort by the Best Match. Best Match
means that scans with a similar recording date as the selected scan on
the left side are shown first. For every sort method except for the Best
Match, it is possible to reverse the sort order by clicking on the triangle
next to the drop down.

Figure 9-2 Manual Registration task, first step: select scans

2. Select a scan by clicking its preview. The header of scan preview is marked
blue. The preview of the this scan in the other column will be grayed and is
no longer accessible.
If by accident the wrong scan was clicked, simply click another one.

• If a cluster contains a subordinate cluster, the scans in these cluster are
displayed as a single flat group of scans. To register such a subordinate
cluster, pick one representative scan. Selected subordinate clusters are
also framed in color, they can be expanded or collapsed.

3. Change to the other column and select a second scan by clicking its
preview. Again, the scan preview is marked with a blue triangle in its upper
left corner. The preview of the same scan in the other column will be grayed
and is no longer accessible.
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9.6.3 Mark Targets

1. Click the Mark Targets button on the upper right side of the header. Now,
the display changes to the Split View.

• In the column on the left side, SCENE will show buttons, notes, and
advices which guide you through the registration.

• The two windows show each the two selected scans in a Quick View.

Figure 9-4 Manual Registration task, second step: select targets

2. Rotate, move, zoom the two scans until you have them in a useful position,
i.e., they show the same part of the scenery.

3. Check for natural targets like points or planes, or artificial targets like
spheres, markers or checkerboards which could be useful and which are
not marked yet.

• Select the Mark Point button  to mark a point.

• Select the Mark Plane button  to mark a plane.

• Select the Mark Sphere button  to mark a sphere target.

• Select the Mark Checker button  to mark a checkerboard target.

NOTE: Some types of scans will be shown in a 3D View, for 
example Freestyle3D scans.
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• Select the Mark Marker button  to mark a Marker

Plane Normals A plane is identified by the fact that it is level, i.e., there is precisely one 
direction that the plane stands perpendicular to (actually, there are two such 
directions; however, they are exactly opposite to one another). This direction is 
called the Normal of the plane.

Some types of scans will be shown in a 3D View, for example Freestyle3D 
scans. 

In this case, an additional Invert Plane Normal button is displayed on the 
image, This button can be selected to invert the Normal. This avoids that the 
scan is placed with a flipped orientation.

4. Mark the targets by hopping and clicking between the windows.

If SCENE detects that there are correspondences among the newly
marked objects, or one of the newly marked target corresponds to an
earlier marked target, it will mark them with a label.

Figure 9-5 Split View with detected correspondences

The label then has a small green field with a “C” which indicates that those 
correspondences were found automatically.

NOTE: Points are typically hard to mark because it is difficult to 
determine where exactly they are in a 3D View. If you have the 
chance to mark planes, mark the planes.

NOTE: A label shows a name with a maximum of 9 characters. If 
the name has more characters, only the last 8 will be displayed 
and an asterisk (*) will replace the missing characters. As soon as 
you click a label, the name is shown completely.
110
Chapter 9: Registration



SCENE 2018 User Manual
The frame around the label symbolizes the quality of the correspondence:

• Green: good quality

• Yellow: compromised quality

• Red: seriously compromised quality

5. Continue with marking correspondences until the button on the upper right
side changes from Mark Targets to Register and Verify, and gets a green
color. This means that there is a sufficient number of correspondences to
perform the registration.

Delete specific 
targets or 
correspondences

It may happen that, at the end, your scans would show marked targets which 
were not needed for a correspondence, or you want to delete a 
correspondence because it is wrong.

 Right-click the correspondence, then click Delete ‘name’.

If two or more correspondences are very close to one another, a list will be 
shown. Select one of the correspondences by clicking on it, then click Delete 
‘name’.

9.6.6 Register and Verify

1. Click the Register and Verify button on the upper right side.
The registration is executed.

2. Verify the registration.

3. Click either the Finish button, if there are no more scans in this cluster, or
click the Next Pair button to register the next scan pair.

AutoCluster In order to save registered pairs during registration, they are moved into a so-
called AutoCluster. It is created below the previously selected cluster, which is 
the cluster in which scans pairs are to be registered. If SCENE needs more 
than one AutoCluster, these AutoClusters are numbered.

After all scans and clusters were registered, these automatically created 
clusters are removed.

9.6.7 Optimize Registration

Optimize Registration always offers a Cloud to Cloud registration. To do this, 
click the Start Optimization: Cloud to Cloud button. 

After a manual registration, the cluster contains scans with user-defined 
targets. A target-based registration can be performed using Start Optimization: 
Target Based step button. 

NOTE: If you cancel a registration for some reason, you would see 
such an AutoCluster in the Registration Dashboard.
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9.7 Visual Registration

Visual Registration provides an option to place scans and 
clusters in the correspondence view by moving them with drag 
and drop. After a placing, an Automatic Registration can be 

started to refine the registration. 

There are three ways to start a Visual Registration:

• Click the Visual Registration button in the Registration toolbar. You will
then be asked to select a cluster.

• Click the Visual Registration button in a cluster line. Select the settings to
start registration.

Figure 9-1 Visual Registration on a Cluster 

• Click the recommendation to perform a Visual Registration in a cluster
line. Select the settings to start registration.

Figure 9-2 Recommendation to perform a Visual Registration

9.7.3 Select Cluster

In the first step, select an cluster that must be used for registration. 

9.7.4 Select Method

In the second step, select a method that must be used for registration: 

1. Click the Select Method button on the upper right side. The Select
Method dialog is shown.

2. Visual Registration provides only two methods:
• Cloud To Cloud

• Target Based.
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9.7.5 Place and Register

Figure 9-6 Visual Registration: Place and Register Scan

In the third step, place and register the scans:

1. A correspondence view is opened on the selected cluster. Move the scans
and cluster in the view by selecting them with a mouse click. Drag and drop
them on the shown manipulators.

2. Place all scans and clusters correctly in the correspondence view. Click the
button Start Registration.

3. If the registration is successful, the result is displayed in the 3D View or
through the Registration Report. If the registration is not successful, a
dialog is shown to inform the user.

9.8 Registration Report
Once you have gone through all Registration steps, the Registration Report 
will give you an overview on the results.

Open Registration 
Report

In the Registration Dashboard, click the Registration Report button.This button 
is also displayed on the final page of the registration task.

NOTE: To better be able to place the scans/clusters and verify the 
result, select Unique Color or Scan Color or create an Auto 
Clipping Box. 

NOTE: For the report, all values with a length unit (point error, 
subsampling settings, and others) will be shown in the smallest 
unit of the selected set (metric = mm, imperial = inch, imperial US 
= inch US).
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9.8.1 Target Statistics

Target Statistics shows all reference pairs and target pairs used for the scan 
registration. Values close to zero indicate a good registration result. Here you 
can easily identify reference pairs which are causing problems in the 
registration.

All values are color coded with a bar on the left side, same as the table cells.

Figure 9-2 Target based registration report

 Name of the cluster
The name of the registered cluster the report is opened on.

 Switch between Target Statistics and Scan Point Statistics.

The following statistics display the averaged Maximum and Mean error 
between all targets in this cluster.

•  Maximum Distance Error / Mean Distance Error

•  Maximum Horizontal Error / Mean Horizontal Error

•  Maximum Vertical Error / Mean Vertical Error

 Maximum Angular Error / Mean Angular Error

Shows the averaged maximum or minimum angular error between all 
plane targets in this cluster.
Angular errors can only be calculated for plane targets, which are planes, 
checkerboards, and slabs.

 Settings

Displays used settings and for placing the scans as well as a legend for the 
color coding of errors.

 Report Mode
The report has three modes:

• Simple: Displays all statistics between the first-level scans of the cluster.
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• Full: Displays all statistics between all scans inside the cluster
(recursive).

• Color Matrix Mode

 If you require the Registration Report Table for usage outside SCENE, you can 

either save the report as PDF or copy the report directly into Excel®. Mark the 

table, or parts of it, and copy it to Excel®. Save the Registration Report as PDF

 Click the Close button to close the Scan Report and to return to the 
Registration Dashboard.

 Matrix 
Gives a colored overview for the registration quality of the scans. Displays 
the error between a pair of scans or cluster. The type of error shown (e.g. 
Max Distance Error) can be changed in the Error Type Selection List.

 Error Type Selection List 
Open the drop down menu to select the type of error you want to see in the 
corresponding mode.

The view of the matrix depends on the content of the selected cluster. If this 
cluster contains subordinate clusters, the matrix displays the registration 
quality for those clusters. If the selected clusters contains scans, the matrix 
displays the registration quality for those scans. 
If there is a square in yellow, red, or green color and you want to know which 
pair of scans or clusters they represent, use the mouse to hover over the 
square. The names of the two scans or clusters are displayed, with the error 
value.

Figure 9-3 Target based registration report, detailed errors

The Detailed Errors table shows errors between corresponding targets in a 
structured way:

• In the first level, the registered scans or clusters are listed. The maximum
and mean errors for all the connections of the scans or clusters in the first
level are displayed.

• In the second level, the scans or clusters with which the scan or cluster of
the first level has targets in common, are listed.The maximum and mean
errors for each connected scan pair are displayed.
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• In the third level, individual targets and the errors in the registration of
corresponding targets between the scans of the first and second level are
listed. The point errors are displayed for each connected target pair.

Inclinometer 
Mismatches

The Inclinometer mismatches list is shown as part of the scan point statistics. 
This list displays the angular offsets between a scan's up direction after 
registration and the scan's up direction according to the scanner's 
inclinometer.

Figure 9-4 Target based registration report, inclinometer mismatch

For scans without an inclinometer, a dash ‘-‘ is shown instead of a value.

Scan names are specified as follows:

• Scan Name: For direct Scans of the main report cluster.

• Cluster Name: For sub-clusters.

• Cluster Name_Scan Name: For scans in the sub-clusters of the report
cluster.

9.8.5 Scan Point Statistics

Figure 9-6 Scan point based registration report

 Name of the cluster
The name of the registered cluster the report is opened on.

 Switch between Target Statistics and Scan Point Statistics.
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 Maximum Point Error
Maximum point error of all shown scan pairs.

Mean Point Error
Mean point error of all shown scan pairs.

 Minimum Overlap
Minimum percentage overlap of all shown scan pairs. All values are color 
coded with a bar on the left side, same as the table cells.

 Settings
Displays the settings used to register the selected cluster.

 Report Mode
The report has two modes:

• Simple: Will show all statistics between the direct children of the cluster.

• Full: Will show all statistics between all scans inside the cluster
(recursive).

The Report Mode is only visible when the report is opened from the 
Registration Dashboard. When opened in the registration verification, the 
simple mode is shown.

 If you require the Registration Report Table for usage outside SCENE, you can 

either save the report as PDF or copy the report directly into Excel®. Mark the 

table, or parts of it, and copy it to Excel®. as PDF

 Click the Close button to close the Scan Report and to return to the 
Registration Dashboard.

 Color Matrix Mode.

 Error Type Selection List.

Detailed Errors, 
Scan Point Statistics

Figure 9-7 Scan point based registration report table

The Detailed Errors table (in Simple Mode) shows detailed error values for 
every registered scan pair or cluster pair:
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• Depending on the selected report mode, in the first hierarchy, all scans
inside the cluster are shown. The errors that are displayed are applicable to
all connections of the Scan or Cluster.

• The first hierarchy will show the name of the scan or cluster, the number of
connections it has, the mean point error, maximum point error and
minimum overlap.

• By clicking on the first hierarchy row, the connections show the individual
scan or cluster Name, point error, and overlap.

• The three right columns are color coded with red, orange and green
according to specific thresholds that can be adjusted using the registration
settings.

The table can be sorted by clicking on the table header of every column.

9.8.8 Saving or Exporting the Registration Report 

If you require the Registration Report Table for usage outside SCENE, you 
can either save the report as PDF or copy the report directly into Excel®. Mark 
the table, or parts of it, and copy it to Excel®.

Clicking the Save Report button opens a File Open dialog where a location and 
a file name can be chosen. 

In the PDF report, the same data is displayed like in the SCENE report. 
Additionally some information about the project are listed like project name 
and recording period.

9.9 Import Surveyed Points
In the Registration Toolbar, you have an option to import surveyed points. We 
can use this option, when we need to include external references. For further 
information, see Importing surveyed reference points.

Figure 9-1 Registration Toolbar

Click the Import Surveyed Points  button.

A File Open dialog box opens where you can choose the Surveyed Points file 
to be imported (in .cor or .csv format). An Import References dialog opens. You 
can select any of the following options and click Import:

• Import on workspace level

• Import on cluster level

NOTE: When importing the table to Excel®, the decimal 
separator has to correspond to the decimal separator used in 
SCENE. Otherwise, the numbers will be automatically 
converted into another format, e.g., a date.
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• (Import) From Structure and map it to /Scans directory or pathname.

The imported survey points are used for Registration. 
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Chapter 10: Explore

10.1 View Project 

 Click the View Project button . The scan project is shown in a 3D View.

You can use a scan for many different purposes.

The Explore features allow to analyze a scan in different views.

Types of views There are various views to display and explore scans and point clouds:

Quick View

The standard scan view to examine single scans. The Quick View is available 
within a few seconds; in the meanwhile the scan data will be loaded in the 
background. You can manipulate the scan points as soon as background 
loading is finished. Until then, you are only able to view and navigate.

Planar View

Used to examine single scans. The scans must be loaded manually.

3D View

The 3D View is not limited to display the scan points of a single scan or scan 
point cloud, it also offers the combined viewing of all the scans and objects in 
your project point cloud or workspace.

Structure View The Structure View displays the structure of the workspace, including all 
folders and objects. If you click the name of those folders and objects with the 
right mouse key, a so-called context menu will open which offers specific 
functions.

NOTE: When a Project is opened, the scans are not automatically 
loaded. To load all scans, select Load all Scans option in the 
context menu of the Project. To unload all scans, select Unload all 
Scans and Pictures option in the context menu of the Project

However, to unload the scans, de-select the Loaded option in the 
context menu of the Scan or Cluster. After a Scan is unloaded, it 
can be reloaded by selecting the Loaded option.

NOTE: When a Project is opened, the scans are not automatically 
loaded. To load all scans, select Load all Scans option in the 
context menu of the Project. To unload all scans, select Unload all 
Scans and Pictures option in the context menu of the Project

However, to unload the scans, de-select the Loaded option in the 
context menu of the Scan or Cluster. After a Scan is unloaded, it 
can be reloaded by selecting the Loaded option.
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By default, the Structure View is folded away. If you want it to stay visible, click 
the Structure button, then click the little pin needle button.

VR View

10.2 Clusters

Figure 10-1 Structure View 

SCENE 7.1 introduces the ability to step into your point cloud with virtual 
reality (VR). You can now experience your scans as if you were on location, 
take measurements, make screen captures, and read annotations

To create a new cluster:

1. In the Structure View, right-click the Workspace name, then click New >
Cluster. A cluster will be created.

2. Give the cluster a name.

3. Create more clusters, for example “FirstFloor”, “SecondFloor”, “ThirdFloor”.

4. If required, create subordinate clusters, for example, clusters that contain
the scans for special rooms.

5. Arrange those clusters by dragging and dropping them into the respective
superordinate cluster.

6. Drag and drop the scans into the clusters in which they belong to. You can
also drag and drop subordinate clusters into a cluster folder.

10.3 3D View
With the 3D View, you can achieve the most easily comprehensible view of the 
scan points and CAD models. The 3D View is normally set up with the field of 

NOTE: You can combine laser scanner scans and Freestyle scans 
in one scan project.
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view corrected, so that you get an impression close to reality. Unlike the Quick 
View and the Planar View, scan points manipulation and analysis is limited in 
the 3D View.

The 3D View will show scan point clouds, or the project point cloud. Such a 
point cloud has to be generated by SCENE 6.1.

No point clouds 
available at all

If there are no such point clouds, these will be generated automatically. During 
generation, no scan points are displayed. This is not the case for Freestyle3D 
scans during capturing, because those scans have a different format and will 
be converted later on during processing.

Point clouds from 
earlier and current 
SCENE versions 
available

If your scan project contains point clouds of new and old format (including 
scans for which no point cloud has been created), the following will happen:

• Automatic conversion of legacy point clouds in the background.

• A warning message is displayed.

It is not possible to edit the legacy point clouds until they are converted.

Point clouds of 
earlier SCENE 
versions available

If your scan project contains point clouds of an old format, editing of the point 
clouds is possible.

You will be informed that these point clouds should be updated.

NOTE: On systems with NVIDIA Quadro graphics processors, 
rendering performance in the 3D View might be slow or 
intermittent. In order to improve rendering performance, start the 
NVIDIA Control Panel application (available in the Windows 
Control Panel) and select the global preset 3D App – Game 
Development from the Global Settings tab.
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3D View of a single 
scan

 Right-click the scan‘s name in the Structure Window, then click 3D View in
the context menu.

Figure 10-1 3D View of a single scan

3D View of a cluster You can also open the 3D View for all the scans within a cluster.

 Right-click the cluster‘s name in the Structure Window, then click 3D View in
the context menu.

In the 3D View, the points of scans have priority over the points of scan point 
clouds, which means that the points of loaded scans will be displayed instead 
of the points of the related scan point clouds.
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3D View of the 
project point cloud

Figure 10-2 3D View of a project point cloud

1. Click the 3D View button  in the toolbar.

Or:

1. Right-click the superordinate cluster in the Structure Window. Typically, it is
simply called „scans“. Then, click 3D View in the context menu.

Normally, the 3D View displays the scan points and objects with the correct 
field of view, in other words, objects of the same size appear smaller with 
increasing distance (Perspective View). You can also change the view to an 
Orthographic View. Then, objects of the same size always appear the same 
size, regardless of how far away they are. This type of representation is 
common in a lot of CAD systems. You can switch between these two 
representations in the Navigation Toolbar (3D View only).

NOTE: If no project point cloud is available, this button or 
command will open the 3D View of all scans in the workspace. 
Displaying the scans of a workspace behaves like displaying the 
3D View of a cluster.
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10.4 Quick View

Figure 10-1 Quick View

The Quick View is the standard view and displays the content of a single 
scan. 

To start the Quick View,

• double-click the scan‘s name in the Structure Window.

• right-click the scan‘s name in the Structure Window, then click View >
Quick in the context menu.

After the Quick View has been opened and is displayed, the scan point data 
will be loaded in the background. However, until then you can view the scan 
and navigate but you cannot access and thus not manipulate the scan points. 
As soon as the scan data has been fully loaded, all the scan point 
manipulation functionality is available.

The following restrictions apply in the Quick View:

• You always see the scanned area from the scanner position, which means
you cannot leave this position. However, you can of course change your
line of sight and scale.

• The field of view cannot exceed 180°.

You can adjust the line of sight by holding the left mouse button down and 
moving the scan points in the direction required. In Quick View, the Examine 
Mode is the standard viewing mode.
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10.5 Planar View

Figure 10-1 Planar view

Like the Quick View, the Planar View displays the content of a single scan 
only. 

To start the Planar View 

• right-click the scan‘s name in the Structure View, then click View > Planar
in the context menu.

At first glance, the Planar View may appear very strange because the scanned 
area seems to be distorted. Straps and supports do not run in a straight line 
but are curved. For the Planar View, SCENE uses the same technique as it is 
used for depicting the earth's surface on a map where the area around the 
poles appears to be magnified, and the flight route between two distant cities 
is not straight but bent.

The consequence of the distortion is that it only succeeds approximately in 
displaying other objects congruent with the scan points. If a scanned reference 
sphere already appears in the view more like an ellipsoid than a sphere, do 
not be surprised that the added reference object does not cover the reference 
sphere completely. For this reason no CAD models are displayed in the Planar 
View; use the 3D View for this instead.

The Planar View is useful because of the fact that with some scanners, it is the 
most natural display format of the scan points. A lot of scanners process the 
horizontal and vertical angles step by step; it is therefore practical to display 
the scan points in a column and row oriented manner accordingly.

The view starts at the left margin with the first column the scanner recorded. In 
the local coordinate system of the scanner, this column normally has the 
horizontal angle of 0°. The subsequent columns then come to the right, with an 
increasing horizontal angle until 360° is reached with a circumferential scan. In 
the top row, the scan points with the greatest vertical angle reached are 
displayed, for example, the zenith with +90°, which is directly over the 
scanner. From top to bottom, the vertical angle decreases, reaching 0° at the 
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horizontal line and then becoming a negative value. The smallest possible 
vertical angle is –90°.

As in the Quick View, you always view the scanned area from the scanner 
position – you cannot leave this position. However, you can of course change 
your line of sight and scale.

As in all views, you can set the scale using the scroll wheel of your mouse. 
There are also further buttons in the toolbar for the Planar View which you can 
use to change the scale. 

10.6 Explore Toolbar
.

Figure 10-1 Explore Toolbar for Quick or Planar View

Figure 10-2 Explore Toolbar for a 3D View

The functions you see in the Explore toolbar depend on the kind of view. For 
example, the Create Virtual Scan button will not be shown when a scan is 
opened a Planar View.

The Explore features allow to analyze a scan in different views.The Explore 
toolbar has the following options: 

• View Project

• VR View

• Overview Map

• Annotation

• Measure Points

• Select Polygon

• New Selection

• Save Screenshot

• Mark Distance Range

• Project Point Cloud

• Only in Quick View or Planar View:

• Color Mode

• Mark Points

• Only 3D view:

• Viewpoints

• Auto Clipping Box

• Show Grid
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• Mesh Selection

• Create Virtual Scan

Several buttons include more than one function and are marked with a little 
arrow beneath the icon. To see those functions, simply click the button and a 
dropdown menu will open. Some of these functions might be grayed because 
they do not work with a certain view. As soon as you select a function out of a 
dropdown menu, its icon will be shown in the toolbar.

10.6.3 Explore features in Quick View or Planar View (2D view)

Color mode This button provides an option to easily switch between color and gray 
(intensity) mode views of a scan. Click Color Mode to reload the scan in the 
color mode or gray (intensity) mode. 

If there is more than one view opened on that scan, all views are updated and 
the scan data is visualized in the new color mode.

If the color mode is selected and the scan contains only color or gray mode 
views, then a warning: “Toggle color mode is not possible as color or gray 
(intensity) data is not available” is displayed.

Mark Point The Mark Point menu provides different options to mark points, planes 
spheres, checkerboards or markers.

Figure 10-4 Mark Point

10.6.5 Navigating with the mouse in 3D View

Left mouse button Click the left mouse button, then drag the mouse to move the image area.

Double-click with 
the left mouse 
button

When you double-click a scan point the 3D view, the camera flies towards that 
scan point. Each time you double-click again on the same scan point, the 
camera flies even closer to that scan point.

To stop this Fly to point feature, move the view with the mouse or with the 
respective keys.

Middle mouse 
button (mouse 
wheel)

Mouse wheel: Zoom in or out.

Click the middle mouse button or the mouse wheel to shift the image.

Right mouse button Clicking with the right mouse button on a view or an object will open the so-
called context menu. The context menu offers specific functions valid for this 
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view or object. From the context menu, you can also open the Properties 
dialog.

10.6.6 Navigating with the mouse in Quick View

Left mouse button Click the left mouse button, then drag the mouse to move the image area.

Middle mouse 
button (mouse 
wheel)

Mouse wheel: Zoom or out.

Click the middle mouse button or the mouse wheel to shift the image.

Right mouse button Clicking with the right mouse button on a view or an object will open the so-
called context menu. The context menu offers specific functions valid for this 
view or object. From the context menu, you can also open the Properties 
dialog.

10.6.7 Navigating with the mouse in Planar View

Left mouse button Click the left mouse button, then drag the mouse to move the image area.

Middle mouse 
button (mouse 
wheel)

Zoom or out.

Right mouse button Clicking with the right mouse button on a view or an object will open the so-
called context menu. The context menu offers specific functions valid for this 
view or object. From the context menu, you can also open the Properties 
dialog.
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10.7 Overview Map
The overview map provides a top view overview to the whole scan project. 
The map is by default, a gray scale image. It is recommended to create the 
map after the registration and cleanup of scan points is completed. 

Figure 10-1 Overview Map

The  icon with the dropdown button provides a menu with the following 
options:

Open This option is only enabled when an overview map exists. It will open a new 
view with the map.

Create Select this option to create a new overview map for a scan project

Update If you change the transformation of scans or clusters, or if scan points are 
deleted after the map has been created, the map becomes invalid. Update the 
map in such instances. 

Delete Select this option to delete the overview map. 

NOTE: An overview map can also be opened on a single scan or a 
cluster. Right-click the desired object to open the context menu 
and select 
View > Overview Map. This overview map displays only the scan or 
the scans that are part of the cluster.

NOTE: Even though an overview map is deleted, it may be 
available in older revisions of your project. Perform the Wipe 
Project History operation to free the space allocated for the 
overview map files in old revisions, if required.
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The toolbar contains a button to toggle the scan location visibility as well as 
buttons to zoom/zoom out.

The lower left corner contains also a scale bar that shows the metric and 
imperial scale. The default scale is meter or feet. 

Each scan is marked with an icon. Hover on a scan marker icon to view the 
name of the scan. Click the icon, to open a popup. The popup contains the 
name of the scan and buttons to open quick and 3D views of the scan. 

10.8 Annotations (3D View, Quick View, Planar View)
To attach a documentation object to a certain scan point, 

1. Open a view of a scan, a cluster, or a scan project.

2. Select the documentation tool  from the toolbar, then click the point of 
interest the view.

3. The new annotation and its Documentation Properties dialog are
displayed.

Figure 10-1 Documentation object in 3D View
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Documentation 
Properties

Detailed information can be entered in the Documentation Properties dialog: 

Figure 10-2 Documentation Properties Dialog

Position – determines the position of the documentation object in the 
workspace.

Description – detailed information about the documentation object.

Hyperlinks – hyperlinks to files or web sites. 

• Add a new hyperlink by entering its address into the lower text field, then
press Add.

• Change the order of the hyperlinks with Up / Down.

• Delete them with Remove.

• Open them by double-clicking on the list item or by selecting the Open
button.
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General tab You can enter the name of the documentation object in the General tab. Since 
a documentation object usually consists of a text string, its Layer should be 
defined as Text.

Figure 10-3 General dialog

10.9 Measuring (3D View, Quick View, Planar View)
With renovations, you are often confronted with the question of whether there 
is still enough space in the building for the intended machinery. Since you can 
only rely on the CAD model of the building to a certain extent, you will probably 
have to examine and take measurements of the critical places on site. Using 
scanned reality, you can easily address queries at your computer, such as: 
What is the clearance height of this gate? How great is the distance between 
these supports?

There are two different approaches for measuring distances:

• between scan points,

• between objects such as spheres or planes.
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10.9.1 Measure Points

Figure 10-2 Point-to-point measurement

Select measure 
points

1. Click the Measure Points button  in the tool bar.

2. Select valid scan points in the respective view with the left mouse button.

3. Select the last measure point and finalize the measurement by a double-
click with the left mouse button.

4. To leave the measurement process, click the right mouse button or press
the Esc key.

Several keyboard commands are available in the Quick View and the 3D View:

• Return key: Finalize the measurement without adding a last measure
point.

• Backspace key: Remove the last measure point.

• Home key: Add a last measure point at the start position and finalize the
measurement.

A new point-to-point measurement gets added as a child to the current scan 
when measuring in the Planar View or Quick View and to the Measurements 
folder of the workspace when measuring in the 3D View.

A point-to-point measurement made in the 3D View is only visible in the 3D 
View. It is not linked to any individual scan. If the involved scans are later 
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altered or transformed, the measurement stays in the same place. In this case 
you could delete the measurement and create a new one.

In the Quick View and the 3D View, a yellow dashed line is drawn between the 
measure points. Labels show the overall distance and the length of each 
measure segment. In the Planar View, only the overall distance is shown.

Invalid measure points of point-to-point measurements are indicated by a red 
outline. While it is not possible to select invalid scan points as measure points 
in SCENE, this may happen in SCENE WebShare Cloud when the sky or an 
area with heavily filtered scan points is selected. Therefore, invalid measure 
points may exist in workspaces downloaded from SCENE WebShare Cloud. 
An invalid measure segment is indicated by a red dashed line.

Two additional lines show the vertical and horizontal distance between the first 
and last measure point.

10.9.3 Measure Objects

Probably you frequently have to measure distances to level surfaces, for 
example to the wall, the floor or the ceiling. In this case you should fit a plane 
through the wall and measure from the plane to the point you are interested in. 
When using a plane, the measurement is automatically taken perpendicular to 
this plane.

Figure 10-4 Object measurement

You can measure between objects of the following types:

Point objects • Sphere (A sphere is a point object because its central point is used for
measurement),

NOTE: Point-to-point measurements may be susceptible to single 
noisy scan points.

NOTE: Object measurements are also available in the Structure 
View.
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• Checkerboard,

• Point Object, Corner Point,

• Scan. This means, the scanner icon which stands for a scanner position.

Figural objects • Plane, including Expanded Plane, Rectangle, Slab.

• Pipe.

Figure 10-5 Checkerboard point – plane measurement

1. Click the Measure Objects button  in the toolbar to start a measurement 
between objects.

2. To select objects for your measurement, select them with the left mouse
button. You can also select objects in the Structure View this way.

3. It may happen that objects superpose. In this case, a small dialog opens
which lists these objects. Double-click the one you want to use, and
continue measuring.

4. You can measure the distance between more than two objects if you hold
down the Shift key when clicking on the next object. However, an object
measurement can only contain one figural object.

A new object measurement gets added to the Measurements folder of the 
workspace.

If the position or location of the objects used for the measurement change, for 
example, by a new fit or by updating the registration, the measurement is 
automatically updated.
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Measure Object The representation of a measurement is called a measure object. To open the 
Properties dialog of a measure object, double-click it the Structure View, on its 
label or near a measure line.

Figure 10-6 Properties of measurement object

The property dialog provides distance information and a list of the involved 
objects of an object measurement. 

You can hide the lines for the vertical and horizontal distances and the label for 
the overall distance by selecting the Show Distance checkboxes.

10.10 Selecting Scan Points (3D View, Planar View, Quick View)
Depending on the view, it is possible to select scan points and then apply 
commands to this group of points. 

10.10.1 Selecting Scan Points in the Planar View or the Quick View

In the Planar View and in the Quick View, it is possible to select scan points 
and then apply a variety of commands to this group of points. For example, 
you may apply an object fit on this group, or search for objects in the selected 
points and apply automatic object fits.

• apply filters on the selected scan points,

• apply a white-balance,

• colorize them using scanner based pictures,

• delete them,

• export them into a CAD system,

• or create a new scan from the selected scan points.
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Selected scan points are colored yellow. There can only be one selection 
simultaneously in all views, in other words, if you make a selection in one view, 
the selection disappears from the view worked on before.

Available selection 
tools Quick View 
and Planar View

Select Polygon button 

Click the down arrow, next to the Select Polygon button in the Explore toolbar 
to get a drop down list with all the Selection tool options for Scan Points.

1. Click the left mouse button to define the starting point of the selection.

2. Release the mouse button, move the mouse to the next point and click to
fix the point. A straight connection is drawn automatically between these
two points.
Or:
You can also hold the mouse button down – then all the scan points that
you move over with the mouse are selected.

3. Lock the selection by double-clicking with the left mouse button.

When completing the selection, the line will be closed; in other words, the last 
fixed point is connected to the starting point. The selection comprises all the 
scan points that are enclosed within the outline.

Select Rectangle button 

1. Select a rectangular area by first defining a corner of the rectangle by click
the left mouse button and hold it down to define the first corner of the
rectangle.

2. Drag the mouse to define the opposite corner of the rectangle. You can
then release the mouse button.

Select Circle button 

1. Click the left mouse button to define the starting point of the selection. A
circle with the radius just set is displayed.

2. Change the radius by turning the scroll wheel on the mouse.

3. Click with the left mouse button again to place the selection in the chosen
location and to end the selection process.

NOTE: If you wish to select an area that you cannot see with the 
set line of sight, you can also switch into navigation mode during 
the selection process. Simply press the control (Ctrl) key.
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Select Ellipse button 

1. Click the left mouse button to define the starting point of the selection. An
ellipse with the starting point of the major axis just set is displayed.

2. Change length of the minor axis (i.e., the “width”) by turning the scroll wheel
on the mouse.

3. Click with the left mouse button again to place the selection in the chosen
location and to end the selection process.

Select Line button 

A linear selection has a thickness of one point.

1. Click the left mouse button to define the starting point of the line.

2. Release the mouse button, move the mouse to the next point of the line
and click to fix the point. A straight connection is drawn automatically
between these two points.
Or:
You can also hold the mouse button down – then all the scan points that
you move over with the mouse are selected.

3. Lock the selection by double-clicking with the left mouse button.

Planar View only: Select Poly edge button 

Select an arbitrarily shaped area of scan points, with the polygon following the 
visible edge in the scan points. 

1. Click the left mouse button to define the starting point of the selection.

2. Release the mouse button and move the mouse to the next point. If you
reach an edge, i.e., an area in which there is a noticeable difference in the
reflection value, the selection will automatically follow this edge. If there is
no such edge, a straight connection is drawn.

3. Click to fix the point.

4. If you are not confident with the polygon, you can undo the last part of the
polygon by backtracking it in the opposite direction. You can always
backtrack to the last fixed point.

5. With a click of the right mouse button, you switch edge detection on or off,
and you can cancel the selection.

10.10.2 Selecting Scan Points in 3D View

Compared to the Quick View and the Planar View, you may 

• delete a scan point selection,

• invert a scan point selection,
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• export them into a CAD system (only available for 3D selections made on
the basis of points from scan point clouds and the project point cloud,

• create objects,

• or create an object fit.

Available selection 
tools in 3D View

Select Polygon button 

The polygon selection applies to point clouds.

1. Click the left mouse button to define the starting point of the selection.

2. Release the mouse button, move the mouse to the next point and click to
fix the point. A straight connection is drawn automatically between these
two points.
Or:
You can also hold the mouse button down – then all the scan points that
you move over with the mouse are selected.

3. Lock the selection by double-clicking with the left mouse button.

When completing the selection, the line will be closed; in other words, the last 
fixed point is connected to the starting point. The selection comprises all the 
scan points that are enclosed within the outline.

Select Brush button 

The brush selection can be used similar to brush tools known from 2D image 
processing programs. It works with scan – or project point clouds only. 

The brush works in three dimensional spaces, meaning that you can use the 
mouse to literally paint points which are going to be selected. 

The brush has the shape of a sphere. A transparent red circle will highlight the 
area where the selection sphere is currently located. 

1. Click the left mouse button to define the starting point of the selection, hold
the button down in order to paint the points.

2. Moving the cursor around while having the brush selector tool activated will
highlight the scan points that are currently within the selection sphere.

3. Use the mouse wheel to modify the radius of the sphere.

4. Hold the shift key to modify the sphere radius more quickly.

10.10.3 Invert a selection of scan points

There may be applications in which the marking of scan points is difficult or 
time-consuming, and it would be much easier if you could mark those scan 
points you do NOT need.

1. Open a 3D view on a point cloud.

2. Click the Select Polygon  or the Select Brush  selection tool.
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3. Create a selection in the 3D View.

Figure 10-4 Scan points of a house, marked with the Polygon selection

4. Right-click the selection, then click Selection > invert Selection.

Your selection will be cleared and all other scan points will be selected.

Figure 10-5 Scan after using the invert function
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10.11 Selection Combinations
There are different types of selection combinations which determine what 
effect the next selection to be executed has on the selection that already 
exists. 

1. If there is no selection: select scan points with one of the scan point
selection tools.

2. Select the required combination type from the toolbar:

• New selection button  – The next selection replaces the existing
selection.

• Add selection button  – Combination mode whereby the next selection
is added to the existing selection.

• Subtract selection button  – Combination mode, whereby the next
selection is removed from the existing selection.

• Intersect selection button  – Combination mode whereby the
difference of the two selections is retained.

10.12 Save Screenshot (3D View)
You can save the view currently being displayed, for example, to share the 
view, or to use it as a preview for your scan project.

1. Open a 3D View of a scan.

2. Move the 3D View until it shows the view you want to see in the screenshot.

3. Click the Save Screenshot button in the toolbar.

An information box opens, saying: “The screenshot will be saved in the
structure view in the folder named Screenshots”. (The name will be
different if you renamed the folder. If the screenshots folder doesn't exist, it
will be created.)

The screenshot's name is generated automatically as, Screenshot.
subsequent screenshots have a number appended. When the screenshot
is created, a child object called a Viewpoint is also created.  For more
information, see Viewpoints (3D View) on page 143.

The screenshot image will show exactly what you have seen in the 3D View, 
including annotations or measurements, scan point selections, etc.

If you want to export the screenshot to a file, right-click the screenshot and 
select Import/Export > Export Picture.
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10.12.1 Viewpoints (3D View)

Save the current camera position and line of sight as a viewpoint, so that you 
can return to it later. In the drop-down menu of the Viewpoints button, you can 
activate the previous or next viewpoint.

Create Viewpoint 1. Move the camera to a position that you would like to keep for later use.

2. Click the Viewpoints button . The drop-down menu opens.

3. Click Create. A little dialog opens in which you can enter a name for that
viewpoint.

4. Click OK to save the viewpoint.

Viewpoints are added to a folder called Viewpoints in the Structure View. 
Viewpoints are part of the Workspace and will be saved when saving the 
Workspace or scan project.

In the Structure View, you can organize the viewpoints into folders. Create 
new folders, and drag and drop the Viewpoints into them.

Figure 10-2 Viewpoints in the Structure View

Go to a viewpoint  In the Structure View, right-click the Viewpoint, then select Activate in its
context menu.

Activate viewpoints 1. Click into the 3D View.

2. Click the Viewpoints button . The drop-down menu opens.

NOTE: You can also create a viewpoint with the short keys 
Ctrl + F2. 
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3. Click either Activate Previous, or Activate Next. The view will move to that
position.

10.13 Mark Distance Range (Planar View)
The scan points in the Planar View are normally displayed so that the 
reflection value of a scan point determines the brightness of the pixel. You can 
also display the scan points so that the pixel assumes a different color 
depending on the distance of the scan point from the scanner. You can also 
then choose to either have all scan points in a range assume the same color 
or have the color reflect the actual distance.

This type of visualization is appropriate, for example, when analyzing a scan, if 
it must not fall below a certain level of precision. Generally, the quality of a 
scanner's distance measurement is not constant across the entire range but 
decreases as the distance increases. You can then highlight in color the range 
in which the distance measurement is no longer satisfactory.

You can switch the highlighting on or off using the Mark Range on/off button 
in the toolbar. 

The colors are displayed corresponding to your entries:

• Scan points that lie close to the lower limit is colored red.

• Scan points that lie in between are colored yellow to green.

• Scan points that lie close to the upper limit is colored blue.

NOTE: All viewpoints can also be successively activated in the 
order of their creation by using the hotkey F2 or in reverse order by 
using Shift+F2.
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• Scan points lying outside this range are not colored.

Figure 10-1 Scan points colored depending on distance

10.14 Clipping Boxes (3D View)
Clipping boxes provide an easy access to areas of interest of a 3D point cloud. 
They allow slicing the point cloud and clipping away specific areas which 
enables you to display or hide certain points of the 3D point cloud.

There are two types of Clipping Boxes:

• Clipping boxes with the points outside of the box hidden. Only the points
inside the box are displayed.

• Clipping boxes with the points outside the box displayed, points inside the
box are hidden.
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Clipping boxes may also be used to select scan points in the 3D View in order 
to perform certain operations on these points.

NOTE: Clipping boxes can be applied to the points of point clouds, 
not to the points of scans. In such a case, create point clouds by 
executing the Process feature.

If your scan project contains more than one scan, register those 
scans first, then use the Clipping Boxes for the entire scan project.
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Figure 10-1 3D View without (upper picture) and with Clipping Box (lower 
picture)

10.14.2 Creating a Clipping Box

Open a 3D View and navigate to the area of interest.

There are various ways to create a Clipping Box:

Click Auto Clipping Box to get the following options: 

Auto Clipping Box Click the Auto Clipping Box button  in the toolbar. Click this option to open 
the Clipping box toolbar. For details on how to use the toolbar, refer to the 
section Manipulating a Clipping Box.

A Clipping Box will be created close to the center of the current 3D View. The 
created Clipping Box will be scaled so that it covers roughly two thirds of the 
screen.

One Click Clipping 
Box

1. Select this option from the drop down menu of the Auto Clipping Box button

. 

2. Select a point in the view in order to determine the surface. The Clipping
Box will then be created with one of its faces being coplanar to the defined
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surface, and with the selected point in the center. The created Clipping Box 
will be scaled so that it covers roughly two thirds of the screen.

Three Clicks 
Clipping Box

1. Select this option from the drop down menu of the Auto Clipping Box button

 in the toolbar. 

2. Select three points in the view in order to determine the surface. The
Clipping Box will then be created with one of its faces being coplanar to the
surface defined by the three picked points. The Clipping Box will be scaled
in such a way as it exactly encloses the picked points.

Aligned to a limited 
or unlimited plane 
object

• Select New > Aligned Clipping Box in the context menu of a plane object to
align a Clipping Box to the object:

• Unlimited plane: The new Clipping Box will be created as a unit cube
centered on the reference point of the plane. Its faces will be parallel to
the selected plane.

• Limited plane: The new Clipping Box will tightly enclose the boundary
polygon of the limited plane.

The created Clipping Boxes are saved to the workspace for later use and will 
be added to a folder ClippingBoxes in the Structure View. Those folders are 
added as follows:

• New Clipping Boxes are local, which means, they will be placed below the
object the 3D View is opened on.

• If the overall project 3D View gets opened, created Clipping Boxes will be
global.

• In scan projects imported from earlier SCENE versions, Clipping Boxes will
stay global.

Operations started from a 3D View which operates with Clipping Boxes will 
use only the Clipping Boxes visible in that 3D View.

After created, you can reposition and resize the Clipping Box.

10.14.3 Visualizing Scales and Distances

SCENE allows to visualize dimensions and distances in the 3D View by 
displaying a customizable two dimensional grid. 

This tool is only available in the 3D View.

The grid is a set of visible lines that serve as a visual distance reference and 
can be seen as a two dimensional ruler. The grid can be positioned anywhere 

NOTE: 

• Once created, the rotation point of the view will be set to the
center of the Clipping Box.

• Creating Clipping Boxes does not delete any points from the
point cloud. The points outside or within the Clipping Box are
simply hidden and may be displayed again at any time.
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in the SCENE and gives a good impression of distances and scales in the 
point cloud. 

Figure 10-4 Regular grid in 3D View

Figure 10-5 Polar grid in 3D View
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Displaying and 
customizing the grid

1. Click the Grid button  in the Explore toolbar to activate the grid
function. By default, the grid is located in the coordinate origin and lies in
the XY plane.

2. Customize the grid. Use the drop down menu of the grid button in the 3D
toolbar to make your adjustments.

Figure 10-6 Drop down menu of the grid

Grid Properties Open the Grid Properties dialog from the Show Grid drop-down menu. The 
dialog has different options to set the grid properties.

The grid can be displayed in two different styles:

• The regular grid divides the space in axially parallel and evenly spaced
rectangular areas. Both scales in X and Y direction show the distance in
relation to the grid’s origin.(Figure 10-5)
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• The polar grid consists of concentric rings and radial dividers. The
concentric rings show the distance to the grid’s origin. With the radial
dividers one can estimate the angles between two points of interest.

Figure 10-7 Grid properties

Style – choose between the regular and the polar grid.

Define the dimensions of the displayed grid in both directions by entering a 
start and an end value. Define the resolution of the grid by changing the 
distance between the displayed grid lines for both directions.

Colors – Change the color of the lines for the two directions.

Increase Resolution Increase the resolution of the grid by decreasing the distance between the 
displayed lines by a factor of 2.
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Decrease 
Resolution

Decrease the resolution of the grid by increasing the distance of the displayed 
lines by a factor of 2.

Attach to Scan Point Change the position of the grid’s origin. Pick a point in the SCENE and the 
grid’s origin will be moved to that point.

Activates a tool to align the grid to a surface. 

Attach with One 
Click

Align the grid by picking one click, if the plane has an even surface.

Attach with Three 
Clicks

Align the grid by picking three points, if the plane is uneven, or if you need a 
high accuracy. Picking three points for planes makes sense for outdoor scans, 
or for a scans of an old building in which floors or ceilings often are more or 
less curved.

Display Options

Figure 10-8 Grid properties – Display Options

On tab Display Options you may toggle the visibility of certain visible grid 
elements:

Direction X – x-axis (colored line)

Direction Y – y-axis (colored line)

Labels X – labeling of lines parallel to the x-axis

Labels Y – labeling of lines parallel to the y-axis

Primary Scale X – labeled lines of the grid in x direction

Primary Scale Y – labeled lines of the grid in y direction

Secondary Scale X – non-labeled lines visible at certain zoom levels in x 
direction

Secondary Scale Y – non-labeled lines visible at certain zoom levels in y 
direction.
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10.14.9 Manipulating a Clipping Box

Clipping Box 
Toolbar

You can change the transformation of a Clipping Box by rotating, moving, or 
changing its size. 

For this, click the Clipping Box in the 3D View, or click its name in the 
Structure View. A floating tool bar will appear which provides the 
manipulation functionality.

Figure 10-10 Clipping Box toolbar

Scale button 

Figure 10-11 Resizing a Clipping Box

1. Select the Scale button  from the Clipping Box toolbar to resize the
Clipping Box. Handles will appear on the Clipping Box allowing you to
resize it.

2. Drag one of the red, blue or green handlers to resize the Clipping Box. The
corresponding face of the box will move.

3. Drag the gray cubes at the corners to resize the Clipping Box
proportionally.
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When dragging one of the handlers, the length of the movement will be 
indicated in the view as shown in the picture below.

Figure 10-12 Length of movement

Rotate button 

Figure 10-13 Rotating a Clipping Box

1. Select the Rotate button  from the Clipping Box toolbar to rotate the 
Clipping Box. Handles will appear on the Clipping Box allowing you to 
rotate it around different axes.

2. Drag one of the red, blue or green handlers and rotate the Clipping Box
along the corresponding axis.
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Move button 

Figure 10-14 Moving a Clipping Box

1. Select the Move button  from the Clipping Box toolbar to move the
Clipping Box. Handles will appear on the Clipping Box allowing you to
change the position of the box.

2. Drag one of the handlers (white arrows) and move the Clipping Box within
two dimensions. The dimensions depend on the used handler. You may
also use the keys 2, 4, 6 or 8 on the number pad instead.

NOTE: Change the size of the handlers with the num pad “+” key 
(increase size) and “-” key (decrease size).

You may undo (and reapply) your transformation changes with the 
following buttons of the Clipping Box toolbar:

Undo the last transformation change with .

Redo the last transformation change with .

Restore the initial transformation of the Clipping Box with .
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10.14.15 Hiding and Displaying Points by Means of Clipping Boxes

Hide button 

You may select which points are displayed or not with the Hide button  of 
the Clipping Box toolbar. 

Hide exterior: Hide the points outsides the selected Clipping Box (this is the 
default setting).

Hide interior: Hide the points insides the selected Clipping Box. 
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This does not have an effect on the visible objects in the3D View.

Figure 10-16 Exterior hidden (upper picture) and interior hidden (lower picture)

Depending on this setting the boundaries of the Clipping Box as well as the 
icon in the Structure View will be displayed in different colors: 

• transparent blue when the exterior is hidden.

• transparent orange when the interior is hidden,
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This setting will be saved in the Clipping Box properties for later use and may 
also be changed in the properties dialog.

10.14.17 Deleting Points by Means of Clipping Boxes

You may delete points of all active Clipping Boxes.

1. Execute Hide exterior or Hide interior to the Clipping Boxes.

2. Right-click an active Clipping Box, then select

• Delete visible points of all active clipping boxes: All visible points of all
active Clipping Boxes will be deleted, no matter if they are insides or
outsides the Clipping Boxes.

• Delete invisible points of all active clipping boxes: All invisible points of
all active Clipping Boxes will be deleted, no matter if they are insides or
outsides the Clipping Boxes.

10.14.18 Enabling / Disabling Clipping

Enable/Disable clipping button 

You may enable or disable clipping of the selected Clipping Box with the 
Enable/Disable clipping button of the Clipping Box toolbar. When disabled, the 
points hidden by this box will be displayed again; the color of the Clipping Box 
boundaries and its icon in the Structure View change to gray.

Figure 10-19 Disabled Clipping Box
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This setting will be saved in the Clipping Box properties for later use and may 
also be changed in the properties dialog.

Toggle application of Clipping Boxes button 

You may also enable or disable clipping of all available Clipping Boxes globally 

with the Toggle application of Clipping Boxes button  of the 3D View toolbar. 
This setting will not be saved in the properties of the individual Clipping Boxes.

10.14.20 Working with Multiple Clipping Boxes

You can combine the point visibility settings of several Clipping Boxes. For 
this, the following rules apply:

• Adding a Clipping Box with hide exterior enabled to already available and
active Clipping Boxes:

• The points inside this box will always be added to the currently visible
points, even if this box intersects with boxes that have the interior
hidden.

• The points outside this box will not be hidden. In that case the clipping
settings of the already available Clipping Boxes have the precedence.

• Adding a Clipping Box with hide interior enabled to already available
Clipping Boxes:

• This will cut out the points that are inside of this box from the points that
are visible at that time, even if this box intersects with boxes that have
their exterior hidden (and the interior displayed).

• The points outside this box will not be displayed. In that case the clipping
settings of the already available Clipping Boxes have the precedence.

The order of creation of the Clipping Boxes thus matters and has an effect on 
which points are displayed or not.
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Example: We want to show the motor of the car. For this, we use a scan in 
which the hood is opened:

Figure 10-21 Example: Complete point cloud
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Now you add the first Clipping Box around the car that has its exterior hidden 
(Clipping Box 1).

Figure 10-22 Example: First Clipping Box with hide exterior added

All the points outside the Clipping Box are now hidden, only its interior is 
displayed. Now you would like to remove the hood because it would disturb 
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the view. So you add a new Clipping Box with hide interior enabled (Clipping 
Box 2).

Figure 10-23 Example: Second Clipping Box with hide exterior added

The points within Clipping Box 2 are now hidden. But now you would like to 
hide the points of the two front fenders. So you add two new Clipping Boxes 
but this time with hide interior enabled (Clipping Boxes 3 and 4).

Figure 10-24 Example: Clipping box 3 with hide interior added
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The points in the overlapping areas between Clipping Boxes 1 and Clipping 
Boxes 3 and 4 are now removed from the scene.

Figure 10-25 Example: Result with hidden Clipping Boxes

If you would like to have one or more of the available Clipping Boxes not being 
regarded in the current scene, you may disable them or delete them from the 
workspace.

10.14.26 Toggling Visibility of Clipping Boxes

Clipping box 
visibility button 

Toggle the visibility of a Clipping Box

• With the Clipping box visibility button  in the Clipping Box toolbar,

• in its context menu,

• or in its properties dialog.

Disabling the visibility of a Clipping Box will only hide its boundaries; the 
Clipping Box is still active (if clipping is enabled) and it still has effect on the 
visibility of the points in the 3D View.

10.14.27 Creating Multiple Clipping Boxes Along an Axis of an Existing Clipping Box

You can create multiple Clipping Boxes along one of the three axes of an 
already available Clipping Box which also serves as a template for the new 
Clipping Boxes. This allows slicing the point cloud into specific areas of 
interest and can be a useful feature, for example to divide a building into its 
several floors.
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Do the following to create multiple Clipping Boxes along an axis of an already 
available Clipping Box:

1. Open the 3D View.

2. Navigate to the Clipping Box which should serve as the template.

3. Check if this Clipping Box has the clipping mode Hide Exterior. If not,

select Hide Exterior  .

Figure 10-28 Clipping boxes along an axis – Hide Exterior
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4. Right-click this Clipping Box, then click Create Clipping Boxes Along an
Axis. Two new Clipping Boxes will be displayed according to the default
settings.

Figure 10-29 Clipping boxes along an axis – Preview

5. Make your settings in the appearing dialog. In our example, we would like
to have each one Clipping Box for the front part, for the middle part, and for
the rear part of the car.

Figure 10-30 Clipping boxes along an axis – Settings dialog

Axis
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Select the axis of the existing Clipping Box along which the new Clipping 
Boxes will be generated. A preview of the new Clipping Boxes will be 
available in the current 3D View.

Disable Clipping

Disable clipping in the preview.

Sign of Axis

Select the direction of the axis in which the Clipping Boxes will be created.

Settings

Number of Clipping Boxes along axis

Define the number of Clipping Boxes to be created.

Space between boxes / Space between box origins

The distance between the Clipping Boxes. There are two ways to define 
the distance, either between the origins of the Clipping Boxes or between 
the adjacent faces of the Clipping Boxes.

6. Click OK to create the Clipping Boxes with the selected settings.

Figure 10-31 Clipping boxes along an axis – preview

The initial Clipping Box will be moved to the new Clipping Box folder and 
will be renamed according to the folder’s name. The other Clipping Boxes 
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will get the name of the folder and an enumeration. The Clipping Boxes will 
be surrounded by the so-called Clipping Box container.

Figure 10-32 Clipping boxes along an axis, with Clipping Box container

Working with 
Clipping Box 
Containers

A Clipping Box container contains all the Clipping Boxes which were created 
along an axis of an existing Clipping Box. It has a transformation which 
consists of scale, rotation and translation. 

You can rotate, move, or resize a Clipping Box container similar to a Clipping 
Box.

Figure 10-33 Clipping box container with resize handlers

These transformation changes will be proportionally applied to the Clipping 
Boxes within the container.

If required, you can change the size of the Clipping Boxes inside the Clipping 
Box container. It is no longer possible to rotate one of the Clipping Boxes, nor 
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is it possible to move one of the Clipping Boxes to the outside of the Clipping 
Box container.

Figure 10-34 Resizing the Clipping Boxes inside the Clipping box container

10.14.35  Exporting Scan Points by Means of Clipping Boxes

You may also export 3D points into different file formats using the active 
Clipping Boxes. 

1. Right-click the 3D View, or,

2. Right-click a Clipping Box, then, click Export 3D selection using active
Clipping Boxes.

NOTE: All Clipping Boxes within a Clipping Box container have 
constrained functionality:

• The single Clipping Boxes cannot be rotated individually.

• Their clipping mode cannot be changed.

• The single Clipping Boxes cannot leave the volume of the
Clipping Box container.

• Change the visibility of the Clipping Box container and the
Clipping Boxes in the container with the Clipping box visibility

button  in the Clipping Box toolbar or in its context menu.

• Any transformation of the Clipping Box container will transform
the single Clipping Boxes.

• The visibility state of the Clipping Box container is a global state
and not view specific. This state will be saved with the
workspace.
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SCENE will then create a 3D selection and export the selected points 
afterwards.

Additionally, you may export the points in a local coordinate system defined by 
one of the available Clipping Boxes. For this, select Use Local Coordinates in 
the export dialog and select the Clipping Box from the available list.

10.15 Meshing (Planar View and 3D View)

This section describes how to use the meshing feature in SCENE.

10.15.1 What is a Mesh?

When an object is scanned, the scan points represent individual spots on the 
surface of the object. If you want to reconstruct the surface itself, you can 
create a mesh which takes the scan points as a basis and approximates the 
surfaces within certain limits.

From scan points to 
triangles

The approximation of the scanned surfaces is done with a set of triangles.

Depending on the curvature of the real surface and the required 
approximation quality, the number of triangles can vary between a few and a 
huge number.

Making Your Mesh 
Water-Tight

To print a 3D model with a 3D printer, the 3D model must not have any gaps. 
The 3D model must have a solid volume, it must have a solid surface without 
gaps. A commonly used term for this is „water-tight“.

10.15.2 Creating a Mesh in Planar View

1. Create a 2d selection as described in Selecting Scan Points in the Planar View
or the Quick View.

2. Right-click the selection, then click Create Objects – Mesh. The Mesh
Generation Parameters dialog is shown.

NOTE: Only the points of point clouds will be exported.

The Export menu shows the Color/gray option as well as the Full 
scan option grayed out, because they don't make sense for a point 
cloud.

NOTE: 3D Meshing is only available for point clouds. For 
information about creating point clouds See Processing on 
page 93.

NOTE: Creating a Mesh in Planar View option is only available 
with the SCENE Classic View.
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To create a mesh in Planar View, select the Mesh Generation Parameters in 
the following dialog:

Figure 10-3 Mesh generation parameters

2nd level simplification – Activate 2nd level simplification based on the 
distance between scan point and nearest triangle.

Distance threshold – A triangle approximates all scan points within this 
distance threshold. The smaller the value, the more triangles you’ll get.

Activate triangle removal – If an object is in front of a different object, 
neighboring scan points shouldn’t be connected by triangles. Here you can 
activate the removal of triangles which match both following requirements.

Angle below – The angle between the scanner and the surface of the 
triangle. The larger the value, the more triangles will be removed.

Edge length above – The edge length of the triangle. The smaller the 
value, the more triangles will be removed.

Although the resulting mesh may be a relatively small collection of triangles, 
its appearance can show more details. This is done by a texture, which is 
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similar to a photo glued onto the triangles. By default the display is with 
textures.

Figure 10-4 Mesh with and without texture

10.15.5 Creating a Mesh in the 3D View

Figure 10-6 Meshing Object

There are two methods to create a mesh:

• Mesh Selection: You can make a freehand selection of scan points.

• Mesh Clipping Boxes: you can use one or more clipping boxes to select what
you want to be meshed.

Meshing a Selection 1. Create a 3D selection as described in Selecting Scan Points (3D View, Planar
View, Quick View)
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2. Click the little arrow in the Mesh button to open the drop-down menu, there
click Mesh Selection. The Create Mesh – Settings dialog is shown. You can
also right-click the selection, then click Selection – Mesh Selection

Mesh Clipping Boxes

Figure 10-7 Object selected with a Clipping Box

1. Create and adapt one or more Clipping Boxes around the object as
specified in Creating a Clipping Box.

2. Click the little arrow next to the Mesh button  to open the drop-down
menu, there click Mesh Clipping Boxes. The Create Mesh Settings dialog is
shown. You can also right-click the clipping box, then click Create Mesh
using Active Clipping Boxes.
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Settings

Figure 10-8 Create Mesh Settings

Mesh Name Specify a name for the mesh.

Meshing Mode Watertight (3D Print Ready)

Select this option if the mesh will be used for 3D printing. The mesh will then 
be generated „watertight“, which means, it has a solid surface.

Non-Watertight Mode

Select this option if the mesh will not be used for 3D printing. 

Slider – Meshing Mode

The slider in the Meshing Mode box, allows control to make the meshing close 
more or less holes and expands the mesh more or less beyond the points. 
This option is available when Non-Watertight mode is selected.

Smoothing Perform Smoothing

Select this check box to apply a post processing operation to make the mesh 
smoother.

Slider – Smoothing
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The slider in the Smoothing box allows control to make the mesh smoother.

The higher the slider value, the mesh will be smoother.

Maximum Number 
of Triangles

Slider – Maximum Number of Triangles

The slider under this category allows control, how many triangles will be 
created in the mesh, if non-watertight mode is active.

If you know the maximum number of triangles which your software or your 3D 
printer is able to process, enter this number. Else, use the predefined value. 

Detail Reduction 
Behavior

Optimize Geometry Only

If you require optimal geometric precision in the mesh image, select Optimize 
Geometry Only. 

Optimize Geometry and Colors

If you require optimal color detail in the mesh image, but reduced geometric 
precision, select Optimize Geometry and Colors.

Create Click the Create button to start the mesh creation. The created mesh will be 
added to the structure view and displayed in the opened 3D view. It is also 
possible to open a 3D view on the mesh, through the context menu.

Mesh Properties You can review the mesh properties by right-clicking on the name of the mesh 
in the structure window and selecting properties. The surface area of the mesh 
is calculated by taking the sum of the surface area of all the triangles in the 
mesh.

Figure 10-9 Mesh Properties Dialog
174
Chapter 10: Explore



SCENE 2018 User Manual
10.15.10 Export

1. Right-click the mesh, then click Export. The Export dialog is shown.

2. Select the file format in which you want the meshed object to be exported.
Available file formats are: .stl, .ply, .obj, and .wrl.

3. Click OK to start the export.

10.16 Virtual Scans (3D View)

For technical reasons, Freestyle3D scans can not be displayed as a Panorama 
View in SCENE WebShare Cloud. They have to be converted to so-called 
Virtual Scans first and can then be uploaded.

Virtual scans are created from the point cloud data of already existing scans. 
After the virtual scans were created, they behave like scans which were 
recorded with a laser scanner. 

You can open a Virtual Scan in

• Quick View,

• Planar View, and

• 3D View.

You can export a Virtual Scan as

• an image,

• as an object,

• as scan points, and

• as a new scan project.

Figure 10-1 3D View of a scan
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4. Click the Create Virtual Scan button  in the toolbar. The Create Virtual
Scan dialog is shown:

Figure 1: Create Virtual Scan dialog

Name

Enter a name for the virtual scan.

Resolution

Set the resolution with the slider. The first number corresponds to the 
number of columns, the second number for the number of rows.

Point interpolation

Select, if the virtual scan shall include interpolated points.

5. Click the OK button to start the creation of the virtual scans. A folder named
VirtualScans will be created which contains the virtual scans.

Figure 10-2 Quick View of the VirtualScans folder
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Export the virtual 
scans

After you are done with creating all the virtual scans, you can continue with the 
usual Export to SCENE WebShare Cloud functions.

10.17 Working with the Project Point Cloud
Like the scan point clouds, the project point cloud is optimized for fast 
visualization of large amounts of scan points in the 3D View, and is organized 
in a spatial data structure that facilitates fast visualization of the scan points. 
The project point cloud consists of the points in of all the scans within your 
scan project and can thus be seen as a comprehensive point cloud of the 
complete scan project. For this reason, the amount of points in a project point 
cloud can be enormous. Unlike scan files, such large amounts of points 
cannot be loaded into physical memory at once. Therefore, the points of the 
project point cloud are automatically loaded and visualized on demand based 
on the camera position and point visibility. The automated point loading of the 
project point cloud is able to visualize hundreds of scans at once. This 
empowers you to actually see all scans of a scan project at once, regardless 
of whether they fit into your computer’s physical memory or not. Manual scan 
file loading is not necessary. 

The project point cloud is the best way to visualize and manipulate enormous 
amounts of scan data interactively. It is accessible from all local workspaces of 
a scan project. There can only be one project point cloud for each scan 
project.

If your project has a project point cloud: 

1. Open a 3D View with the View Project button  from the toolbar, or 

use View > 3D from the context menu of the workspace. 

2. Start exploring.

As the point cloud visualization technique is constantly loading scan points 
from the hard disk drive based on point visibility, the overall performance 
strongly depends on the speed of your hard disk drive. While project point 
clouds outperform all other visualization methods (including scan point clouds) 
on regular hard disk drives, we recommend using a solid state drive for 
maximum performance. Using a solid state drive will also speed up the 
process of creating the project point cloud.

The benefits of the project point cloud are:

• No manual loading of scans required

• Very fast visualization of large amounts of scans at once

• One optimized single spatial data structure for all scan points in a project

• Out-of-Core visualization

• Can be accessed from all local workspaces associated with the project.
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10.17.1 Creating the Project Point Cloud

The project point cloud is typically created from all the single scans in your 
project after they have been processed and registered. 

1. Open the scan project from the Project Overview, or by clicking the Open

Project button  in the Project toolbar.

2. Click the Explore button  in the Workflow Bar. 

3. Click the Project Point Cloud button  in the toolbar. A drop-down menu
opens.

4. Select Create .

Preparing your Scan 
Project

The resulting point cloud is about two to four times the size of your scan files. 
SCENE will create large amounts of temporary data during point cloud 
creation, which will be deleted after the point cloud was successfully built. The 
amount of space needed for the temporary data during the point cloud 
creation process can be up to seven times the size of the original scan data. 
The actual amount of temporary data and the size of the project point cloud 
strongly depend on the point data itself and cannot be safely predicted 
beforehand. Make sure to have enough free space on your target hard disk 
drive (the location of your scan project) and in the location of the temporary 
data folder when creating project point clouds. The temporary data folder can 
be changed in Settings > General.

Certainly, you may change your registration at any time, even if a project point 
cloud already exists, but be aware that the project point cloud will not have 
these changes applied until it is updated or recreated.

NOTE: The creation of the project point cloud is only available if 
you are directly working on the scan project. 

NOTE: Project point cloud creation will only consider the global 
position of the scan points at the time of the creation. All changes 
to scan, cluster, folder or workspace transformations that are 
performed after the project point cloud has been created will not 
alter the project point cloud. This will lead to an inconsistency 
between point cloud and the traditional scan-based data of the 
scan project. For this reason, we recommend creating the project 
point cloud once you consider your registration to be complete.
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Project Point Cloud 
Creation Settings 

After you have initiated the project point cloud creation, the point cloud 
settings dialog shows up:

Figure 10-2 Create project point cloud settings

Filter For the creation of the project point cloud, two point filters are available. Each 
of these filters will reduce the overall point count by eliminating different types 
of (unwanted) points.

Eliminate Duplicate Points

The filter removes duplicate points that always exist when points are recorded 
from several different scanner positions. Overlapping areas can be optimized 
by removing some of the duplicate points. This filter can improve the visual 
quality of your project point cloud significantly while reducing overall point 
count and therefore improving interactivity and loading times of the point 
cloud.

Points are considered duplicates of others when they were recorded from 
different scanner positions and their 3D positions are similar. The actual 
distance threshold for duplicate points depends on point to scanner distances. 
The farther away a point is from the position of the scanner during recording, 
the “larger” we consider this point to be because points great distances are 
spatially farther away from each other than points close to the scanner 
position.
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The filter is configured to always keep the highest quality point. Higher quality 
means smaller distance to the scanner position. If two points are considered 
duplicates of each other, the point with the greater distance – and therefore 
lower quality – is dismissed. Only the higher quality point is added to the 
project point cloud.

When creating a project point cloud from a project that contains both Laser 
Scanner scans and Freestyle scans, all points are considered. Usually, 
Freestyle points are used only where no Laser Scanner points are available.

With the Search Radius slider you can adjust the distance threshold for point 
elimination. The default setting should be sufficient for almost all scenarios.

Adjust the Search Radius slider to the right to enlarge the search radius and 
increase the number of eliminated points. This may help to reduce point count 
when your registration is not very accurate (for example when using natural 
targets only).

Adjust the Search Radius slider to the left to reduce the number of eliminated 
points. This can be useful if too many points have been deleted by this filter in 
previous point cloud iterations.

Close Surfaces

Select this checkbox if you want to have additional points interpolated 
between original scan points, in order to create a more dense impression of 
the surfaces. The color or gray value of these additional points will also be 
interpolated.

Full color detail

Select Full Color Detail if the color of the points shall be retrieved from the 
laser scanner's high resolution camera images. Moreover, additional even 
smaller points are interpolated to transfer the color information from the 
camera images into the point cloud. By using the images from the camera 
images, smearing effects are reduced and more color details are visible in the 
project point cloud. 

Homogenize Point Density 

This filter balances the density of points within the point cloud by reducing the 
number of points in areas where the average target density is exceeded. This 
is especially the case close to scanner positions, where the point density is 

NOTE: Scans captured using Freestyle are interpolated 
immediately after they are captured (if the appropriate option was 
enabled during capture). No additional interpolation is performed 
for these data sets during project point cloud creation. 
Nevertheless, you need to select this option to get a closed 
surface representation of your data. If you don’t, points of 
Freestyle scans are stored with smaller sizes.

NOTE: The time needed for the interpolation and the creation of 
the point cloud will greatly increase. The files will need much more 
disk space.
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particularly high or in areas where two or more scans overlap. By reducing the 
total number of points in the point cloud, less hard disk space is required and 
the performance of the point cloud visualization is increased, while preserving 
the overall visualization quality. 

The achievable rate of data reduction is highly dependent on the input data. 
Outdoor projects with little overlap between scans will benefit less than 
densely scanned indoor projects where a data reduction of 25% and more can 
be achieved with hardly any perceivable loss of visualization quality.

Cell size

You can adjust the cell size of the existent homogenization feature. The 
standard value of 1.5mm was empirically chosen so that no band artifacts 
emerge. The unit of the maximum distance is adapted according to the setting 
of the small standard units. The homogenization and Close Surfaces are 
mutually exclusive, which means that setting the Close Surfaces will unset the 
homogenization checkbox and vice versa.

Apply Color Balancing

A typical effect seen in real world laser scanning projects is that the overall 
perception of color may not always be consistent across colored scans. This 
effect can have two different root causes:

• The internal camera of the FOCUS3D laser scanners performs white
balancing on a per-scan basis. As a result, the internal camera may choose
to apply a different white balancing at different scan positions, given that
the lighting conditions vary. For example, the scanner is set up in a room
illuminated by neon lights as opposed to natural light when scanning
outdoors.

• While carrying out a scanning project, lighting conditions may vary over
time. For example, when the project starts in the morning and is completed
in the evening (or even on another day).
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This effect may especially become apparent when such differently colored 
scans are combined into a project point cloud and visualized together as 
shown in the following figure:

Figure 10-3 Inconsistent color of a floor due to scans taken under varying 
lighting conditions.

When enabled, the color balancing filter minimizes the color contrast between 
scans in the project point cloud and results in a more homogeneous overall 
perception of color as shown Figure 10-4.

Figure 10-4 Significant reduction of color inconsistencies by applying color 
balancing
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Distance Filter

If this checkbox is set, all points which are more than “Maximum Distance” 
units away from the associated scanner position will not be used to create the 
project point cloud. This filter can be used to restrict the point cloud to the 
more precise near the area of the scanner. For example, if you scan a 
windowed room, you can now ignore most outside stray points, which are 
probably bad, because they were scanned through the window glass. The unit 
of the maximum distance is adapted according to the setting of the standard 
units.

CPU Load The Number of CPU cores to use slider allows adjusting the number of 
(logical) CPU cores to use for parallel computation throughout certain steps of 
the point cloud creation process. The more cores are used, the faster the 
creation may be completed.

A dialog will also be shown during the point cloud creation process that allows 
you to adjust the number of cores on-the-fly if you temporarily need 
processing power for other applications.

Figure 10-5 CPU load 

You may adjust the number of cores used at any time while this dialog is 
shown.

Temporary Data 
Folder

During the project point cloud creation process all scans in the project will be 
loaded successively; their point data will be processed and in a temporary 
representation. This temporary data will be stored inside the temporary data 
folder. Do not delete, move or copy any of these files during the point cloud 
creation process or the process might fail. The temporary data will be deleted 
automatically after the process is complete.

Section Disk Space shows if there is enough free space on the hard disk used 
for the temporary data and the (target) hard disk used for saving the final point 
cloud data. The target hard disk is the disk on which the scan project data is 
stored.

10.17.6 Updating the Project Point Cloud

The project point cloud can be updated to make changes such as deleted 
points or scans persistent. When points are deleted or scans have been 
removed from the scan project, they are not deleted from the point cloud but 
rather marked as removed. The point cloud will no longer visualize these 

NOTE: Less performance is available for other programs running 
on the machine when increasing the number of CPU cores.
183
Chapter 10: Explore



SCENE 2018 User Manual
points; they are filtered out during the point loading process. Unfortunately 
these filter operations will slow down the process of point loading. This may 
not be noticeable for only a few delete operations but as you work with your 
point cloud, deleting more and more points over time, you might notice a 
decrease in performance. When this happens, the project point cloud should 
be updated.

1. Click the Project Point Cloud button  in the toolbar. A drop-down menu
opens.

2. Select Update .

Update when saving 
the project

1. In the Share Changes dialog, select the Update Point Cloud checkbox.

Figure 2: Share changes

This way the project point cloud will be updated automatically after the 
sharing and saving operation is complete.

After the update has been initiated, you are asked to specify the same 
parameters as for the initial creation of the point cloud. If point filters where 
enabled during its creation, it is not necessary to apply them during 
updating again since the resulting points will just be the same (and the 
updating will also take longer without any visual benefit).

10.17.7 Deleting the Project Point Cloud 

1. Click the Project Point Cloud button  in the toolbar. A drop-down menu
opens.

2. Select Delete .

10.18 Visibility Settings
The views can also show objects other than the scan points, such as:

• The positions of the other scans in the workspace.

• The simple objects assigned to a scan that were created by a fit, for
example spheres, and 3D points.
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• CAD models.

Not all views can display all these objects. For further information, see the 
more detailed description of views.

You can decide whether or not to display the objects using the visibility 
settings, which are arranged in three levels:

• The visibility of the layer to which the object is assigned.

• The visibility according to the prominence of the object.

• The distance of the object from the observer.

An object is only visible if the visibility on the first two levels is set accordingly 
and it is located in the set range.

The visibility settings are maintained separately for each view. It is therefore 
possible that an object is visible in one view and not in another. When you 
open a new view, this view initially takes over the default values of the visibility 
settings. You can also change these default values. 

 In a view, right-click the view, then Visibility Settings.

10.18.1 View (3D View only)

Figure 10-2 Visibility settings –Representation

NOTE: If Auto apply changes is selected, new settings are visible 
immediately; you do not need to click the Apply button.
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Quality Settings – Determines the image quality while moving.

If the handle of the slider is moved to the left, the quality of the rendering is 
reduced during movement in favor of performance. 

If the handle of the slider is moved to the right, the quality increases/the 
performance decreases. If the handle of the slider is moved completely to the 
right, there will be no quality penalty during movement.

Clear View Settings – In the clear view mode, points in areas with low point 
density will be displayed more transparently and points in areas with a high 
point density will be displayed more brightly. 

Enable Clear View – check if you want to use Clear View. By changing the 
settings with the slider you can intensify or weaken this effect.

Gap Filling – The gap filler fills gaps between scan points that are physically 
close to each other.

Figure 10-3 Gap filling turned off (left) and turned on (right)

Supersampling – Supersampling renders the point cloud with a resolution 
higher than the resolution of your screen and then shrinks the point cloud to fit 
the screen resolution. This reduces anti-aliasing effects and gives the point 
cloud a smoother visual appearance. Fine and filigree structures look sharper 
and stray points will appear less annoying. Set the resolution of the initially 
rendered point cloud compared to the screen resolution by selecting one of 
the options 2x2, 3x3, or 4x4. For example, choosing 2x2 means that the point 

NOTE: If clear view and gap filling are grayed out, Offscreen 
Rendering under Tools > Options > View might be disabled. 
Offscreen Rendering must be enabled for Gap Filling and Clear 
View.
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cloud will be rendered with a resolution that is 4 times the resolution of your 
screen.

Figure 10-4 Supersampling turned off (left) and turned on (right)

10.18.5 Layer

Figure 10-6 Visibility settings – Layer

Toggle the visibility of the available layers and their related objects and the 
object names in the view. See chapter Layer for more information.

Objects like walls might appear transparent when using small point 
sizes in combination with supersampling.

NOTE: High supersampling resolutions like 4x4 require large 
amounts of graphics card memory.
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10.18.7 Extra

Figure 10-8 Visibility settings -Extra

Objects – Display or hide certain types of objects:

Models Folder – Display CAD models. 

References Folder – Display reference objects.

Scan positions – Display the scanner positions in the view. If enabled, the 
positions will be visualized by this symbol:

Figure 10-9 Scanner position

Cameras – Display the camera positions of other views.

Scan objects – Display or hide the objects that are assigned to the scans in 
the view. You may display these objects only if the scan is loaded.

Visibility – Set the minimum and maximum distance at which objects are 
shown.

Documentation Objects – Set the maximum distance at which 
documentation objects are shown.
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Chapter 11: Export

11.1 Introduction
In order to use scan points from the scans in other applications such as CAD 
systems, SCENE provides the possibility to export scan points in various data 
formats and write them to a file. You can then import this file into the desired 
application.

You may change certain settings prior to the export of the scan points. The 
settings available in the export dialog will be described in this chapter.

Applying Clipping 
Boxes

The export of scan point clouds and of the project point cloud will consider 
activated Clipping Boxes in the same way as they are applied in the 3D Views 
(what you see is what you get). 

If Clipping Boxes exist in the project, but should temporarily not be considered 
during the export, deactivate the Clipping Boxes individually or through the 
global Clipping Box setting.

11.2 Exporting the Scan Project

Figure 11-1 Export toolbar

1. Click the Export button  the Workflow bar. The toolbar will now show the 
available Export functions.

2. Click the button of the Export function you want to execute for the entire
scan project.

11.2.2 Export Scans

In the Export toolbar, click Export Scans, then click

• Export Scans – ordered to export all scans of this scan project.

NOTE: 

• Due to the nature of the underlying data, the export of points
from 3D selections provides only a reduced set of export
settings. The mismatching will be grayed in the export dialog
when exporting points of a 3D Selection.

• Not all export formats are available when exporting points from
a 3D selection.The supported formats are CPE, E57, VRML,
DXF, XYZ Text, XYZ Binary, IGES, FLS, PTS and POD.

• The export of multiple scan point clouds of a scan folder does
not support to export all points into a single file.
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• Export Scan Point Clouds – unordered to export all point clouds of this
scan project. Exporting scan point clouds on a scan or cluster will only
apply the Clipping Boxes below the scan or cluster, instead of all
available Clipping Boxes.

The Export Scan Points dialog opens, and you can specify the export format, 
and the required settings. Export formats are: CPE, E57, VRML, DXF, XYZ 
Text, XYZ Binary, IGES, PTS and POD.

11.2.3 Export Project Point Cloud

 In the Export toolbar, click Export Project Point Cloud.

The Export Scan Points dialog opens, and you can specify the export format, 
and the required settings. Export formats are: CPE, E57, VRML, DXF, XYZ 
Text, XYZ Binary, IGES, PTS and POD.

All clipping boxes will be applied.

11.2.4 Export Project

 In the Export toolbar, click Export Project.

The Export as Project dialog will open.

• Format: Select, if the new scan project will be used in SCENE or in
ReCap.

• Project Name: Enter a project name for the new project.

• Location: Select the target folder in which the new project shall be saved.

11.2.5 Export Overview Map

Scan Project

The overview map for a scan project can be exported as a high resolution TIF 
image or as a DXF file that can be opened in any CAD system for further 
modeling. 

 In the Export toolbar, click Export Overview Map.

 A file dialog opens where you can enter the desired name of the exported
file.

An additional text file is also created that contains information about the 
resolution, the image size in pixels and in meter, and the corner points of the 
image and the associated TIF file.

Scan Cluster

To export the overview map of a single scan or a cluster:

NOTE: When exporting a ReCap Cluster Project, SCENE creates 
a temporary SCENE project in the TEMP folder. This may require 
a large amount of disk space.
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 Right-click the cluster and select Export > Overview Map.

Scan

To export each overview map of a scan into a single file:

 Right-click the cluster and select Export > Scans > Overview Map.

 A file dialog opens where you can enter the desired base name of the
exported file. For each overview map exported, the corresponding scan
name is added to the base name.

11.2.6 SCENE WebShare Cloud

 In the toolbar, click SCENE WebShare Cloud.

A drop-down menu opens in which you can select to

• Export SCENE WebShare Cloud Project: Export the project for SCENE
WebShare Cloud or WebShare 2Go 2.0.

• Upload SCENE WebShare Cloud Project: Upload an existing export to
SCENE WebShare Cloud.

• Upload Project Point Cloud Data: Upload the project point cloud to
SCENE WebShare Cloud as a CPE file. This CPE file can be used as
source data for the 3D View in SCENE WebShare Cloud.

11.2.7 Export Objects

 In the Structure View, right-click the scan, then click Export > Objects.

The Export Objects dialog opens, and you can specify the export format, and 
the required settings. Export formats are: VRML, DXF, and IGES.

11.3 Exporting scan points

11.3.1 Scan points of an entire scan

• In the Structure Window, right-click the scan, then select Export > Scan
Points.

Or:

1. Open the scan in Planar View or the Quick View.

2. Right-click into the view, then select the command Export > Direct Export or
Export > Export Scan Points in its context menu.

• Select Direct Export to export the scan points without opening the
settings dialog. The prior settings will be used and the data will be saved
directly to a file.

• Select Export Scan Points to open the settings dialog to make certain
settings prior to exporting the points. The available settings are
explained in the next sections.
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11.4 Exporting scans
To export scans:

1. In the Structure View, right-click the cluster.

2. Select Export > Scan Points. This command will be grayed if a scan point
cloud of the respective scan does not yet exist.

11.4.1 Exporting the scans of a cluster

 In the Structure View, right-click the scan, then select Export > Scan Points.

The Export Scan Points dialog opens, and you can specify the export format, 
and the required settings.

11.4.2 Exporting the scans bundled as a new project

 In the Structure View, right-click the cluster, then select Export > As Project.
The Export as Project dialog opens.

• Format: Select, if the new scan project will be used in SCENE or in
ReCap.

• Project Name: Enter a project name for the new project.

• Location: Select the target folder in which the new project shall be saved.

11.4.3 Exporting the images of the scans to .jpg format

 In the Structure View, right-click the scan, then select Export >
Panoramic Images. Select Scan Resolution to create images that have the
same color resolution as the scan, or select Full Color Resolution if you
want to create panoramic images with the highest color quality possible,
and which are compensated to remove the offset between the two halves of
the scan, as well as any distortion cause by the scanner’s rotation. Full
color resolution panoramas have a white stripe at the bottom of the picture
because the proportions of the scan and the picture are different. (Scans
made with FARO scanners versions M70, S70, S350 and later create 160
megapixel images. Scans from older scanners only output panoramic
images with 40 megapixel images.)

The Select folder for images export dialog opens, and you can browse to the 
target folder in which the images shall be saved.

NOTE: When exporting a ReCap Cluster Project, SCENE creates 
a temporary SCENE project in the TEMP folder. This may require 
a large amount of disk space.
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11.5 Exporting scan point clouds

11.5.1 Export one scan point cloud

To export the scan points of a scan point cloud:

• In the Structure View, right-click the scan, then select Export > Scan Points.
This command will be grayed if a scan point cloud of the respective scan
does not yet exist.

11.5.2 Export several scan point clouds

To export the scan points of several scan point clouds of a scan folder:

• In the Structure View, right-click the scan, then select Export > Scan Points.
This command will be grayed if the respective scan folder does not contain
any scan point clouds.

11.6 Exporting the project point cloud
To export the project point cloud of a scan project:

1. Click the Project Point Cloud button  in the Export toolbar. It does not
matter what you clicked in the Structure View before.

The Export Scan Points dialog is shown.

2. Select the file format in which you want the project point cloud to be
exported.

3. Click OK to start the export.

11.7 Exporting a Cluster
You can export the content of a cluster into three different formats:

• the scan points of each scan, or the scan points of all scans,

• the scans bundled to a new project,

• the images of the scans. The images are saved in .jpg format.

11.7.1 Exporting the scans of a cluster

 In the Structure View, right-click the scan, then select Export > Scan Points.

The Export dialog opens, and you can specify the export format, and the 
required settings.

11.7.2 Exporting the scans bundled as a new project

 In the Structure View, right-click the cluster, then select Export > As Project.
The Export as Project dialog opens.
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• Format: Select, if the new scan project will be used in SCENE or in
ReCap.

• Project Name: Enter a project name for the new project.

• Location: Select the target folder in which the new project shall be saved.

11.7.3 Exporting the images of the scans to .jpg format

 In the Structure View, right-click the scan, then select Export >
Panoramic Images. Select Scan Resolution to create images that have the
same color resolution as the scan, or select Full Color Resolution if you want
to create panoramic images with the highest color quality possible. (Scans
made with FARO scanners versions M70, S70, S350 and later create 160
megapixel images. Scans from older scanners only output panoramic
images with 40 megapixel images.)

The Select folder for images export dialog opens, and you can browse to the 
target folder in which the images shall be saved.

11.8 Format related settings 
The appearance of the Export dialog depends on the format selected in the 
Format dropdown menu. Some file formats support additional settings in 
which can be configured in up to three tabs. 

NOTE: When exporting a ReCap Cluster Project, SCENE creates 
a temporary SCENE project in the TEMP folder. This may require 
a large amount of disk space.
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11.8.1 Export tab

Figure 11-2 Export tab, shown here for the IGES export

Full scan

Export the entire scan.

Selection

Export the selection.

Full Scan and Selection become available only when exporting from a single 
scan within the tree or from a point selection.

Subsample

Since even small selections of a scan can contain a great number of scan 
points it may be necessary to reduce or thin out the exported scan points. 
Thinning out is achieved by only exporting every second, or third scan point of 
a row or column. Therefore, thinning out is done according to the arrangement 
of the scan points in the planar or Quick View.

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and so 
on. For example, if you enter the value 10 in both fields, you will thin out of a 
tenth of the columns and a tenth of the rows, therefore in total you will have a 
reduction of one hundredth of the scan points. 

For further reduction, you can indicate the distance threshold a scan point may 
be away from the scanner:
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Min. Distance – The minimum distance the exported scan points can be 
from the scanner. Scan points situated closer are not exported.

Max. Distance – The maximum distance at in which the exported scan 
points can be from the scanner. Further away scan points are not exported.

Color and Grey 

Export RGB and grayscale (intensity) values of each scan point if available. 
This function is enabled for the formats CPE, E57, XYZ text, POD, PTX and 
PTS. To export both values, the scan will be unloaded first and re-loaded with 
both values. After the export, the scan will be unloaded again and the initial 
scan status will be restored.

Use Local Coordinates

Enable to export the points in the local coordinate system of an available 
Clipping Box. Select the box from the drop down list. This option is only 
available if points of scan point clouds or the project point cloud will be 
exported and if there is at least one Clipping Box in the workspace. It is not 
available for exporting points of scans.

11.8.3 Slices tab

If, for example, you want to very quickly create the floor plan of a building from 
the scan points, it is practical to use the slice export. When exporting slices, 
only those scan points are exported, which are between the top and the 
bottom limit you have specified. Therefore, if you select a slice where there is 
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hardly any furniture or machines blocking the view, you obtain the floor plan of 
the building very easily.

Figure 11-4 Slice of scan points

When exporting slices, only those scan points are exported, which are 
between the top and the bottom limit you have specified. 
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You can of course also apply the threshold outlined above for reducing and 
thinning out when exporting slices.

Figure 11-5 Export of a single slice

The orientation and position of the slice are defined by the reference plane. 
The default setting of the reference plane is the ground floor, so top and 
bottom limits refer to the z coordinate and are limits in height.

If you want to create vertical slices, for example, you can select the 
corresponding predefined plane with the normal pointing along the x- or y-axis. 

The reference plane will be added to the workspace after the export. It will be 
called ExportRefPlane and will be available in the folder References.

However, the export of slices is not limited to planes with normals pointing 
along the axes. With the Custom button you can use arbitrary planes as 
reference planes. Custom reference planes make it very easy to export scan 
points of objects that are located above a flat surface, like objects on the floor 
or on a table, by fitting a plane to the surface and using this plane as a 
reference.

The Tomograph can be used with any reference plane.

11.8.6 Several slices

If you want to export several slices at the same time, you can define the slices 
with a set of planes. In contrast to the export of a single slice, here each plane 
directly defines the location of the slice. Instead of having a plane and a top 
and a bottom distance, each plane defines the center of the slice. All slices 
have the same thickness which you can input into the dialog. 
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Also in contrast to the export of a single plane, here only those points of a slice 
are exported which are located within a given radius around the center point of 
the slice.

The center point of each slice is defined by the position of the corresponding 
plane. 

You can create planes either by fitting or manually. Observe that all planes of 
the workspace will be used as reference planes – even if they are defined in 
other scans or in completely different folders of the workspace.

In the figure below you can see an example of an export with a set of 
equidistant planes that had been defined manually. This figure shows the 
exported scan points after they have been imported back into SCENE. 

Figure 11-7 Slices defined by a set of equidistant planes

Several Slices: Slice 
by plane

If you want to export several slices at the same time, you can define the slices 
with a set of planes. Here, each plane directly defines the location of the slice. 
Instead of having a plane and a top and a bottom distance, each plane defines 
the center of the slice. All slices have the same thickness which you can input 
into the dialog.

Only those points of a slice are exported which are located within a given 
radius around the center point of the slice.
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The center point of each slice is defined by the position of the corresponding 
plane. 

Figure 11-8 Export of several slices

You can create planes either by fitting, or manually. Observe that all planes of 
the workspace will be used as reference planes – even if they are defined in 
other scans or in completely different folders of the workspace.

11.8.9 Tomograph

When exporting slices, of course scan points from horizontal surfaces in the 
slice are also exported, which can make it difficult to define the floor plan. The 
Tomograph resolves this: it brings out vertical surfaces and hides horizontal 
surfaces, thereby allowing walls and supports to stand out.

Figure 11-10 Tomograph

The Tomograph works like an X-ray apparatus – the X-ray goes through the 
slice from above and comes out on a photo plate below. The photo plate is 
covered with a fine raster and a raster field now either turns black or it remains 
white. If the X-ray hits sufficient scan points on its way through the slice, the 
raster field turns black. This occurs predominantly with vertical surfaces. If the 
X-ray hits only very few scan points, as is the case with horizontal surfaces,
the raster field remains white.

The Tomograph brings out vertical surfaces and hides horizontal surfaces, 
thereby allowing walls and supports to stand out.
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11.8.11 CPE Export

CPE is a new file format for point data developed by FARO that combines 
minimal file size with flexible quality settings.

Figure 11-12 CPE Export

When exporting scans to the CPE file format, the following information has to 
be provided:

• File name – Name and location of the file to be created.

• Export each scan in a separate file – If not selected, all scans will be saved
in one file.

• Numerical Resolution – Set the numerical resolution (quantization) for the
exported scan points to one of the recommended values or your own
desired value.

• Color – Set the number of colors used for the exported scan points to “True
Color”; or “High Color” for a smaller file size, but with a reduced visual
quality of color gradients.

• Export Reflection Values – Export with raw reflections, that can be between
0 and 2047 for the FARO Laser Scanner. Otherwise, the monitor brightness
will be exported (values between 0 and 255).Export the original reflection
values of the scan points if they're available.

• Export Normal Vectors – Export the normal vectors of the scan points.

• Estimated size – The estimated file size in MB per million exported scan
points.

11.8.13 E57 Export

When exporting scans to the E57 file format, the following information will be 
stored in the exported file:
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• For each scan point in a scan, the xyz-coordinate, RGB or intensity values,
and the corresponding index of row and column. This information is part of
the binary section of the E57 file. It is possible to store several scans in one
E57 file.

• Additional Meta information like the scan name, the unique ID (Uuid) of a

scan and the software version that is used for the export1. This information
is stored in the XML-part of the E57 file.

Figure 11-14 Settings for E57 export

File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file. 

1. For more detailed information we refer to http://www.libe57.org or
http://www.astm.org/Standards/E2807.htm
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11.8.15 VRML

Figure 11-16 Settings for VRML export

File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file.

Export

Scan points as is – Scan points are exported as points.

Note: A lot of VRML viewer programs do not support points!

Scan points as sphere – Scan points are exported as small spheres.

Scan points as boxes – Scan points are exported as small boxes.

VRML2 – Export in VRML2 format. Otherwise VRML1 is used.

Coordinate System

Select the target coordinate system. 

11.8.17 DXF

DXF is a data format developed by AutoDesk for the exchange of CAD 
drawings. SCENE uses DXF version 12.
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The scan points in DXF are always displayed as points. Since DXF has very 
few gray scales at its disposal, the visual appearance is not as good as in 
SCENE.

Figure 11-18 Settings for DXF export

File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file. 

Export Object Names

Select this check-box if the names of the selected objects shall be exported.

11.8.19 XYZ text

With XYZ text format, the export file contains one scan point per row. Each 
scan point is identified by its 3 Cartesian coordinates X, Y and Z and the 
reflection value. You can also specify the row and column number of the scan 
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point. Both these numbers will then be next to the current scan point in the in 
export file.

Figure 11-20 Settings for XYZ text

File name

Name and location of the file to be created.

Export each scan in a separate file

If not selected, all scans will be saved in one file. 

11.8.21 IGES

IGES is a multi-vendor-capable standard for the exchange of CAD drawings. 
SCENE uses IGES version 5.3. 
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The scan points are exported as gray points or color points, if color information 
is available. When you import the IGES file into your CAD system, it decides 
how it will represent these points in its in own gray or color space.

Figure 11-22 Settings for IGES export

File name

Name and location of the file to be created.

Part

naming the parts is a required component of an IGES file.

Author

specifying the author is a required component of an IGES file.

Organization

specifying the organization is a required component of an IGES file.

Represent Scan Points as

Points – Scan points are displayed in the CAD system as points.

Spheres – Scan points are displayed in the CAD system as small spheres.

Set Color to

Settings for the colors to be used.

IGES default – The export file does not contain any color specifications so 
the CAD system will use the default color.
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Scan point color – Use the gray value or color value of the scan point.

Scan specific – If the export consists of several scans, the scan points 
from the different scans will have different colors. 

Set Level to

Settings for the level to be used.

IGES default – The export file does not contain any level specifications so 
the CAD system will use the default level.

Scan specific – If the export consists of several scans, the scan points 
from the different scans will have different levels.

Objects

Unbounded Planes – The idealized planes without border are also 
exported as idealized and without border. Otherwise a square is exported.

Export Object Names – Object names are exported.

Level – Level allocation for object names.

11.8.23 PTS Export

Figure 11-24 Settings for PTS export

File name

Name and location of the file to be created.
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Export each scan in a separate file

If not selected, all scans will be saved in one file.

Full scan

Export the entire scan.

Selection

Export the selection.

Full Scan and Selection become available only when exporting from a 
single scan within the tree or from a point selection.

Subsample

Since even small selections of a scan can contain a great number of scan 
points it may be necessary to reduce or thin out the exported scan points. 
Thinning out is achieved by only exporting every second or third scan point of 
a row or column. Therefore, thinning out is done according to the arrangement 
of the scan points in the planar or Quick View.

Rows – Reduction by thinning out the rows

Columns – Reduction by thinning out the columns

With the value 1, every column/row is exported, with 2 every second, and 
so on. For example, if you enter the value 10 in both fields, you will thin out 
of a tenth of the columns and a tenth of the rows, therefore in total you will 
have a reduction of one hundredth of the scan points. 

For further reduction, you can indicate the distance threshold a scan point may 
be away from the scanner:

Min. Distance – The minimum distance the exported scan points can be 
from the scanner. Scan points situated closer are not exported.

Max. Distance – The maximum distance at which the exported scan points 
can be from the scanner. Further away scan points are not exported.

Color and Grey 

Export RGB and grayscale (intensity) values of each scan point if available. 
This function is enabled for the formats E57, XYZ text, POD, PTX and PTS. To 
export both values, the scan will be unloaded first and re-loaded with both 
values. After the export, the scan will be unloaded again and the initial scan 
status will be restored.
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11.8.25 Export POD (PointoolsTM)

Pointools is a third-party application that provides an environment for viewing, 
analyzing, editing and producing visual content from a range of 3D data types. 

Figure 11-26 Settings for Pointools export

File name

Name and location of the file to be created.

Compression Accuracy

POD files compress cloud data for efficient storage and faster retrieval from 
disk. You can set the level of accuracy you want to maintain. It is important to 
consider the accuracy of the instrument used to acquire the data and to not set 
the compression accuracy too high. 

Normal Generation

Normals are required for point lighting. This data is either imported from the 
source file or generated upon import.

Normal – no altering.

Sharpest, Sharper, Sharp – Quality of normals, degree of faceting on object’s 
surface. 

Smoothest, Smoother, Smooth – Quality of normals, degree of curvature on 
object’s surface. 

Spatial Filter Strategy

For advanced users. Default setting is usually sufficient.
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Spatial Filter Accuracy: Much like the compression accuracy, setting this too 
high may result errors.

11.9 SCENE WebShare Cloud
With SCENE WebShare Cloud, panoramic scan images can be put on the 
Internet, thus enabling anyone to share scan information of scan projects with 
other parties, like far-off company sites, customers, suppliers or partners 
without the need of additional software.

SCENE WebShare Cloud is a web service hosted by FARO Technologies inc. 
which enables you to share your scan projects without setting up a web server 
on your own. The project data can be accessed with a standard web browser, 
no additional software or plug-ins are needed. Connect to 
faro.websharecloud.com to view the publicly available projects.

11.9.1 Export SCENE WebShare Cloud Project

Before publishing a scan project in SCENE WebShare Cloud, special SCENE 
WebShare Cloud data has to be created from the project. Follow these steps 
to create such data:

1. Open your scan project. Make sure that the scan project is processed and
registered.

2. Click the SCENE WebShare Cloud button in the tool bar. A small menu
opens.

3. Click the Export SCENE WebShare Cloud Project button in that menu.

4. You will be asked to save the scan project first.

NOTE: For details about the export, refer to the PointoolsTM 
manual.

NOTE: See the SCENE WebShare Cloud online help for more 
information: www.manuals.faro.com/documentation.

NOTE: Freestyle3D scans are visible in overview maps, but if you 

want to view your Freestyle3D scans as panoramas in SCENE 
WebShare Cloud, you must first create virtual scans. 

See Upload Project Point Cloud on page 218 to learn how to 

create 3D views from Freestyle3D data in SCENE WebShare 
Cloud.
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5. The SCENE WebShare Cloud export dialog appears. This dialog has three
tabs:

• Export Settings: allows configuring the data export of the SCENE
WebShare Cloud Overview Map and the Panorama Views.

• Project Settings: allows providing the name of the project and its URL
identifier plus additional project information to be published in SCENE
WebShare Cloud.

• Upload Settings: allows entering the user login data, and starting the
project upload to SCENE WebShare Cloud immediately.

6. Configure the data export on tab Export Settings of the SCENE
WebShare Cloud export dialog.

Export Settings

Figure 11-2 SCENE WebShare Cloud export dialog – Export Settings
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Overview Map settings

Settings for the Overview Map, which is a top view of your entire scan 
project.

Standard View – Select an option in this drop down list to export the 
Overview Map with the following options:

• Standard View

• Clear View

• Gap Filler

• SCENE Overview Map

Background color – Select the background color of the Overview Map. 
Selecting a color other than white might be useful when the scan project 
contains crucial structures which are white themselves. You can test this by 
selecting a white background in the 3D View and looking at the project from 
above.

Create Scan Overlays – If this check box is selected, the coverage of 
each scan can be shown in the overview map.

If this check box is activated, the coverage of each scan can be shown in 
SCENE WebShare Cloud's overview map. Since the creation of the scan 
overlays increases the export and upload time significantly, the option is 
deactivated by default.

Single-layer map

Apply Clipping Boxes – Sometimes, it might be useful to hide points (for 
example, the roof of a building) with the help of Clipping Boxes to improve 
readability of the map.

Select this option to create the Overview Map from the visible scan points, 
defined by the available and active Clipping Boxes.

Multi-layer map – These map layers can be toggled on and off separately in 
SCENE WebShare Cloud. Clipping boxes are used as the basis for the 
map layers. Select one or more clipping boxes from the given list.

The Clipping Boxes have to show their inside. They do not need to be 
active.

Export layout plans – If the project contains layout plans, select here if you 
want them to be exported and if yes, if all layout plans shall be exported or 
only some of them.

Panorama settings

Settings for the panoramic scan images.

Resolution

• Export images in HD resolution – Select whether to export the panorama
images in the standard resolutions only (width of the standard panorama
images is up to 4096 pixels) or, to export the panorama images in the
standard resolutions and additionally in a higher resolution (HD
resolution, width of images is 8192 pixels). Such HD images can only be
displayed on desktop PCs or Notebooks. On mobile devices like tablet
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computers, the panorama images will be displayed in the standard 
resolutions.

• Export scan data in HD resolution – The scan data which is necessary for
measurements and annotations in the panorama images can be
exported in two sizes, in the standard size and, additionally, in the
maximal size. Exporting scan data in the maximal sizes needs additional
storage space of 128 MB per scan on the server, but facilitates the exact
positioning of measurements and annotations in HD panorama images.

Color Settings

Panorama images can be exported in color and/or as gray scaled images. 
If there are scans in the scan project that are not colorized, gray scaled 
images will be exported from these scans, even if Export gray scale images 
is not selected. And vice versa, if there are scans in the project that do not 
have their original reflection values anymore, only colored images will be 
exported from these scans, even if Export color images is not selected.

Project Settings 1. Set up project information on tab Project Settings:

Figure 11-3 SCENE WebShare Cloud export dialog – Project Settings

Name – Enter the name of the scan project.
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URL identifier – Enter a unique identifier for the project in the SCENE 
WebShare Cloud. Every project in the SCENE WebShare Cloud must have 
a unique URL identifier. The following characters are allowed: “a-z”, “0-9”, 
and “-”.

Preview image – Select a preview image for the project. This image will be 
displayed in the SCENE WebShare Cloud project selection. Supported 
picture formats are BMP, JPEG, and PNG.

Access control

• Make public – If you set this option, everybody will be able to see and
access the project in SCENE WebShare Cloud. If you do not set this
option, the project will not be visible to the SCENE WebShare Cloud
users. After project has been uploaded, the appropriate project access
rights must be defined in the Administration area of SCENE WebShare
Cloud to make the project visible to certain users or user groups. See the
SCENE WebShare Cloud online help for more information.

• Feature project – If you set this option, the project will be shown in the
slide show on the SCENE WebShare Cloud Project Overview page.

Description – Enter a description text for the project.

Keywords – Enter keywords associated with the project, separated by 
commas.

Project coordinates – Enter the project’s world coordinates. The project 
location will be displayed on a map in the SCENE WebShare Cloud. The 
latitude must be a decimal number between -90 and 90, the longitude 
between -180 and 180. 

2. Click Show the project location in Google Maps button  to test the 
entered coordinates in Google Maps.

3. If you want to upload the data to the SCENE WebShare Cloud immediately,
switch to tab Upload Settings.
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Upload Settings

Figure 11-4 SCENE WebShare Cloud export dialog – Upload Settings

Immediately start upload – Starts to upload all files created during the 
SCENE WebShare Cloud export immediately. If you do not want to upload 
the SCENE WebShare Cloud data immediately, you can do this at any time 
later. For more information, see chapter Uploading SCENE WebShare Cloud 
Project.

Upload options – enter your login credentials for the SCENE WebShare Cloud 
web service:

Domain – Enter your organization's subdomain ID on SCENE WebShare 
Cloud.

User name – Enter your user name to log in to SCENE WebShare Cloud.

Password – Enter your password.

NOTE: We recommend to export and upload the data in parallel.
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Save Credentials – Select to save your login credentials so that you do 
not have to enter them again in the future.

Once finished, click Export to start the creation of the SCENE WebShare 
Cloud data that will be saved to the project folder. The data is uploaded to the 
WebShare Cloud.

NOTE: You must have a SCENE WebShare Cloud account with 
Uploader rights to upload scan projects. Ask your SCENE 
WebShare Cloud Administrator for more information.
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11.9.5 Uploading SCENE WebShare Cloud Project

If SCENE WebShare Cloud data is already available for your scan project, you 
can upload it to the SCENE WebShare Cloud at any time. Follow the steps 
below to do this:

1. Click the SCENE WebShare Cloud button in the toolbar. A small menu
opens.

2. Click Upload Data in that menu. The SCENE WebShare Cloud upload
dialog will show up. This dialog has two tabs, Upload Settings and Project
Settings.

Figure 11-6 SCENE WebShare Cloud upload dialog – Upload Settings

Upload options – enter your login credentials for the SCENE WebShare Cloud 
web service:

Domain – Enter your organization's subdomain ID on SCENE WebShare 
Cloud.

User name – Enter your user name to log in to SCENE WebShare Cloud.

Password – Enter your password.
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Save Credentials – Select to save your login credentials so that you do 
not have to enter them again in the future.

3. Specify project relevant information on tab Project Settings.

4. Once finished, click Upload to start uploading of the SCENE WebShare
Cloud data to SCENE WebShare Cloud.

11.9.7 Upload Project Point Cloud

It is now possible to upload point clouds to SCENE WebShare Cloud or export 
the point clouds generated in SCENE to a particular project in the SCENE 
WebShare Cloud domain. Select the Upload Project Point Cloud option in the 
SCENE WebShare Cloud drop-down menu to open the Send to SCENE 
WebShare Cloud tab.

This functionality can also be accessed from the: 

• context menus of scans or clusters, select Point Cloud > Send to SCENE
WebShare Cloud.

• context menus of clipping boxes, select Active Clipping
Boxes > Send to SCENE WebShare Cloud.

• context menus of selections, select Selection > Send to SCENE WebShare
Cloud.

Login The Login page is displayed. Enter the login details to access your SCENE 
WebShare Cloud domain.

NOTE: 

• You need to have a SCENE WebShare Cloud account with
Uploader rights to upload scan projects. Ask your SCENE
WebShare Cloud Administrator for more information.

• You can resume interrupted uploads: To resume an
interrupted upload, make sure to enter the same URL identifier
in the Project Settings as used in the previous upload attempt.

NOTE: It is recommended to upload the project point cloud, or 
selections based on it.

Due to filtering and color balancing, a better visualization quality 
can be achieved than with scan point clouds.

NOTE: You must have a SCENE WebShare Cloud account with 
Project Manager rights to upload point clouds. Ask your SCENE 
WebShare Cloud Administrator for more information.
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If the login credentials are already saved, you are automatically logged in with 
the saved credentials.

Figure 11-8 Login to upload project point cloud

Select Project 
Settings

The Select Project Settings page opens.

Figure 11-9 Select the project in the list of recommended or other projects

Based on the project properties of the current SCENE project, matching 
SCENE WebShare Cloud projects are recommended.

Other projects can be selected by expanding the section Other Projects in this 
Domain. 

If you want to upload the CPE file into a new empty SCENE WebShare Cloud 
project, create the project in SCENE WebShare Cloud first.

NOTE: When uploading to an existing SCENE WebShare Cloud 
project, make sure that you did not modify the scan positions in 
SCENE after the SCENE WebShare Cloud export. Otherwise, the 
uploaded point cloud will not be aligned to the scan positions in the 
SCENE WebShare Cloud project.
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Point Cloud Settings The Point Cloud Settings page opens.

The project point cloud is generated in CPE format. Enter the name of the file, 
and file format properties.

Figure 11-10 Point Cloud Settings

Start Upload Click Start Upload to upload the project point cloud. After the upload has 
successfully completed, you can use the Create 3D Data task in SCENE 
WebShare Cloud to create the data for the 3D View. Select the uploaded CPE 
file in the Select Sources option. You can additionally select other CPE files or 
scans to get a combined 3D View. After the 3D data creation has finished, you 
can view the uploaded point cloud in SCENE WebShare Cloud.
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Chapter 12: Virtual Reality

12.1 Introduction
SCENE7.1 introduces the ability to step into your point cloud with virtual reality 
(VR). You can now experience your scans as if you were on location, take 
measurements, make screen captures, and read annotations.

12.2 VR System requirements
• See System Requirements on page 12 for all VR system requirements.

12.3 SCENE project requirements
• Your project requires a point cloud.

• Closed surfaces are strongly recommended.

12.4 SCENE Virtual Reality features
When you view your project using VR goggles, the following features are 
available:

• View a project point cloud.

• View imported mesh/VRML data.

• Choose among different movement modes:

• Teleporting

• Flying

• Flying with fixed vertical position (walk mode).

• Jump directly to measurements, annotations, and scans.

• A virtual tablet that serves as your user interface while using the VR
goggles. It can be minimized when you don’t need it.

• Keep track of your location with a 2D overview map (if present in your
project).

• Take and delete measurements.

• View and delete annotations and attached image files.

• Take and delete screen captures. The images are stored in the structure
window under the Screenshots folder. To export the screen captures, select
the images in the structure window, right-click and choose export images.

• View the help page for Oculus and HTC VIVE that explains how to use the
controllers to explore the virtual world.

• VR Settings (Within VR only).
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12.5 Starting the Virtual Reality in SCENE.

1. Ensure that the VR hardware is correctly connected to the computer.

2. Open the Explore Toolbar and click the VR icon.
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Chapter 13: Scanning 

The Scanning category available in SCENE and FARO® Laser Scanner 
provides the options for Scanner Control, On-Site Registration, and 
On-Site Compensation.

Activate Scanning in 
SCENE 

Typically, you will not see the Scanning feature in SCENE since it is hidden. If 
you need it, activate it in Settings > General > User Interface > Show Scanning 
Category under the User Interface option. The Scanning feature will then 
appear in the Workflow Bar.

13.1 Scanning

Figure 13-1 Scanning toolbar

The Scanning toolbar provides the following options: 

• Scanner Control

• On-Site Registration

• On-Site Compensation

• Open Target PDF

13.2 Scanner Control
The Scanning category has the Scanner Control option. It can be used to start 
a remote connection to control the laser scanner. The scanner can be 
controlled by using the scanner user interface that is displayed in SCENE.
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To connect to the scanner: 

1. Enter the IP address of the scanner.

Figure 13-1 Connect page: Enter the IP address

2. Click Connect to retrieve the details of the scanner. The page will be
updated.

Figure 13-2 Connect to Scanner

3. If the IP address is not associated to an active laser scanner, an error
message is displayed.
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4. If a connection is successful to a supported FARO Focus Laser Scanner,
the Control button becomes active and green. Click to control the scanner
through the HTML user interface.

Figure 13-3 Click to Control the Scanner

5. SCENE starts the Scanner Control task and displays the scanner user
interface. You can control the scanner remotely through this HTML
interface.

Figure 13-4 Finish or Cancel task

6. Click the Finish or Cancel button to close the scanner user interface,
scanner control task and disconnect from the scanner.

13.3 On-Site Registration
The On-Site Registration feature enables the user to process and register 
scans on-site remotely through the computer running SCENE software. The 
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scanner must be connected to SCENE and can be controlled by using the 
scanner user interface displayed in SCENE. The processing and registration 
of the scans are performed in SCENE

The user can operate on-site registration functionality as follows: 

• directly on the scanner
Or

• through a connected device like a smart phone or tablet, showing the
scanner user interface
Or

• within SCENE. The scanner can be remotely accessed through WLAN or
Ethernet through a computer running SCENE.

13.3.1 On-Site Registration Setup

To enable on-site registration, see On-Site Compensation.

The procedure to setup on-site registration is as follows. 

On the Scanner Configure the scanner

1. Configure the WLAN connection on the laser scanner. See Connecting the
Scanner to WLAN.

2. Configure scan project/cluster, scan name, scan parameters.

Enable On-Site Registration

1. Go to Home > Manage > On-Site Registration Settings.

2. Turn On-site Registration ON or OFF by sliding the button. The scanner
now connects to a remote system in the network, running SCENE.

3. The IP address and port will be automatically set on the scanner.

4. The Start Scan button leads to the new map page. When Start Scan is
selected, the map page will be displayed.

NOTE: Refer to the Operating Software chapter in FARO Laser 
Scanner User Manual for more information about on-site 
registration settings and related user interface pages.
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On your Computer Configure SCENE

1. Configure the WLAN network of the computer.

2. Start SCENE on the computer.

3. Start On-Site Registration task in the Scanning category of SCENE.

4. Enter the IP address of the laser scanner. You can find the IP address of
the laser scanner by tapping Manage > General Settings > WLAN > IP
Address on the scanner user interface. Enter the IP address as it is,
following exactly the given scheme of digits.

5. Connect to the FARO laser scanner after entering the IP address in the On-
Site Registration task. The scanner Home page is displayed.

6. On the scanner home page click the Map button. A map is displayed with
the available scans in a project.

Figure 13-2 On-Site Registration overview map with list and status of scans

7. Now click Start Scan button to start a new scan on your scanner, or
remotely in SCENE. All recorded scans on the current cluster or project
opened on the scanner will be uploaded to SCENE. The scans will be
automatically processed by SCENE.

NOTE: The scanner and computer must be continuously 
connected to the same WLAN network.

NOTE: If one scan fails to register, run a connection scan with the 
scanner placed in between the area of the two different scans.

To validate the registration of scans, highlight their points in the 
map. 
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13.4 On-Site Compensation
On-Site Compensation process is a procedure to test and improve the angular 
accuracy of the scanner using SCENE software.

13.4.1 Preparing the Compensation Station

Site Setup

Before you begin the On-Site Compensation process, ensure that the scan 
site has the following facilities:

• Target sheets must be setup at the scan site at regular distance to the laser
scanners between 1.5 m to 3 m.

• No windows or other reflective planes: The markers on the target sheets
would be reflected if the scan site has any windows or reflective surfaces.
This can cause incorrect measurements.

• Lighting conditions are less important because On-Site Compensation is
done with the laser, video images are not used.

13.4.2 Connect Laser Scanner to Computer through Wireless LAN

To be able to transfer the scanned data directly to your computer, you must 
connect the computer with the laser scanner and through WLAN to remotely 
access and control the scanner.

Using the scanner 
as a WLAN access 
point

On your scanner 1. Enable WLAN on your scanner (see Connect Laser Scanner to Computer
through Wireless LAN).

2. Look up your scanner‘s network name by tapping Manage > General >
WLAN > Network Name on the scanner‘s user interface.

On your Computer Establish a WLAN connection between the computer or tablet and the scanner 
by using the network name as the SSID.

NOTE: On-Site Compensation feature is not available for 
FocusM 70.

NOTE: Disable the proxy server to make the connection work. If 
this is not possible for some reason, enter the addresses of both 
devices in the Exceptions field. 

We recommend to use a WLAN card that supports IEEE 802.11n.
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13.4.3 On-Site Compensation steps

On your computer Select Output folder

1. Click Start On-Site Compensation button in the Scanning toolbar by
selecting the “Scanning” toolbar.

All data captured during On-Site Compensation, including the Compensation 
Report will be stored in the output folder. 

2. Click the Browse button to open the file system browser.

3. Browse to the folder. Click the OK button.

13.4.4 Setup

Figure 13-5 Setup: Select Output Folder

Figure 13-6 Setup: Enter IP Address
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Enter Scanner IP Address

1. Enter the IP address of the laser scanner. You can find the IP address of
the laser scanner by tapping Manage > General Settings > WLAN > IP
Address on the scanner user interface. Enter the IP address as it is,
following exactly the given scheme of digits and dots.

2. Click the Connect button.

3. In the dialog, click the Place Targets button to continue with the next step.

Figure 13-7 Place Targets 

13.4.8 Place target

Print target sheets

On your Computer 1. In the Place Targets page, a picture is shown that describes how to place
the targets and the scanner for the compensation.

2. If the 6 Target Sheets are not available In SCENE, click the Open Target
PDF button in the toolbar.

3. Select among the DIN/ISO A4 format, or US letter format. Your standard
PDF viewer will open, showing the target PDF sheet.

4. Print at least 6 marker sheets.

On Site Place at least 6 Target sheets on site as follows:

NOTE: We recommend to glue the target sheets on suitable rigid 
plates, especially if On-Site Compensation is done at an outdoor 
location.
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• The target sheets must be placed in a vertical range of -50° to 50° from the
scanner device.

• Distribute the target sheets uniformly over the specified range. At least one
board must be close to the horizon (0°).

• The distance between the target sheets and the scanner must be between
1.5 m to 3 m.

• All target sheets must be vertically aligned.

Laser Scanner Placement

• Mount the laser scanner on a tripod.

• Place tripod and scanner on a stable and plane ground. The tripod must not
move during scanning.

13.4.9 Horizontal Alignment

Figure 13-10 Horizontal Alignment

Horizontally align the scanner tripod as follows: 

• Rotate the tripod of the scanner to point approximately towards the center
of the targets.

• Start scanning and compensation by clicking the button “Scan &
Compensate”

• During the compensation process, the status of progress is displayed. You
can cancel the process if required.

13.4.11 Scan & Compensate 

• Select whether you want to apply the compensation data to the scanner.

• Click disconnect to disconnect from scanner and finish the On-Site
compensation.

• To apply this compensation to the scanner choose „yes“ and click the
Finish button. Choose “no“ if you do not want to apply this compensation.
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• When the compensation is finished, the Compensation Report is displayed
with the results of the compensation. Open the compensation report as
PDF by clicking the button Open Report. The Compensation Report is
saved as PDF to the location specified in the left side of the page.

Figure 13-12 Compensation Report

13.4.13 Troubleshooting

Error

Reading and writing to the selected data output folder failed.

Solution

Make sure that you have sufficient rights to read and write in the selected 
output folder. Ensure that you have sufficient disk space. Approximately 
330MB are necessary to perform an On-Site compensation.

Error

The process did not identify enough targets for compensation.

Solution

In the output folder a targetImage.png file is stored. This image shows the 
identified markers as blue circles. Areas with a sufficient amount of detected 
targets have a green background color. Areas with an insufficient amount of 
detected targets the background color is red.

Error

No consistent solution could be determined.

Solution

Make sure that the tripod and the targets did not moving during the procedure.

Error

The SD card of the scanner could not be accessed.
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Solution

Make sure that the SD card is inserted and that it is not write-protected and 
has sufficient free space left (approximately 330MB).

Error

Communication with the scanner failed.

Solution

Make sure that the WLAN connection to the scanner is stable.

If this error appears when connecting to the scanner or applying the 
compensation parameters, try to repeat the corresponding step.
233
Chapter 13: Scanning



SCENE 2018 User Manual
Chapter 14: FARO Laser Scanner Focus Scanner Administration

The built-in FARO Focus scanner administration functionality of SCENE 
allows you to manage your Focus SD cards, scanner snapshots and your scan 
projects.

You can open the scanner administration of SCENE under View > 
Administration View or in the projects selector by clicking on the Scanner 
Administration icon.

Figure 14-1 Scanner administration

Structure View

Administration view

14.1 Items in the Structure View of the Scanner Administration

14.1.1 Scanner Snapshots

Each time you start a scan on your FARO Focus scanner, it automatically 
saves its current settings to the currently inserted SD card. Thus, a Focus SD 
card not only contains the captured scans but also an automatic snapshot of 
all system settings, scanning parameters, scan profiles, scanner operators 
and scan projects that are currently available on your scanner. When you 
insert a Focus SD card into your computer, it will automatically be recognized 
by SCENE and you will be asked whether to start an automatic data transfer or 
not. Clicking yes will import new scans from the SD card and create a local 
copy of the automatic scanner snapshot. The local copy of this automatic 
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scanner snapshot can be found under the folder Scanners in the Structure 
View of the scanner administration and bears the name of your scanner's 
serial number.

With the scanner administration in SCENE you can also set up new scanner 
snapshots from scratch. These scanner snapshots can be configured 
according to the needs of your scan projects, which means that you can create 
several new snapshots with differing settings, profiles, operators and projects 
according to the needs of different scan projects and transfer their 
configurations to your FARO Focus scanner(s) whenever needed. You can 
find these new scanner snapshots in the Structure View under the folder 
Scanners. 

The Structure View shows the complete file structure of the snapshots. You 
can perform delete commands on the folders and files via their context menu.

SD Cards The folder SD-Cards contains the FARO Focus SD cards that are currently 
inserted to your PC. Here, the complete content of the SD Card is shown. You 
can perform delete commands on the folders and files via their context menu.

Projects The folder Projects contains all scan projects that are already known to 
SCENE. With the help of the scanner administration you can prepare or create 
new projects and transfer them to your FARO Focus (see chapter Transferring 
Firmware Updates to your FARO Focus Scanner on page 240).

14.2 Administration View
With the administration view you can view and modify the scanner settings, 
scan profiles, scanning parameters, projects and scanner operators of all 
available scanner snapshots. If a SD card is inserted to your PC, the 
administration view of the automatically created scanner snapshot is initially 
shown. To open the administration view of another snapshot, double-click the 
respective item under the Scanner or the SD-Cards folder in the Structure 
View or select the administrate command in its context menu. 

Design and functionality of the administration view in SCENE is the same as of 
the user interface that runs on the touch screen of the FARO Focus scanner. 
Refer to the FARO Laser Scanner Focus manual for details about how to 
change the scanner settings, create and edit scan profiles, scanner operators 
and projects.

14.3 Managing Snapshots

14.3.1 Editing the Automatic Scanner Snapshot on the inserted SD Card

When you open the scanner administration in SCENE, the administration view 
of the automatic scanner snapshot of the currently inserted SD card will 
initially be shown. You can also open the administration view of this automatic 
snapshot by selecting the Administrate command in the context menu of the 
SD card. 
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Make your changes in the administration view. Refer to the scanner manual 
for details about how to change the scanner settings and how to create new 
and edit existing scan profiles, scanner operators or projects.

When finished, remove the SD card from your PC and insert it into your 
scanner. For more information, see chapter Transferring a New, Modified or 
Restored Snapshot to Your Scanner on page 238.

14.3.2 Creating a New Scanner Snapshot

To create a new scanner snapshot, right-click the Scanners folder in the 
Structure View and select New > Scanner Snapshot in its context menu. 
SCENE will create a new scanner snapshot and open its administration view. 
Configure the scanner settings and create profiles, projects and scanner 
operators according to your needs.

You can rename the snapshot by selecting the Rename command in its context 
menu. 

You can also create a new snapshot based on the content of an already 
existing snapshot. To do this, create a new scanner snapshot, then select the 
base snapshot and drag it onto your newly created snapshot. Now you have a 
duplicate copy of your original snapshot that can be modified according to 
your needs.

To transfer a newly created snapshot to your scanner, select it in the 
Structure View and drag it to the SD card item under the folder SD-Cards.

When finished, remove the SD card from your PC and insert it into your 
scanner. For more information, see chapter Transferring a New, Modified or 
Restored Snapshot to Your Scanner on page 238.

14.3.3 Restoring and Editing Manually Created Scanner Backups

The FARO Focus scanner allows you to manually create backups of your 
scanner data. You can modify these backups with SCENE and transfer the 
modified configuration data back to your scanner. 

If you have a scanner snapshot that contains manual backups, open the 
administration view of this snapshot in SCENE and go to Manage > Service > 
Restore. You will then get a list that contains all the manually created backups 

NOTE: This will replace the data of your SD card snapshot with 
the data of the new snapshot. The scans on the SD card remain 
unaffected by this operation.
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that are available in the currently administrated snapshot as well as its 
automatically created scanner snapshot.

Figure 14-4 Restore manual backup

Click the backup that you want to restore (_AUTO_BACKUP is the 
automatically created scanner snapshot, _SCENE_BACKUP the snapshot 
that has been modified or created with SCENE) and a new screen will appear.

Figure 14-5 Select restore data
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Select the configuration data that you want to restore from the selected 
backup and press the Restore button.

You can now modify the restored configuration data and transfer it back to 
your scanner. For more information, see Transferring a New, Modified or 
Restored Snapshot to Your Scanner on page 238. 

14.3.6 Restoring the Local Copy of the Automatic Scanner Snapshot

SCENE will create a local copy of the automatic scanner snapshot. This local 
copy bears the serial number of the scanner and can be found in the 
Structure View under Scanners. 

1. Select local copy of your automatic scanner snapshot in the Structure
View.

2. Drag it to the SD card item under the folder SD-Cards.

3. The configuration data on the SD card will be replaced by the configuration
data of the snapshot, the scans on the SD card remain unaffected by this
operation.

4. When finished, transfer it to your scanner.

For more information, see chapter Transferring a New, Modified or Restored 
Snapshot to Your Scanner on page 238. 

14.3.7 Transferring a New, Modified or Restored Snapshot to Your Scanner

1. Insert the SD card with a new, modified or restored snapshot into your
scanner.

You will be asked by the scanner‘s operating software whether to update
the scanner with this snapshot or to keep the current scanner settings.

2. Click yes to transfer the settings from your SD card to the scanner.

You can also transfer your new, modified or restored scanner snapshot later 
using the restore functionality in the scanner's operating software. 

3. Go to Manage > Service > Restore the scanner's operating software.

NOTE: The restored configuration data will override the 
configuration data of the administrated snapshot. For example, if 
you want to restore or import scan profiles, all the existing scan 
profiles of the administrated scanner snapshot will be overridden 
by the profiles of the backup.

NOTE: This will override all current scanner settings, scan profiles 
and scanner operators with the configuration data of the new 
scanner snapshot.
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4. Select the list item _SCENE_BACKUP.

5. Select the data that you want to restore and press the Restore button.

For more information, see the scanner manual.

If you own several scanners and if you want to make sure that they all have 
the same configuration, you can transfer one snapshot to several scanners 
which will then have duplicate configurations.

14.3.8 Managing Scan Projects

The scanner administration in SCENE provides a quick and convenient way to 
prepare your scan projects in advance. Projects prepared with SCENE usually 
represent the spatial distribution of your real scan projects and can be 
transferred to your scanner via the SD card. In the scanner‘s operating 
software, when carrying out the scan project, you can then assign scans to the 
created scan project or one of its subprojects. This information is very helpful 
for the later scans registration and will be used to automatically combine the 
scans to scan clusters. 

Create a new project 1. Right-click the Projects folder in the Structure View of the scanner 
administration.

2. Select New > Project.

You will be asked to give the project a name and to specify its storage 
directory. 

To open an existing project, double-click the project in the Structure View. 

Add subprojects Add new scan folders or clusters to your main cluster 

1. Select New > Scan Folder in its context menu.

Figure 14-9 Workspace with project structure

2. When finished, save the scan project and return to the scanner
administration view.

3. Select your project in the Structure View and drag it onto a snapshot or a
SD card.

This will add the new project with all of its subprojects to the respective
snapshot. Already existing projects will not be deleted. If the added project
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already exists on the snapshot, it will be updated with the changes you 
have made. 

4. Transfer the snapshot with the added project to your scanner.

For more information, see chapter Transferring a New, Modified or Restored 
Snapshot to Your Scanner on page 238. 

14.4 Transferring Firmware Updates to your FARO Focus Scanner

1. Drag and drop the firmware update file from the windows explorer to the SD
card item in the Structure View of the scanner administration.

SCENE will then copy the file to your SD card into the folder Updates. If
this folder does not exist, it will automatically be created.

2. Remove the SD card from your PC and insert it into your scanner.

3. To install the firmware update on your scanner, go to Manage > Service >
Firmware the operating software of the scanner.

4. Press the Update button.

For more information refer to the scanner manual.

14.5 Scanner Service Request
In case of problems with your scanner, you can send a scanner snapshot with 
the current settings of the scanner to the FARO Customer Service that can 
then analyze the snapshot to find the cause of error. 

1. Select Scanner Service Request in the context menu of the respective
scanner snapshot.

Your default email client should start automatically with an open email
window that has the snapshot attached.

2. Send this email with a detailed description of your scanner failure to the
FARO Customer Service.
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Chapter 15: Apps

For developers, SCENE offers an application programming interface (API) 
which gives the opportunity to integrate own functionality into SCENE. This 
API allows anyone to create custom applications (Apps) which integrate 
seamlessly into the SCENE user interface in order to extend the functionality 
of SCENE. Developers are free to share their Apps with others (for free or for 
sale), so that everybody can benefit from them. 

Publicly available apps may be downloaded from the FARO 3D App Center:

http://3d-app-center.faro.com/

The following apps are available by default:

• Orthographic Photo Generator

• WebShare 2Go 2.0

• Forensic Wizard

15.1 Installing and managing apps
You can install and manage apps with the SCENE App Manager.

 Click the Apps button  on the right side of the Global Workflow Bar.

Figure 15-1 Apps toolbar

The Apps Toolbar shows the Apps button, and all the Apps that are 
available.

15.2 App Manager
The SCENE App Manager provides the following functionality:

• It allows installing new apps. For more information, see chapter Installing
and managing apps.

• It gives an overview of the already installed Apps with additional
information, like the version number.

• Already installed apps can be activated, deactivated or removed from the
system. For more information, see chapters Activating / Deactivating Apps or
Updating Apps.
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• Developers can create an app package file (app in installation file) from
their app files (with the Pack App… button that will be displayed when
Developer Options is enabled).

Figure 15-1 App Manager

Use the  button to uninstall an app from your system.

15.3 Installing Apps
To install a SCENE App, do one of the following:

• Click the  button and select an App package file (with the 
extension .fpp) from your hard disk. In the drop down menu of the button 
you will find:

• the possibility to install an App that is not packed to an App package but
whose individual program files are available within a folder on the hard
disk.

• a link to the FARO 3D App Center to download new apps.

• Drag & drop a downloaded App package file into SCENE.

• Double-click an App package file in Windows Explorer.

If the App is already installed you will get an error message and the installation 
will be canceled.

SCENE also checks whether the App is compatible to the current version of 
SCENE. If the App and SCENE are not compatible, the installation will be 
canceled.

After installation is complete, the App will be activated by default.
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15.4 Updating Apps
If you would like to install a new version of an already installed App, remove 
the former version of the App from your system first, and then install the new 
version as described above.

15.5 Activating / Deactivating Apps
Use the Activate checkbox in the App Manager to enable or disable certain 
Apps at runtime.

15.6 Uninstalling Apps

Use the  button to uninstall an App from your system.
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Chapter 16: Advanced Functions

16.1 Coordinates
The coordinates of a point describe its exact location in relation to an agreed 
reference point. This reference point is referred to as the origin of the 
coordinate system. With a scan, you receive points in the three dimensional 
space, therefore, for a precise description of a measured point, you need the 
definition of the origin and three other values which then indicate the relative 
location to this origin. 

Depending on the choice of origin, you can decide between local coordinates 
or global coordinates. The three other values can be set to different degrees, 
so that you obtain polar coordinates or Cartesian coordinates, for example.

16.2 Local Coordinates
When scanning, the position of the scanner emerges as the natural origin of 
the coordinate system because when recording the scan, all position 
specifications of the points are initially recorded in relation to the scanner. This 
coordinate system is therefore described as the local coordinate system.

Polar coordinate 
system

Due to the rotation of the scanner, its natural coordinate system is the polar 
coordinate system, with which two angles and a distance value are used to 
determine the position.

Figure 16-1 Polar coordinates

For the single scan points created by the scanner, you can find the polar 
coordinates in the bottom status bar:

Figure 16-2 Display the polar coordinates of a scan point
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Cartesian 
Coordinates

In day to day use, you would generally use Cartesian coordinates, which have 
a direct reference to concepts such as length, width and height, rather than 
polar coordinates.

Figure 16-3 Cartesian coordinates

The conversion of polar coordinates into Cartesian coordinates occurs 
automatically in SCENE. It is completely independent from the location of the 
scanner or other influencing variables because it simply converts between two 
types of representation at the same level. The converted coordinates are 
displayed directly next to the polar coordinates in the bottom status bar:

Figure 16-4 Display of the Cartesian coordinates of a scan point

16.3 Global Coordinates
If a scan is viewed in its 3D position against another scan, local coordinates 
are no longer practical. If, for example, two scans were recorded at different 
positions, the points within each one can have the same local coordinates; 
they match reality but not one another. 

Therefore, you should relate the coordinates to one reference point which 
remains the same for all scans. This reference point is normally selected so 
that it is also possible to make a comparison using other systems, for example 
a CAD system.

By doing so, you can view polar coordinates and Cartesian coordinates again. 
However, since the polar coordinates do not produce a clearer representation 
than the Cartesian coordinates, you will find no use for them in this 
environment and they are therefore not explained in any more detail here.

Coordinate 
Transformation

You can calculate the global coordinates using the local coordinates of a point 
if you know the relationship between the local and the global coordinate 
system. To do this, you transfer the local coordinates into global coordinates 
by tracing the movement which would make both coordinate systems match. 
You can differentiate between two types of movement:
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If the local origin does not match the global origin, all coordinate specifications 
must be moved by the difference between the local and global origin. This 
movement is also called Translation.

Figure 16-1 Translation

If the orientation of the coordinate axes is different, you must make them 
match with a Rotation.

Figure 16-2 Rotation

The rotation is described by a rotation axis and the corresponding angle of 
rotation. Generally, any rotation can be described with a single rotation axis; 
this rotation axis, however, does not necessarily match one of the coordinate 
axes! It is then sometimes difficult to make this rotation graphically clear. 
However, you can also split the rotation up into three separate rotations 
around the coordinate axes. In this type of representation you can imagine the 
result of a rotation more easily. SCENE saves the rotation internally with a 
single rotation axis and a single angle of rotation; the user interface, however, 
displays the more comprehensible type of representation of the three rotations 
around the coordinate axes.

NOTE: When splitting the rotation into three separate rotations 
around the coordinate axes, it is important to have a defined 
sequence of the axes. If you first rotate around x, then around y, 
and finally around z with some specific angles of rotation, you get 
different results than you would get with the sequence x, z, y.
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Figure 16-3 Rotation of 90° around y and then 90° around z

Figure 16-4 Rotation of 90° around z and then 90° around y

In the user interface, SCENE uses the sequence x-y-z.

If you want to fine-tune a rotation on a per-axis basis, this default sequence 
may lead to some unexpected behavior. For example if you want to place an 
object interactively and you are so far satisfied with the orientation around the 
x axis and the z axis. Now you want to adjust the orientation around the y axis 
– but when you change the corresponding rotation angle, the object seems to
move around a totally different axis! This is simply caused by the fact that the
rotation around the y axis is applied in the middle of the two other rotations. A
more intuitive behavior is achieved when the rotation is last in the sequence.
You can enforce this more appropriate sequence, when you select Axis snap
in the dialog.

Local coordinates can always be transferred into global coordinates with a 
simple combination of these two basic movements: translation and rotation. 
This transfer is also called Transformation. The sequence in which the basic 
movements are executed is important because it makes a big difference 
whether you first move and then rotate or first rotate and then move. In 
SCENE the rotation takes place first and then the translation.

Coordinate 
Transformation of a 
Scan

In order to know the coordinate transformation of a scan, you must know its 
position and orientation. You can see these values if you click the scan with 
the right mouse button in the Structure View and select Properties in the 
context menu.
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On the Scan tab, the position and orientation are displayed in compact 
notation with a single angle of rotation.

Figure 16-5 Orientation displayed compactly
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On the Transformation tab, you will see the same information displayed in a 
more intuitive way.

Figure 16-6 Orientation displayed more intuitively

Of course, coordinate transformations can not only be applied to local 
coordinates but can also be used to convert from one global coordinate 
system to another. For example, you could use a hall coordinate system as 
the first coordinate system, which has the origin in the corner of a hall and 
whose axes run along the walls of the hall. On a greater scale, you could 
define a plant coordinate system whose origin lies in the south-west corner of 
the plant premises and whose axes match the four points of a compass.

Figure 16-7 Hierarchical transformations

Then you only have to describe the transformation between the hall and the 
plant premises to automatically obtain all the coordinate specifications within 
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the hall in plant coordinates. SCENE proceeds hierarchically from inside to 
outside: first, the local coordinates within the scan are transformed into hall 
coordinates and these are then converted into plant.

The position of the scan is not only stored in the Workspace and its 
corresponding file .fws, but also in the scan file itself. When using hierarchical 
transformations, you should note that the scan file only stores the local 
transformation, not the global. In the example above, this means that the scan 
file only contains the relative position to the hall, not to the plant.

Transformation and 
Registration

Registration of scans is always performed in the global coordinate system. If 
you have added transformations in the scan folders, these transformations will 
of course also be used during the registration. The result might not be the one 
you expected: the scans will be positioned on the same global coordinates as 
they would have without the additional transformations! Only their local 
coordinates may differ.

If you want to add a transformation because you don’t want to use the 
coordinate system of the surveyor, you should input it into the References 
folder.

16.3.8 Quick Change of Global Origin

For some tasks it might be helpful to use a different coordinate system than it 
is currently defined globally. But as not all tasks need this specific coordinate 
system, it should be possible to switch between such coordinate systems 
easily. For example imagine the examination of a robot cell in a plant. The 
global coordinate system might be defined according to the plant, but now you 
would like to export scan points in the local coordinate system of the robot cell. 
In this case you would like to switch to the local coordinate system of the robot 
cell temporarily, and later switch back again. For this you need the position 
and orientation of the robot cell within the plant and you put this transformation 
in a folder, and the mark this folder to be used as definition for the global 
coordinate system.

When you want to work in the local coordinate system of a folder (or scans 
folder or scan), you activate its transformation by Operations > Global System 
> Set as Global Origin in its context menu. The folder is now marked with a red

G  to indicate that it is currently defining the global coordinate system.

If you want to switch back to the original global origin, you may select 
Operations > Global System > Clear Global Origin in the context menu of this 
folder. In addition, this function is also available in the context menu of the 
Workspace.

16.4 Exemplary Driver Configuration for the Stereoscopic Mode
This chapter describes how to enable OpenGL Stereo for an exemplary 
hardware and driver configuration. Enabling OpenGL Stereo on comparable 
configurations should be similar. The stereoscopic mode will most likely run 
with other driver versions, too. However, the menu structure may look different 
than described here.

Exemplary hardware and driver configuration used for this description:
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• Hardware

• NVIDIA Quadro Graphic Card

• NVIDIA 3D Vision (Shutter Glasses)

• 120 Hz Monitor

• Compatible cable (HDMI 1.4 or Dual Link DVI)

• Driver

• NVIDIA Quadro/NVIDIA Tesla Driver (Release 295.73)

Follow these steps to configure your system:

• Enable OpenGL quad buffering:

• Open the NVIDIA system control. For Windows 7: right-click the Desktop
and choose NVIDIA system control in the context menu.

• In the NVIDIA system control tool

• select Manage 3D Settings the structure tree on the left.
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• In the pane that is shown on the right set 3D OpenGL Stereo as global
preset under global settings.

Figure 16-1 Enabling OpenGL quad buffering

1. Set the 120 Hz Monitor as the primary output device (only when using
multiple displays):

• Select Set up multiple displays in the structure tree on the left. In the
pane that is shown on the right, right-click the 3D monitor and select
Make this in the Windows main display.
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Figure 16-2 Select primary display

2. Ensure that the monitor refresh rate is set to 120 Hz.

• Select Change resolution in the structure tree.

• Select the 3D monitor and then choose 120 Hz in the refresh rate drop
down box. The refresh rate of 120 Hz is not available for some
resolutions. If the refresh rate is not available for any resolution, the
display was not recognized as a 3D display. In this case refer to the
manual of the display.

Figure 16-3 Select primary display

3. Activate NVIDIA vision.

• Switch on the shutter glasses by pressing the button on its left temple.

16.5 3DConnexion 3D Mouse Support
3DConnexion is a manufacturer of 3D mice for navigating and manipulating 
3D content. The 3DConnexion 3D mice are supported by SCENE. Compared 
to the use of traditional mice and keyboards, such a 3D mouse may make 
navigation in your 3D data much more intuitive and controllable.

Gently push, pull, twist or tilt the Controller Cap of the 3D mouse to pan, zoom 
and rotate in your 3D data. Increase pressure to go faster or decrease 
pressure to make intricate adjustments.

When operating the Controller Cap, the 3D mouse acknowledges the selected 
camera mode. In fly mode, for example, you can rotate the camera by twisting 
the cap. In camera pan mode, twisting it has no effect since only left-right and 
up-down movements of the cap are recognized. When a 3D View tool such as 
the measurement tool is selected, the 3D mouse operates in the examine 
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mode. You can also use the 3D mouse to rotate and zoom in the Quick View 
and to pan and zoom in the Planar View.

16.5.1 Predefined Commands

If the 3DConnexion Add-in for SCENE has been installed with the driver of the 
3D mouse, the following assignment of keys will be available (the number of 
available buttons varies with the available 3D mouse model):

• Fit: Move the camera to show the whole SCENE in the 3D View; return to
the initial zoom level in the Quick View and Planar View.

• Menu: Open the settings menu of the 3D mouse.

• T: Display the top view.

• B: Display the bottom view.

• L: Display the left view.

• R: Display the right view.

• F: Display the front view.

• Bk: Display the back view.

• Rot: Toggle rotation on/off.

• Pan Zoom: Toggle pan and zoom on/off.

Optionally, the following commands can be assigned to the function keys from 
1 to 10 with the 3Dconnexion settings tool (this tool is accessible from the 
Windows start menu or the task bar. See the manual of the 3DConnexion 
mouse for more information).

• Switch to fly mode.

• Switch to examine mode.

• Switch to walk mode.

• Switch to camera pan mode.

• Set the rotation point automatically during movement.

• Set the rotation point automatically after movement.

• Don’t set the rotation point automatically.

• Show the rotation point always.

• Show the rotation point during movement.

• Hide the rotation point.

NOTE: When using a 3DConnexion Mouse, make sure to always 
use the latest drivers. They can be downloaded from 
www.3dconnexion.com.

Refer to the 3DConnexion documentation for more information on 
installing and setting up the 3D mouse.
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16.5.2 Adjusting the 3D Mouse Behavior

To adjust the behavior of the 3D mouse and to access further functions, open 
the settings menu with the Menu button on the 3D mouse.

Figure 16-3 3DConnexion Mouse – Settings

Rotate – Switch the rotation capability on or off.

Pan and Zoom –Switch the pan and zoom capability on or off.

Disable Rolling – Switch the roll axis on or off.

Invert 3D Mouse in Examine Mode – Invert all axes in the examine mode.

Invert 3D Mouse in Quick View – Invert all axes in the Quick View.

Speed – Set the speed of movement.

Fly Mode – Switch to fly mode.

Examine Mode – Switch to the examine mode.

Walk Mode – Switch to walk mode.

Camera Pan Mode – Switch to camera pan mode.

Rotation Point – Adjust the behavior of the rotation point. For more 
information, see Navigation Toolbar (3D View only) on page 32.
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Chapter 17: Reference Handbook

17.1 Hotkeys

Key(s) Function

Ctrl + O Open Workspace

Ctrl + N Create new scan project

Ctrl + F Find and locate objects workspace

3D View (general)

B Toggle between Walk- and Fly mode

Space
Toggle between Fly mode and Examine 
mode

Ctrl-Key (hold down)
Temporarily use Examine mode when 
another navigation mode is active

Middle mouse button (hold Down) Temporarily use pan mode

Shift + X Fly to point

Q, E Roll camera left, right

Page Up / R
Page Down / F

Move up
Move down

+ / - Zoom or out

Shift + middle mouse button 
(click):

Set the rotation point

P
Toggle between perspective camera and 
orthogonal camera

V Remove camera rolling

C Toggle Clear View

T Align camera to surface normal

X Move Camera to 3D point

Alt + P Save screenshot of current 3D View

Backspace Go back to previous camera position

1, 2, 3, 4 Point size 1, 2, 3, and adaptive point size (4)

Ctrl + A
Select all points (only the points of scan 
point clouds or the project point cloud)

Ctrl + D
Dismiss the current scan point selection 
(only for point selections of the scan point 
cloud or the project point cloud)

Ctrl + F2 Create new viewpoint

F2 Go to next viewpoint

Shift + F2 Go to previous viewpoint
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3D View (fly mode)

Arrow Keys
W, A, S, D
8, 4, 3, 6 (on numeric key pad)

Move camera forward, left, backwards, right

I, J, K, L
Rotate camera upwards, left, downwards, 
right

3D View (examine mode)

Arrow Keys
W, A, S, D
8, 4, 3, 6 (on numeric key pad)

Move camera backwards (object away), 
right (objects left), forward (objects closer), 
left (objects right)

I, J, K, L

Rotate camera downwards (move towards 
top view of object), counter clockwise (object 
clockwise), upwards (move towards bottom 
view of object), clockwise (object counter 
clockwise)
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17.2 Symbols the Structure Window
Symbol Meaning

Project Folder

Cluster

Scan

Virtual scan

Point

Sphere

Plane, Rectangle

Slab

Pipe

Line

Mesh, Imported object

Documentation

Region

Clipping box

View point

Picture

Overview map

Fit

Scans and Cluster

Fully loaded

Reference scan or cluster 

Fixed scan or cluster

Locked Scan Manager 

Global Origin

Missing file

Freestyle3D: Not processed completely

Freestyle3D: Recoding finished. Some single frames 
unloaded because of low memory.

Freestyle3D: Post processing done
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17.3 Context Menus

17.3.1 3D View 

Selection

Delete Selected Points – deletes the selection.

Invert Selection – the objects around the selection get marked, and the 
selection itself gets canceled.

Dismiss Selection – cancels the selection. 

Export Selected Points – exports the selection as a new scan.

Visibility... – Opens the Visibility dialog.

Freestyle3D: Reduced quality because of low machine 
performance

Freestyle3D: Capture or Replay

Freestyle3D: Next step is Replay

Freestyle3D: Next step is Optimize Scans

Freestyle3D: Next step is Color Smoothing

Freestyle3D: Next step is Stray Point Filter

Freestyle3D: Next step is Point Cloud Creation

Fitting

Active fit

Outdated active fit

Good quality

Compromised quality

Seriously compromised quality

Registration

Ignored for Place Scans

Object with automatically found correspondence

Object with user forced correspondences

Global Origin
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17.3.2 Clipping Box

Visible – Turn visibility of the boundaries of the Clipping Box on or off.

Locate – Displays the selected object the center and enlarged of the active 
view.

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Hide Exterior – Hide the points that are outside of the Clipping Box.

Hide interior – Hide the points that are inside of the Clipping Box.

Delete visible points of all active clipping boxes: All visible points of all active 
Clipping Boxes will be deleted, no matter if they are insides or outsides the 
Clipping Boxes.

Delete invisible points of all active clipping boxes: All invisible points of all 
active Clipping Boxes will be deleted, no matter if they are insides or outsides 
the Clipping Boxes.

Export 3D Selection using active Clipping Boxes – Creates a selection of scan 
points on the basis of the active Clipping Boxes and exports those points.

Create Clipping Boxes along an axis – Creates multiple Clipping Boxes along 
one of the three axes of the selected Clipping Box.

Properties... – Opens the properties dialog.

17.3.3 Planar View and Quick View

Visible – Make the selected object visible or invisible.

View – Open the scan a new view; either as 3D View, Quick View (available 
Planar View) or Planar View (available Quick View).

Locate – Display the selected object the center and enlarged the active view.

Scan Points – Apply filters to the scan or create a new scan from the scan.

Find Objects – automatically detect certain types of objects in the scan.

Export – 

Direct Export – Exports the scan point with the of the last export.

Export Scan points... – Export the scan points of the scan.

Delete – Deletes the selected object.

Properties... – Opens the properties dialog.

17.3.4 Planar View or Quick View – Point Selection

View – Opens a 3D View of the selected scan points.
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Scan Points

Figure 17-5 Context menu: Point selection > Scan Points

Filter – 

Stray... –to remove scan points resulting from hitting two objects with the 
laser spot or by hitting no object at all, for example the sky.

Distance Based... – to remove scan points a certain distance range from the 
scanner.

Dark Scan Points... – to remove scan points with too much noise.

Smooth... – to minimize noise on surfaces.

Delete – Delete all scan points of the current selection.

Push/Pull

Push – All scan points of a selection which are situated between Minimal 
Distance and Maximal Distance, are moved away from the scanner position 
(being the origin of the local coordinate system of the scan). Pull – All scan 
points of a selection which are situated between Minimal Distance and 
Maximal Distance, are moved towards the scanner position (being the 
origin of the local coordinate system of the scan). Create Scan – Create a 
new scan from the selected scan points.

Apply Pictures – Apply pictures to the selection of scan points only. 

Find Objects – Automatically detect checkerboards, spheres, planes, corner 
points, rectangles or lines the selected scan points.

Create Objects – Manually fit object from the selected scan points.

Sphere – Perform a sphere fit on the selected scan points. 

Sphere Radius – Perform a sphere fit with known radius on the selected 
scan points.

Plane – Perform a plane fit on the selected scan points.

Slab – Perform a slab fit on the selected scan points

Expand Plane – Starting with the selected scan points, perform an 
automatic plane expansion.

Mean Point – Determine the mean point of the selected scan points.

Contrast Mean Point – Create a contrast mean point of the selected scan 
points. Usually used for circular flat targets.

Line – Create Lines.

Pipe – Create a pipe.
261
Chapter 17: Reference Handbook



SCENE 2018 User Manual
Mesh – Create a mesh

Region – Create a region.

Delete Objects – Delete all objects within the selection.

Export – Export the scan points of the selection.

17.3.6 Picture

Locate – Displays the selected object the center and enlarged of the active 
view.

View – Opens a new Planar View of the picture.

Operations

Correspondences > Delete Correspondences

Global System > Set as Global Origin

Select to work the local coordinate system of the picture. The picture is 
now marked with a red G to indicate that it is currently defining the global 
coordinate system.

Import/Export

Export Objects – Exports all objects under the picture.

Export Picture – Exports the picture its original format or JPEG format.

Exchange Picture – Replaces the picture with an imported one.

Apply – Apply the color information of the picture onto the scan. Position, 
orientation, and zoom factor of the camera are already known. This command 
is only available if the pictures reside inside a scan.

Undistort – Remove any so-called barrel or pin-cushion distortions from the 
picture. The distortion parameters have to reside inside the picture.

Colorize Scan – Use the color information of the picture onto the scan. 
Position, orientation, and zoom factor of the camera are not yet known and 
have to be calculated with pairs of matching points. This command is only 
available if the pictures reside inside a scan.

Properties... – Opens the properties dialog.

17.3.7 Plane

Locate – Displays the selected object the center and enlarged of the active 
view.

New

Reference on Folder Level – Place a copy of the selected object the 
reference objects folder of the current scan. The copy does not have any 
link to a fit object that may exist.

Reference on Workspace Level – Place a copy of the selected object the 
reference objects folder of the workspace. The copy does not have any link 
to a fit object that may exist.
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Intersection Point – Creates an intersection point on the plane at the spot 
determined by the mouse pointer.

Plane with Border – Creates a new limited plane with border lines from the 
point selection that was used to create the selected plane.

Slab By Plane – Creates a slab from the plane.

Aligned Clipping Box – Creates a new Clipping Box aligned to the selected 
plane.

Documentation – Attach a documentation object to the selected object.

View > 3D View – View the selected object 3D View.

Visible – Make the selected object visible or invisible.

Operations > Correspondences > Delete Correspondences – Deletes the 
correspondences of the selected object. You can select to delete user forced, 
system found or anti-correspondences. 

Alignment – modifies the overall orientation of the entire workspace according 
to the desired alignment of the plane to a cardinal direction (north, south, east, 
west, ceiling, ground or custom).

Flip – turns the plane’s Normal for 180 degrees.

Export… – Exports the selected object.

Delete – Deletes the selected object.

Properties... – Opens the properties dialog.

17.3.8 Limited Plane

Locate – Displays the selected object the center and enlarged of the active 
view.

New

Reference on Folder Level – Place a copy of the selected object the 
reference objects folder of the current scan. The copy does not have any 
link to a fit object that may exist.

Reference on Workspace Level – Place a copy of the selected object the 
reference objects folder of the workspace. The copy does not have any link 
to a fit object that may exist.

Documentation – Attach a documentation object to the selected object.

View > 3D View – View the selected object 3D View.

View Scan Point Distance – Deviations from a level surface relation to

a plane are highlighted color.

Operations > Correspondences > Delete Correspondences – Deletes the 
correspondences of the selected object. You can select to delete user forced, 
system found or anti-correspondences. 

View Scan Point Distance – Analyze the evenness of the surface. Deviations of 
the scan points from the plane will be highlighted different colors. 

Export… – Exports the selected object.
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Set Border from Selection – The border line of the plane is replaced by the 
border line of the selection. 

Delete – Deletes the selected object.

Rename – Renames the selected object.

17.3.9 Plane Fit

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Flip – turns the plane’s Normal for 180 degrees.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.10 Constrained Plane Fit

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.11 Sphere

Locate – Displays the selected object the center and enlarged of the active 
view.

New

Reference on Folder Level – Place a copy of the selected object the 
reference objects folder of the current scan. The copy does not have any 
link to a fit object that may exist.
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Reference on Workspace Level – Place a copy of the selected object the 
reference objects folder of the workspace. The copy does not have any link 
to a fit object that may exist.

Fit – Only available if a selection of scan points exists. Creates a new fit 
from the selected scan points. Both the sphere position and the sphere 
radius are ascertained from the scan points.

Fit (fixed radius) – Only available if a selection of scan points exists. 
Creates a new fit from the selected scan points with a fixed preset sphere 
radius. The sphere position is ascertained from the scan points.

View > 3D View – View the selected object 3D View.

Operations > Correspondences > Delete Correspondences – Deletes the 
correspondences of the selected object. You can select to delete user forced, 
system found or anti-correspondences.

Update Fit – Recalculates the fit of the sphere.

Export... – 

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.12 Sphere Fit

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.13 Region

New 

Reference on Folder Level – Place a copy of the selected object the 
reference objects folder of the current scan. The copy does not have any 
link to a fit object that may exist.

Reference on Workspace Level – Place a copy of the selected object the 
reference objects folder of the workspace. The copy does not have any link 
to a fit object that may exist.

Documentation – Attach a documentation object to the selected object.
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Select – The selection that was used to create the region is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection.

Import/Export – Export the region as object.

Delete – Delete the region object. The scan points are not deleted.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.14 Point

Locate – Displays the selected object the center and enlarged of the active 
view.

New 

Reference on Folder Level – Place a copy of the selected object the 
reference objects folder of the current scan. The copy does not have any 
link to a fit object that may exist.

Reference on Workspace Level – Place a copy of the selected object the 
reference objects folder of the workspace. The copy does not have any link 
to a fit object that may exist.

Documentation – Attach a documentation object to the selected object.

View – Opens a new 3D View of the point.

Set Rotation Point – Sets the rotation point to the center of the scan point.

Visible – Make the selected object visible or invisible.

Operations > Correspondences > Delete Correspondences – Deletes the 
correspondences of the selected object. You can select to delete user forced, 
system found or anti-correspondences.

Export… – Exports the selected object.

Delete – Deletes the selected object.

Properties – Opens the properties dialog.

17.3.15 Point Fit

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.
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Properties – Opens the properties dialog.

17.3.16 Pipe

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.17 Pipe Fit

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.18 Line

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.
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Properties – Opens the properties dialog.

17.3.19 Line Fit

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.20 Rectangle

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.21 Rectangle Fit

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.
268
Chapter 17: Reference Handbook



SCENE 2018 User Manual
Properties – Opens the properties dialog.

17.3.22 Scan

Visible – Make the selected object visible or invisible.

View 

3D View – View the scan 3D View.

Planar – View the scan Planar View.

Quick – View the scan Quick View.

Locate – Resumes the initial perspective of the view. 3D View the rotation 
point will be set to the position of the scanner.

Loaded – Loads the scan points of the scan. Here a check mark shows 
whether the scan points of a scan are loaded.

Process Scan – Opens the Configure Processing page to configure the 
settings for processing and start processing. 

Point Cloud – Create or delete a Scan Point Cloud from the scans within the 
scan folder or cluster.

Create Scan Point Cloud – Create a Scan Point Cloud from the scans within 
the scan folder or cluster.

Delete Scan Point Cloud – Delete a Scan Point Cloud from the scans within 
the scan folder or cluster.

Export

Image – Obtains an overview image from the scan points and saves it the 
file system the same folder as the scans.

Objects – Export the objects of this scan.

Scan Points – 

• Export Scans – unordered to export the scan points of the selected scan.

• Export Scan Point Clouds – ordered to export the point cloud of the
selected scan.

As Project – Create a new SCENE project, or a new ReCap project. A 
dialog opens in which you can select the export format, a file name, and 
the location in which the new project shall be saved.

Delete – Deletes the scan from the workspace. The associated file is not 
deleted.

Properties – Opens the properties dialog.

for unprocessed 
Freestyle3D scans

Operations > Registration

Level

NOTE: When exporting a ReCap Cluster Project, SCENE creates 
a temporary SCENE project in the TEMP folder. This may require 
a large amount of disk space.
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• by picking one point, if the plane has an even surface.

• by picking three points, if the plane is uneven, or if you need a high
accuracy.

Process the scan – Processes the steps Replay, Optimize Scans, Color 
Adjustment, and Stray Point Filtering.

Global System > Set as Global Origin – Select to work the local coordinate 
system of the scan. The scan will be marked with a red G to indicate that it is 
currently defining the Global Coordinates system.

Split Scan – see Freestyle3D user manual.

Create virtual scans – creates one or several virtual scans from a scan. Virtual 

scans are required if you want to export Freestyle3D scan projects to SCENE 
WebShare Cloud.

for processed 
Freestyle3D scans

Operations > Registration

Level

• by picking one point, if the plane has an even surface.

• by picking three points, if the plane is uneven, or if you need a high
accuracy.

Fixed Scan – Mark the scan alignment as fixed and exclude it from further 
automatic registration attempts.

Reference Scan – Set the scan as reference scan. 

Find Objects – Detect Checker boards, spheres, planes, corner points, 
rectangles or lines the scan.

Filter – Apply filters to the scan.

Preprocessing > Preprocess Scan – Opens the preprocess menu dialog. With 
the preprocess option you may apply a series of processing steps such as 
filters, automatic object detection or scan registration to the scan. The scan is 
automatically loaded, processed, saved and unloaded again.

Correspondences > Delete Correspondences – Deletes the correspondences 
of the scan and of its objects. You can select to delete user forced, system 
found or anti-correspondences. 

Preprocessing > Preprocess Scan – Opens the preprocess menu dialog. With 
the preprocess option you may apply a series of processing steps such as 
filters, automatic object detection or scan registration to the scan. The scan is 
automatically loaded, processed, saved and unloaded again.

Correspondences > Delete Correspondences – Deletes the correspondences 
of the scan and of its objects. You can select to delete user forced, system 

NOTE: Refer to the Freestyle3D User Manual for detailed 
information.
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found or anti-correspondences.Delete inactive Fits – Deletes all inactive fit 
objects.

Color/Pictures

Apply Pictures – Apply the color information of the picture onto the scan. 
Position, orientation, and zoom factor of the camera are already known. 
This command is only available if the pictures reside inside a scan.

Adjust Picture Angles – Adjust the picture angles.

Export All Pictures – Exports all pictures of the scan (if the scan has been 
recorded color). Opens a dialog to select the storage location and the 
export format of the pictures. You can select between “Original format” and 
“jpg”. “Original Format” will export the pictures without changing their 
format; “jpg” will convert the pictures and save them as JPG.

Import All Pictures – Opens a dialog to select the storage location of the 
pictures you want to import. This option is only available for scans which 
already contain pictures.

Color Contrast Filter – Enhances the dynamic range of the color pictures.

Restore Grey Image – Remove the color information and restore the original 
reflectance values.

Replace Color Overlay – Import a manually edited picture in order to 
replace the scan’s initial color overlay with this picture. See chapter for 
more information.

Export Color Overlay – Export the scan's color overlay as a picture to your 
local hard drive. 

Point Cloud Tools – Create a scan point cloud from the scan or delete an 
existing scan point cloud. 

Global System > Set as Global Origin – Select to work the local coordinate 
system of the scan. The scan will be marked with a red G to indicate that it 
is currently defining the Global Coordinates system.

Split Scan – see Freestyle3D user manual.

Create virtual scans – creates one or several virtual scans from a scan. 

Virtual scans are required if you want to export Freestyle3D scan projects to 
SCENE WebShare Cloud.

Import / Export

Export Objects – Export the objects of this scan.

Export Scan Points – Export the scan points of the selected scan. This 
applies to the points of the scan only and does not export the scan points of 
any possible scan point cloud.

Export Scan Point Cloud – Export the scan point cloud of the scan.
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Export as Project – Create a new SCENE project, or a new ReCap project. 
A dialog opens in which you can select the export format, a file name, and 
the location in which the new project shall be saved. 

Export Image – Obtains an overview image from the scan points and saves 
it the file system the same folder as the scans.

Export Compensation – Write compensation data to a file. 

Export Scan Parameters – Export the parameters of the scan.

Import Compensation – Import compensation file and use immediately. You 
may not be able to import a compensation if the scan points were changed 
by a filter beforehand and have not been saved again. 

Save Objects Scan – Save the objects of the scan the scan file.

Delete – Deletes the scan from the workspace. The associated file is not 
deleted. 

17.3.23 Scan Fit

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object. 

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.24 Scans Folder / Cluster

Visible – Make the selected object visible or invisible.

View – Open the scans and objects of the scan folder, the Correspondence 
View, the 3D View or the Structure View.

Locate – Resumes the initial perspective of the view. 3D View the rotation 
point will be set to the position of the scanner.

Loaded – Loads the scan points of the scan. Here a check mark shows 
whether the scan points of a scan are loaded.

Process Scan – Opens the Configure Processing page to configure the for 
processing and start processing.

Point Cloud – Create or delete a Scan Point Cloud from the scans within the 
scan folder or cluster.

Create Scan Point Cloud – Create a Scan Point Cloud from the scans within 
the scan folder or cluster.

Delete Scan Point Cloud – Delete a Scan Point Cloud from the scans within 
the scan folder or cluster.

NOTE: When exporting a ReCap Cluster Project, SCENE creates 
a temporary SCENE project in the TEMP folder. This may require 
a large amount of disk space
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New – Create a new Cluster within the scan folder. 

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

Export

Scans – 

• Export Scans – ordered to export the scan points of the selected scan.

• Export Scan Point Clouds – unordered to export the point cloud of the
selected scan.

As Project – Create a new SCENE project, or a new ReCap project. A 
dialog opens in which you can select the export format, a file name, and 
the location where the new project shall be saved. 

Images – Obtains panorama images of the Planar View of each scan and 
saves these images the file system the same folder as the scans.

Delete – Deletes the scan folder and all the scans it from the workspace. The 
files belonging to the scans are not deleted.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.25 Scan Manager

Update Scans – Updates the registration of the scans managed by this Scan 
Manager. To see the results of the update you must open a new Scan 
Manager window.

Lock – as soon you finished your work with this cluster, you can lock its Scan 
Manager. 

Lock all – locks the Scan Manager of the cluster and the Scan Managers of 
subordinated clusters.

Unlock – unlocks a locked Scan Manager.Unlock All – unlocks the Scan 
Manager of the cluster and the Scan Managers of subordinated clusters. 

Delete – Deletes the Scan Manager.

Rename – Renames the Scan Manager.

Properties – Opens the Scan Manager.

17.3.26 Virtual Scan (3D Picture) 

The virtual scan is treated as a normal laser scan.

Visible – Make the selected object visible or invisible.

NOTE: When exporting a ReCap Cluster Project, SCENE creates 
a temporary SCENE project in the TEMP folder. This may require 
a large amount of disk space.
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View > 3D View – View the scan 3D View.

Locate – Resumes the initial perspective of the view. 3D View the rotation 
point will be set to the position of the scanner.

Export

Image – Obtains an overview image from the scan points and saves it the 
file system the same folder as the scans.

Objects – Export the objects of this scan.

Scan Points – Export the scan points of the selected scan. This applies to 
the points of the scan only and does not export the scan points of any 
possible scan point cloud.

As Project – Create a new SCENE project, or a new ReCap project. A 
dialog opens in which you can select the export format, a file name, and 
the location where the new project shall be saved. 

Delete – Deletes the scan from the workspace. The associated file is not 
deleted.

Properties – Opens the properties dialog.

17.3.27 3D Picture Fit (Fit of a Virtual Scan) 

Select – The selection that was used to create the fit object is reactivated. The 
selection combination mode determines how the new selection results from 
the existing selection and the reactivated selection. 

Active – A black check mark indicates whether this fit object is the active fit 
object of the corresponding object, i.e., whether it is the one that determined 
the properties of the corresponding object. An object can have several fit 
objects, of which one at the most can be active. 

Update – Recalculates the object parameters. The basis for this is again the 
selection that was also used to create the fit object.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.3.28 Workspace

New – Create a new Point, Sphere, Checkerboard, Circular Flat Target, Corner 
Point, Plane, Slab, Documentation Object, Folder or Scan Folder the 
Workspace.

View

3D View – Opens a 3D View with all the loaded scans and CAD models. 
Unloaded Scans are not loaded automatically.

NOTE: When exporting a ReCap Cluster Project, SCENE creates 
a temporary SCENE project in the TEMP folder. This may require 
a large amount of disk space.
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SCENE WebShare Cloud view – Opens SCENE WebShare Cloud. The 
workspace will only be displayed SCENE WebShare Cloud if it already has 
been exported as a SCENE WebShare Cloud project.

Structure View – opens a Structure View of the workspace.

Operations

Figure 17-29 Context menu: Scans > Operations

Registration

Figure 17-30 Context menu: Scans > Operations> Registration

Cluster – Set scan folder as cluster.

Reference Cluster – Set scan folder as reference cluster.

Fixed Cluster – Mark the cluster alignment as fixed and exclude it from 
further automatic registration attempts.

Place Scans – Places scans within this cluster (and its sub clusters). This 
does not register the cluster itself. 

Correspondence View – Opens the Correspondence View.

Create References From Workspace References – Copies all references of 
the workspace to this cluster.

Move Clusters to Center of Scans – Moves the center of the cluster and its 
sub clusters to the center of their scans. This does not change the global 
position of the scans. This function is especially useful when working with 
large coordinates.

Check GPS Consistency – Check which GPS positions will not be used for 
the registration as they are too far away from the GPS reference position.

Disband All Clusters – This function will recursively move the contents of all 
sub folders to the cluster it was applied on and will remove the (empty) sub 
clusters to flatten the hierarchy. This function is useful to clean up the 
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project after having finished the registration, especially if auto clustering 
lead to deep project hierarchies.

Correspondences

Figure 17-31 Context menu: Scan folder  Operations  Correspondences

Delete Correspondences – Deletes correspondences of the scan folder, its 
scans and of all objects that belong to its scans. You can select to delete 
user forced, system forced, system found or anti-correspondences.

Force Current – Force all already existing correspondences of the scan 
folder.

Force by Manual Target Names – Forces correspondences by manually 
created reference name.

Preprocessing > Preprocess Scans – Opens the preprocess menu dialog. With 
the preprocess option you may apply a series of processing steps such as 
filters, automatic object detection or scan registration to the scans of the scan 
folder. The scans are automatically processed and saved.

Color/Pictures – Apply the pictures to all the scans within the folder or apply 
the color contrast filter.

Delete inactive Fits – Deletes all the inactive Scan Fits.

Global System > Set as Global Origin – Select to work the local coordinate 

system of the scan folder. The scan folder is now marked with a red G  to 
indicate that it is currently defining the global coordinate system. 

Import/Export

Export Objects – Export objects. Note, scans need not to be loaded and are 
therefore not loaded automatically.

Export Project – Exports the entire scan project. Select, if the new scan 
project will be used SCENE or ReCap. Then, select the target location and 
a project name. 

Export Images – Obtains panorama images of the Planar View from all the 
scans in the workspace. The scans are loaded one after the other, the 
panorama image is created, then saved and then unloaded again.

Export Positions –Saves the position specifications of all scans and 
reference objects.

Assemble Meshes – 

Delete – Deletes the fit object.

Rename – Renames the fit object.

NOTE: When exporting a ReCap Cluster Project, SCENE creates 
a temporary SCENE project in the TEMP folder. This may require 
a large amount of disk space.
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Properties – Opens the properties dialog.

Visibility

3D Visibility – Opens the dialog with the default visibility for Quick Views 
and 3D Views.

Planar View Visibility – Opens the dialog with the default visibility for the 
Planar View.

Layer Manager – Opens the dialog box of the layer manager.

17.3.32 Viewpoint

Figure 17-33 Context menu: Viewpoint

New – Create a new Point, Sphere, Checkerboard, Circular Flat Target, Corner 
Point, Plane, Slab, Documentation Object, Folder or Scan Folder the 
Workspace.

Activate – Go to the selected viewpoint the current 3D View.

Delete – Deletes the fit object.

Rename – Renames the fit object.

Properties – Opens the properties dialog.

17.4 Properties

17.4.1 Scan Project Workspace

General tab Name – The name of the object. The green traffic light right to the object name 
indicates that corresponding objects have been found other scans. If 
corresponding references have not been found, no traffic light will be 
displayed. 

Layer – The representation layer on which the object is located.

Select active layer – Enters the currently active representation layer.

Assign layer to all contained objects – All the scans of the workspace take on 
the representation layer of the workspace.

Transformation tab Position – The translation portion of the transformation.

X – To key in a transformation in the x direction.

Y – To key in a transformation in the y direction.
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Z – To key in a transformation in the z direction.

Scroll bar – Set the transformation using the mouse. The direction of the 
transformation will be the x, y or z coordinate that is highlighted in yellow.

Each tick increments by – Set the increment for the scroll bar.

Rotation Angle – The angle of rotation if the rotation axis is split along the 
coordinate axes.

X – The angle of rotation around the x axis.

Y – The angle of rotation around the y axis.

Z – The angle of rotation around the z axis.

Scroll bar – Set a new angle of rotation.

To change a value, you can either enter the required value directly into the 
appropriate field, or you first select the field and then use the 
corresponding slider to change the value step by step. You can set the 
increment using the drop-down box. If you hit the edge with the slider, 
simply reselect the field and the slider will return to the center without you 
losing your previous changes.

Axis snap – If checked, you can change the rotation for the current axis 
independently from the others. This is achieved by changing the order in 
which the rotations are applied.

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

GPS Reference tab Define the reference coordinate system by entering the GPS or UTM position.

17.4.2 Scan Folder

General tab Name – The name of the scan folder.

Layer – The representation layer in which the scan folder is located. 

Select active layer – Enters the currently active representation layer. 

Assign layer to all contained objects – All the scans of the scan folder take on 
the representation layer of the scan folder.

Transformation tab Position – The translation portion of the transformation

X – To key a transformation the x direction.

Y – To key a transformation the y direction.

Z – To key a transformation the z direction. 

Scroll bar – Set the transformation using the mouse. The direction of the 
transformation will be the x, y or z coordinate that is highlighted yellow.

Each tick increments by – Set the increment for the scroll bar.

Rotation Angle – The angle of rotation if the rotation axis is split along the 
coordinate axes.

X – The angle of rotation around the x axis.
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Y – The angle of rotation around the y axis.

Z – The angle of rotation around the z axis.

Scroll bar – Set a new angle of rotation.

To change a value, you can either enter the required value directly into the 
appropriate field, or you first select the field and then use the 
corresponding slider to change the value step by step. You can set the 
increment using the drop-down box. If you hit the edge with the slider, 
simply reselect the field and the slider will return to the center without you 
losing your previous changes.

Axis snap – If checked, you can change the rotation for the current axis 
independently from the others. This is achieved by changing the order in 
which the rotations are applied.

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Folder tab Cluster – Determine the scan folder as a cluster. 

Reference Cluster – Determine the cluster as the reference cluster

Fixed Cluster – Mark the cluster alignment as fixed and exclude it from further 
automatic registration attempts. 

17.4.3 Scan Manager

Scan Manager tab Name – The name of the Scan Manager.

Managed by – Name of the super ordinate Scan Manager.

Locked – as soon you finished your work with this cluster, you can lock its 
Scan Manager.

Sub Manager – List of the subordinate Scan Managers. 

The Scan Manager also informs whether external references were used for 
the registration or not.

The traffic lights next to the Scan Managers indicate whether they contain 
good or failed Scan Fits. If a traffic light next to a Scan Manager is red, this 
means that this Scan Manager contains bad Scan Fits. Green means that all 
the quality criteria are met. Amber shows that at least one quality criterion is 

somewhat compromised. If there is a  symbol next to a Scan Manager or a 
Scan Fit, this means that registration could not be executed, maybe because 
of missing references.

If you want to see the critical fits of a subordinate Scan Manager, double-click 
onto this Scan Manager to open it. Switch to the tab Scan Results.

Scan Results tab The tab Scan Results gives you a list of all Scan Fits managed by the Scan 
Manager and shows the overall quality of each registration. This is symbolized 
by a traffic light too. Double-clicking on a fit object the list opens its properties 
dialog.

The average tension of each registration is calculated the Mean Target Tension 
column of this table: the lower the value, the better the registration result. Here 
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you can easily see which registrations failed or which registration results are 
bad (in this example the first two Scan Fits have an amber traffic light, so they 
seem not to be optimal). To identify the critical reference pairs which are 
responsible for the bad fit, you can switch to tab Ref. Tensions.

Correspondence View – opens the Correspondence View with all the scans 
that are managed by the Scan Manager. 

Correspondence Split View – opens the Correspondence Split View.

Target Tensions tab Tab Target Tensions shows all reference pairs used for registration, sorted by 
their tension. 

Tension – describes the discrepancy the global coordinate system between 
the position and the orientation of the two corresponding reference objects 
Scan 1 and Scan 2. With reference points in the distance between the 
positions of the two reference points serves as input for the calculation of the 
tension. With planes, slabs or pipes the position and the direction of the 
objects serve as input for the calculation of this value.

Values close to zero indicate a good registration result. Here, you can easily 
identify reference pairs which are causing problems the registration. Clicking 
on the scan name selects the corresponding reference this scan, double-
clicking opens the reference’s properties.

Weighted Tensions – Global references and inclinometer data have higher 
weightings the registration algorithm. When you activate this option, these 
different weightings will be considered the calculation of the tensions.

Full Hierarchy – When activated, the reference pairs of all Scan Managers will 
be displayed.

Weighted Statistics

Mean – Mean value over all tensions.

Deviation – Deviation over all tensions.

Min. – Minimum tension

Max. – Maximum tension

Scan Point Tensions Tab Scan Point Tensions shows all reference cluster pairs used for the scan 
registration. 

Mean – describes the discrepancy between the two corresponding referenced 
clusters. 

Full Hierarchy – When activated, the reference pairs of all Scan Managers will 
be displayed.

Overall Statistics

Mean – Mean value over all tensions.

<4 mm – Deviation smaller than 4 mm, displayed percent. This value gives 
a quick overview on the overall quality of the registration.
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17.4.4 Scan

Depending on the used scanner type, the scan properties dialog might have 
different tabs. On the following pages the scan properties dialog will be 
described for scans recorded with the FARO Laser Scanner.

General tab Name – Name of the scan. Scans cannot be renamed.

Layer – The representation layer in which the scan is located.

Select active layer – Enters the currently active representation layer.

Assign layer to all contained objects – All the objects of the scan take on the 
representation layer of the scan.

Transformation

See chapter Workspace.

Scan tab Size – The number of columns and rows. If a scan is loaded reduced 
resolution, the reduced number of columns and rows is displayed and, light 
gray underneath, the complete number of columns and rows.

Data loaded –Indicates whether the scan is loaded.

Reference Scan –Indicates whether the scan is used as a reference scan for 
registration.

Scan Fixed – Mark the scan alignment as fixed and exclude it from further 
automatic registration attempts.

Scanner Dist. Range – range of the scanner.

Scanner Position – The position of the scanner with the mirror being the point 
of origin.

Orientation Axis – Rotation axis of the scan.

Orientation Angle – The scan’s angle of rotation.

Recording Date – The time the scan was recorded.

Scan Origin Info – Additional information on the origin of the scan, for example, 
where it was recorded and information about issues (scanner warnings or 
errors) that occurred during recording of the scan.

Info – Further details that were provided when recording.

Scan area tab Selected Profile – The scan profile that was selected for the recording of the 
scan (only available for FARO Focus scanners).

Angular Area – The recorded angular area.

Vertical – The vertical angular area.

Horizontal – The horizontal angular area.

Resolution – The resolution of the scan, measured fractions of the maximum 
resolution.

Quality – The quality setting that was selected for the recording of the scan. 
This setting has influence on the quality respectively on the noise of the scan 
data. The corresponding measurement rate is displayed too (in 1000 points 
per second). 
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Filters

Clear Sky – Checked if the Clear Sky Filter was applied during the recording of 
the scan.

Clear Contour – Checked if Clear Contour Filter was applied during the 
recording of the scan

Scan Size – Number of rows and columns.

Resolution – The resolution of the scan. You can select between:

pt/360°, pt/0°, °/pt, ‚/pt, „/pt, mm/10m,/30ft.

File Size – File size of the scan.

Distance Range – The distance range that was selected for the recording of 
the scan (only available for FARO Focus scanners V7 or greater).

Operation tab This tab is only available for scans taken with the FARO Laser Scanner LS, 
the FARO Laser Scanner Photon or the FARO Laser Scanner Focus.

Name – The name of the project or the order.

Company – The client’s company name.

Division – The client’s or order’s division.

Subdivision – The client’s or order’s sub-division.

Area – The scanned area.

Info – Additional information.

Min. Reflection – The reflection value limit set when recording.

Project tab This tab is only available for scans taken with the FARO Laser Scanner Focus.

This tab shows information about the scan project. This information was given 
before the scan was recorded.

Project Name – The name of the project / or sub-project that was assigned to 
the scan.

Customer –formation about the potential project customer.

Additional information – Additional information provided for the project.

Operator tab The FARO Laser Scanner Focus allows to create operator profiles with 
names, contact details and further information. While scanning, it also allows 
to specify the operator who is currently working with the scanner. This 
information will then be saved in the meta data of the recorded scans and is 
shown on this tab. It might be useful for the person who is post processing the 
scans; especially when there are several scanner operators working on the 
same scan project. 

You can still add or change this information when processing the scans 
SCENE.

Scanner info tab Scanner – The name of the scanner.

Revision – The revision number which is allocated during servicing.
282
Chapter 17: Reference Handbook



SCENE 2018 User Manual
Scanner Type – The type of scanner.

Serial Number – The serial number of the scanner.

Range – The range of the scanner. 

Compensation – The name of the compensation file.

Scanner tab This tab contains some compensation data of the scanner.

Sensors tab Inclinometer

Use – Enable or disable the use of the inclinometer data for registration.

Inclinometer Axis – Shows the up direction of the inclinometer the scan 
system.

Inclinometer Angle – Shows the angle between the z-axis and the 
inclinometer axis the scan system.

Ignore Measurement – Overwrites the inclinometer axis and the angle with 
values that level the scan.

Transformation mismatch – Shows the difference between the z-axis 
defined by the inclinometer and the z-axis defined by the scan’s 
transformation.

Compass

Use – Enable or disable the use of the compass data for the 
correspondence search.

Compass Axis – Shows the orientation of the scan the scan system.

Compass mismatch – Shows the difference between the orientation defined 
by the compass and the orientation defined by the scan’s transformation.

Altimeter

Use – Enable or disable the use of the altimeter data for correspondence 
search.

Measured Height – The height measured by the altimeter of the scanner 
based on a given reference height.

Global Positioning System (GPS) – the values measured by the scanner’s GPS 
sensor.

Position (lat./long.) –GPS position longitude and latitude.

Position (UTM) – GPS position UTM coordinates.

Measured Height – Height above sea level.

Transformation mismatch – Shows the difference between the position 
defined by the GPS data and the position defined by the scan’s 
transformation.

Advanced – Shows the raw data from the GPS sensor.

Place using Sensors – Restores the initial placement of the scan according to 
the measurements of the various sensors.

Camera tab This tab is only available for scans taken with the FARO Laser Scanner LS or 
the FARO Laser Scanner Photon.
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Camera Mount – Type of the camera bracket that has been used for taking a 
colored scan. 

Non-winding is the old, fixed type for scans taken with FARO Photon and 
LS scanners and the type for all scans taken with FARO Focus scanners.

No parallax is the new mount with the sliding mechanism.

No parallax, with pins is the camera mount with the sliding mechanism and 
pins that fit into the bushes on the side of newer FARO Laser Scanners. 
Note that older models of the FARO Laser Scanner are not equipped with 
these bushes.

Camera Orientation – Camera orientation 

Top – The camera was fixed the top position of the mount bracket: 
Therefore the camera was pointing slightly upwards when taking pictures.

Horizontal – The camera was fixed the lower position of the mount bracket 
and therefore oriented horizontally.

Exposure

Manual – Exposure time, exposure index, and f-number is set directly at the 
camera.

By Scanner – The scanner determined a balanced exposure setting.

Correction – Correction factor for the exposure that have been determined 
by the scanner.

Color tab This tab is only available for scans taken with the FARO Laser Scanner Focus.

Scan with Color – Checked if the scan was recorded color.

Exposure Metering Mode – The exposure metering mode used to take the 
color pictures when colored scan recording was switched on:

Even Weighted Metering – The light information coming from the entire 
SCENE without giving special weighting to a particular area was used to 
determine the exposure of the camera.

Horizon Weighted Metering – The light information coming from the horizon 
was used to determine the exposure setting of the camera.

Zenith Weighted Metering – The light information coming from above the 
scanner was used to determine the exposure setting of the camera.

17.4.5 Scan Fit

Scan Fit tab Scan Name – Name of the scan. Scans cannot be renamed.

Name – The name of the fit object.

Transformation

Position – The calculated position of the scan.

Orientation Axis – The calculated rotation axis of the scan. 

Angle – The calculated angle of rotation of the scan.

Click the Used button to check which registration method was performed.
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Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Target Tensions tab Normalized Tension – In most cases, this value is identical to the Point 
Distance (see below). It is only different if you have reference coordinates 
based on GPS measurements. For example if you use a GPS device to 
measure the position of a sphere, the position of the spheres is not very 
accurate. As a consequence, the Scan Fit cannot be as good as it normally is, 
and would show very large deviations.

In such cases the indicator of the Scan Fit quality should not base on this, 
therefore the Normalized Tension puts a lower weight on the GPS reference 
positions, leading to smaller numbers for the tension.

Point distance – The standard deviation of the distance between the local 
reference points and their corresponding references.

The traffic light indicates the quality of this individual criterion:

green: < 10mm

orange: ≥ 10mm and ≤ 20mm

red: > 20mm

Point drift – The mean value of the deviations between the local reference 
points and their corresponding references. In contrast to viewing purely the 
distance, the direction of the deviation is also taken into account here. 
Deviations can therefore cancel each other out. 

The traffic light indicates the quality of this individual criterion:

green: < 1mm

orange: ≥ 1mm and ≤ 5mm

red: > 5mm

Long. mismatch – The standard deviation of the longitudinal distance between 
the local reference points and their corresponding references. The longitudinal 
distance is the difference between the distance values to the scanner. 

The traffic light indicates the quality of this individual criterion:

green: < 10mm

orange: ≥ 10mm and ≤ 20mm

red: > 20mm

Angular mismatch – The standard deviation of the angular distance between 
the local reference points and the corresponding references. The angles are 
measured the local coordinate system of the scanner.

The traffic light indicates the quality of this individual criterion:

green: < 0.08°

orange: ≥ 0.08° and ≤ 0.17°

red: > 0.17°
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Orthogonal mismatch – The standard deviation of the orthogonal distance 
between the local reference points and the corresponding references. This is a 
way to express the angular mismatch as distance mismatch.

Inclinometer mismatch – Angular difference between the calculated orientation 
axis and the axis defined by the inclinometer. 

The traffic light indicates the quality of this individual criterion:

green: < 1°

orange: ≥ 1° and ≤ 5°

red: > 5°

List of targets used

Object – The name of the reference object. If reference object is a specific 
real reference, the full path of the corresponding object will be displayed; if 
referenced object is a virtual mean reference (mean reference from several 
scans) only its name will be displayed.

Distance – The distance between the local reference point and the 
corresponding global reference.

Long. – The longitudinal distance between local reference point and the 
corresponding global reference.

Angular – The angular distance between the local reference point and the 
corresponding global reference.

Orth. – The orthogonal distance between the local reference point and the 
corresponding global reference. 

The traffic light here is green if a minimum of three references (including 
the inclinometer) are available; it’s red if there are less than three 
references. 

When you press the View button, a 3D View will open which gives you an 
overview of the placement of the scanner and the local and global references.

Figure 17-6 Overview of references

17.4.7 Constraints Object

Name – The name of the constraints object.

Scanpoint Distance – A quality parameter of a plane.
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Max – The scan point distance of the plane with the highest distance. The 
traffic light indicates the quality of this individual criterion. It is green at 
values <4mm, red at values >20mm and orange between them.

Mean – The mean value of all managed planes. The traffic light indicates 
the quality of this individual criterion. It is green at values <4mm, red at 
values >20mm and orange between them.

Constraint Error – Constraints are implemented by functions that are zero if 
the constraint is met. Deviations from zero are called Constraint Error.

Max – Highest value of all constraint functions. The traffic light indicates the 
quality of this individual criterion. It is green at values <2.2e-013, red at 
values >1e-005 and orange between them.

Mean – Mean value of all constraint functions. The traffic light indicates the 
quality of this individual criterion. It is green at values <2.2e-013, red at 
values >1e-005 and orange between them.

Planes – Planes used to define constraints.

Plane – Name and path of the plane.

Fixed – Fixed planes are only used to define the constraint but will not be 
changed.

Constraints – List of pairs of planes and the constraint chosen for this pair.

Plane 1 – First plane.

Plane 2 – Second plane.

Description – The constraint chosen.

17.4.8 Constrained Plane Fit

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Plane Name – Name of the corresponding plane

Name – Name of the fit (by default named according to the constraints object 
that manages this fit)

Normal – The orientation determined by the fit. The orientation is given by the 
direction which stands perpendicular to the plane. 

Position – The position determined by the fit.

Number of scan points – The number of scan points in the selection used for 
the fit. The traffic light indicates the quality of this individual criterion. It is green 
at values >80, red at values <20 and orange between them.

Scan point distance – The standard deviation of the distance of the scan points 
from the calculated plane. The traffic light indicates the quality of this individual 
criterion. It is green at values <4mm, red at values >20mm and orange 
between them.

Scan point drift – The average distance of the scan points from the calculated 
plane. With this, the scan points above the plane can be averaged out with the 
scan points below the plane. The traffic light indicates the quality of this 
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individual criterion. It is green at values <1mm, red at values >5mm and 
orange between them.

Last Constraint – The name and path of the last constraints object that has 
been used to manage this fit.

17.4.9 Measurement

Overall Distance – Measured distance. When measuring between two points, 
the result will be the point-to-point distance. When using a plane or rectangle, 
the measurement is automatically taken perpendicular to this plane or 
rectangle. Note that negative distances will occur if the normal of the plane or 
rectangle points opposite direction.

Vertical Distance – Vertical part of the point-to-point distance.

Horizontal Distance – Horizontal part of the point-to-point distance.

Along X – The distance along the x axis of the point-to-point distance.

Along Y – The distance along the y axis of the point-to-point distance.

Show Distance – Select which values shall be shown in the views.

Measure Objects –List of objects that were used for the measurement. List is 
empty for point-to-point measurements.

17.4.10 Picture

General tab Name – The name of the object. The green traffic light right to the object name 
indicates that corresponding objects have been found in other scans. If 
corresponding references have not been found, no traffic light will be 
displayed. 

Layer – The representation layer on which the object is situated.

Picture Properties 
tab

Spherical – A checkmark to indicate spherical pictures.

17.4.11 Pipe

General tab Name – The name of the object. The green traffic light right to the object name 
indicates that corresponding objects have been found other scans. If 
corresponding references have not been found, no traffic light will be 
displayed. 

Layer – The representation layer on which the object is situated.

Pipe Properties tab Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Pipe Name – The name of the pipe. 

Axis – The axis of the pipe.

Position – The position of the pipe.

Diameter – The diameter of the pipe.
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Length – The length of the pipe.

17.4.12 Pipe Fit

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Pipe Name – The name of the corresponding pipe.

Name – The name of the fit object.

Axis – The axis determined by the fit. 

Position – The position determined by the fit.

Diameter – The diameter determined by the fit.

Length – The length determined by the fit.

Number of scan points – The number of scan points in the selection used for 
the fit.

The traffic light indicates the quality of this individual criterion:

green: >80 points

orange: ≥ 20 and ≤ 80 points

red: <20 points

Scan point distance – The standard deviation of the distance of the scan points 
from the calculated pipe. 

The traffic light indicates the quality of this individual criterion:

green: < 4mm

orange: ≥ 4mm and ≤ 20mm

red: >20 mm

Scan point drift – The average distance of the scan points from the calculated 
pipe. With this, the scan points inside the pipe can be averaged out with the 
scan points outside the pipe. 

The traffic light indicates the quality of this individual criterion:

green: < 1mm

orange: ≥ 1mm and ≤ 5mm

red: >5 mm

17.4.13 Plane

General tab Name – The name of the object. The green traffic light right to the object name 
indicates that corresponding objects have been found other scans. If 
corresponding references have not been found, no traffic light will be 
displayed. 

Use for Place Scans, Correspondence Search and Automatic Name – The 
object will be used for the registration. Correspondence relationships to this 
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object are enabled and its name will automatically be changed if 
corresponding objects have been found or the name of a corresponding object 
has been changed. 

Local reference objects will have this option activated by default if their name 
has not been changed by the user manually. 

Use for Place Scans and Correspondence Search – The object will be used for 
registering scans, correspondence relationships to this object are enabled but 
its name will not be changed automatically. This means that the name of this 
object is fixed and corresponding reference objects other scans will be named 
accordingly. 

Global reference objects and local references which have been (re-)named 
manually will have this option activated by default.

Use for Place Scans – The object will only be used for registering scans but 
excluded from any correspondence search. Its name will not be changed 
automatically. 

Ignore for Place Scans – The object will not be used for registering scans and 
is excluded from any correspondence search. Its name will not be changed 
automatically.

These options are relevant for the automatic correspondence search and for 
the registration of scans which are only available SCENE.

Layer – The representation layer on which the object is situated.

Plane Properties tab Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Normal – The orientation of the plane, given by the direction that stands 
perpendicular to the plane.

Position – A point of the plane.

17.4.14 Plane Fit

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Plane Name – The name of the corresponding plane. You can enter a name 
manually or choose one from the drop down menu. This menu contains the 
names of the last 10 fitted planes other scans and helps choosing the right 
name for the registration and accelerates the manual naming process.

Name – The name of the fit object.

Normal – The orientation determined by the fit. The orientation is given by the 
direction which stands perpendicular to the plane. 

Position – The position determined by the fit.

Number of scan points – The number of scan points in the selection used for 
the fit.

The traffic light indicates the quality of this individual criterion:
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green: >80 points

orange: ≥ 20 and ≤ 80 points

red: <20 points

Transversal normal deviation – The standard deviation of the normal, which is 
determined using the interim results of the fit. A high standard deviation 
indicates that the selected area is not as flat as it should be. There could be a 
ripple or there might be other objects in the plane. The standard deviation is 
broken down a transversal and longitudinal deviation. 

The traffic light indicates the quality of this individual criterion:

green: < 1°

orange: ≥ 1° and ≤ 2.29°

red: >2.29°

Longitudinal normal deviation – The standard deviation of the normal 
longitudinal direction. 

The traffic light indicates the quality of this individual criterion:

green: < 1.15°

orange: ≥ 1.15° and ≤ 2.29°

red: >2.29°

Scan point distance – The standard deviation of the distance of the scan points 
from the plane that has been determined. This is a good measurement for 
noise. 

The traffic light indicates the quality of this individual criterion:

green: < 4mm

orange: ≥ 4mm and ≤ 20mm

red: >20 mm

17.4.15 Limited Plane Fit

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Border Points – A list of all the corner points of the plane.

Plane Name – The name of the corresponding plane. You can enter a name 
manually or choose one from the drop down menu. This menu contains the 
names of the last 10 fitted planes other scans and helps choosing the right 
name for the registration and accelerates the manual naming process.

Name – The name of the fit object.

Normal – The orientation determined by the fit. The orientation is given by the 
direction which stands perpendicular to the plane. 

Position – The position determined by the fit.

Number of scan points – The number of scan points in the selection used for 
the fit.
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The traffic light indicates the quality of this individual criterion:

green: >80 points

orange: ≥ 20 and ≤ 80 points

red: <20 points

Transversal normal deviation – The standard deviation of the normal, which is 
determined using the interim results of the fit. A high standard deviation 
indicates that the selected area is not as flat as it should be. There could be a 
ripple or there might be other objects in the plane. The standard deviation is 
broken down a transversal and longitudinal deviation. 

The traffic light indicates the quality of this individual criterion:

green: < 1°

orange: ≥ 1° and ≤ 2.29°

red: >2.29°

Longitudinal normal deviation – The standard deviation of the normal 
longitudinal direction. 

The traffic light indicates the quality of this individual criterion:

green: < 1.15°

orange: ≥ 1.15° and ≤ 2.29°

red: >2.29°

Scan point distance – The standard deviation of the distance of the scan points 
from the plane that has been determined. This is a good measurement for 
noise. 

The traffic light indicates the quality of this individual criterion:

green: < 4mm

orange: ≥ 4mm and ≤ 20mm

red: >20 mm

17.4.16 Slab

General tab Name – The name of the object. The green traffic light right to the object name 
indicates that corresponding objects have been found other scans. If 
corresponding references have not been found, no traffic light will be 
displayed. 

Layer – The representation layer on which the object is situated.

Slab Properties tab Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Face – The visible face of the slab object.

Thickness – The thickness of the slab object.

Normal – The orientation of the slab, given by the direction that stands 
perpendicular to the slab.
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Position – A point of the slab.

17.4.17 Slab Fit

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Slab Name – The name of the corresponding slab. You can enter a name 
manually or choose one from the drop down menu. This menu contains the 
names of the last 10 fitted slabs other scans and helps choosing the right 
name for the registration and accelerates the manual naming process.

Face – The visible face of the slab object.

Thickness – The thickness of the slab object.

Name – The name of the fit object.

Normal – The orientation determined by the fit. The orientation is given by the 
direction which stands perpendicular to the plane. 

Position – The position determined by the fit.

Number of scan points – The number of scan points in the selection used for 
the fit.

The traffic light indicates the quality of this individual criterion:

green: > 80 points

orange: ≥ 20 and ≤ 80 points

red: < 20 points

Transversal Normal deviation – The standard deviation of the Normal, which is 
determined using the interim results of the fit. A high standard deviation 
indicates that the selected area is not as flat as it should be. There could be a 
ripple or there might be other objects in the plane. The standard deviation is 
broken down a transversal and longitudinal deviation.

The traffic light indicates the quality of this individual criterion:

green: < 1°

orange: ≥ 1° and ≤ 2.29°

red: > 2.29°

Longitudinal Normal deviation – The standard deviation of the Normal 
longitudinal direction.

The traffic light indicates the quality of this individual criterion:

green: < 1.15°

orange: ≥ 1.15° and ≤ 2.29°

red: > 2.29°

Scan point distance – The standard deviation of the distance of the scan points 
from the plane that has been determined. This is a good measurement for 
noise. 

The traffic light indicates the quality of this individual criterion:
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green: < 4mm

orange: ≥ 4mm and ≤ 20mm

red: > 20 mm

17.4.18 Point

General tab Name – The name of the object. The green traffic light right to the object name 
indicates that corresponding objects have been found other scans. If 
corresponding references have not been found, no traffic light will be 
displayed. 

Layer – The representation layer on which the object is situated.

Point Properties tab Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Position – The position of the point.

Add GPS Position – Add GPS information to the point.

17.4.19 Point Fit

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Point Name – The name of the corresponding point.

Name – The name of the fit object.

Position – The position determined by the fit.

Number of scan points – The number of scan points in the selection used for 
the fit. 

The traffic light indicates the quality of this individual criterion:

For (contrast) mean points:

green: > 80 points

orange: ≥ 20 and ≤ 80 points

red: < 20 points

For checkerboard points:

green: > 400 points

orange: ≥ 100 and ≤ 400 points

red: < 100 points

GPS Position – Enable to add a GPS position to the object. 

Format – Select to enter the GPS position either as coordinates decimal 
degree notation or UTM format.

Position – the GPS position decimal degree notation or UTM format.

Altitude – The altitude above sea level of the position.
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Accuracy – The accuracy of the position.

Only bright points – Is set for the contrast mean point of a selection.

Objects – When creating an intersection point, the fit is depending on the 
properties of the corresponding plane. This dependency is listed here.

17.4.20 Sphere

General tab Name – The name of the object. The green traffic light right to the object name 
indicates that corresponding objects have been found other scans. If 
corresponding references have not been found, no traffic light will be 
displayed. 

Use for Place Scans, Correspondence Search and Automatic Name – The 
object will be used for the registration. Correspondence relationships to this 
object are enabled and its name will automatically be changed if 
corresponding objects have been found or the name of a corresponding object 
has been changed. 

Local reference objects will have this option activated by default if their name 
has not been changed by the user manually. 

Use for Place Scans and Correspondence Search – The object will be used for 
registering scans, correspondence relationships to this object are enabled but 
its name will not be changed automatically. This means that the name of this 
object is fixed and corresponding reference objects other scans will be named 
accordingly. 

Global reference objects and local references which have been (re-)named 
manually will have this option activated by default.

Use for Place Scans – The object will only be used for registering scans but 
excluded from any correspondence search. Its name will not be changed 
automatically. 

Ignore for Place Scans – The object will not be used for registering scans and 
is excluded from any correspondence search. Its name will not be changed 
automatically.

These options are relevant for the automatic correspondence search and for 
the registration of scans which are only available SCENE.

Layer – The representation layer on which the object is situated.

Sphere tab Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Radius – The radius of the sphere.

Position – The position of the sphere mean point.

17.4.21 Sphere Fit

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.
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Sphere Name – The name of the corresponding sphere.

Name – The name of the fit object.

Radius – The sphere radius determined by the fit.

Position – The position of the sphere mean point determined by the fit. 

Number of scan points – The number of scan points in the selection used for 
the fit.

The traffic light indicates the quality of this individual criterion:

green: > 80 points

orange: ≥ 20 and ≤ 80 points

red: < 20 points

Radius deviation – The standard deviation of the radius, which is determined 
using the interim results of the fit.

The traffic light indicates the quality of this individual criterion:

green: < 1mm

orange: ≥ 1mm and ≤ 4mm

red: > 4mm

Position deviation – The standard deviation of the position of the sphere mean 
point, which is determined using the interim results of the fit.

The traffic light indicates the quality of this individual criterion:

green: < 15mm

orange: ≥ 15mm and ≤ 80mm

red: > 80mm

Scan point distance – The standard deviation of the distance of the scan points 
from the calculated sphere surface.

The traffic light indicates the quality of this individual criterion:

green: < 4mm

orange: ≥ 4mm and ≤ 20mm

red: > 20mm

Scan point drift – The average distance of the scan points from the calculated 
sphere surface. Scan points outside the sphere can be averaged out with scan 
point within the sphere.

The traffic light indicates the quality of this individual criterion:

green: < 1mm

orange: ≥ 1mm and ≤ 5mm

red: > 5mm

GPS Position – see fit of point object chapter Point Fit on page 294.
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17.4.22 Clipping Box

General tab Clipping – Select between hiding the points outside the Clipping Box (hide 
exterior) or inside the Clipping Box (hide interior).

Clipping Box enabled – Enable or disable clipping of the Clipping Box. When 
disabled, the points hidden by this box will be displayed again; the color of the 
Clipping Box boundaries and its icon in the Structure View change to gray.

Clipping Box visible – toggle visibility of the Clipping Box. Disabling the 
visibility of a Clipping Box will only hide its boundaries; the Clipping Box is still 
active (if clipping is enabled) and it still has effect on the visibility of the points 
in the 3D View.

Transformation tab Position – The translation portion of the transformation

X – To key in a transformation the x direction.

Y – To key in a transformation the y direction.

Z – To key in a transformation the z direction. 

Scroll bar – Set the transformation using the mouse. The direction of the 
transformation will be the x, y or z coordinate that is highlighted in yellow.

Each tick increments by – Set the increment for the scroll bar.

Rotation Angle – The angle of rotation if the rotation axis is split along the 
coordinate axes.

X – The angle of rotation around the x axis.

Y – The angle of rotation around the y axis.

Z – The angle of rotation around the z axis.

Scroll bar – Set a new angle of rotation.

To change a value, you can either enter the required value directly into the 
appropriate field, or you first select the field and then use the 
corresponding slider to change the value step by step. You can set the 
increment using the drop-down box. If you hit the edge with the slider, 
simply reselect the field and the slider will return to the center without you 
losing your previous changes.

Axis snap – If checked, you can change the rotation for the current axis 
independently from the others. This is achieved by changing the order in 
which the rotations are applied.

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner

17.4.23 Documentation Object

Global Coordinates – If checked, coordinates are displayed in the global 
coordinate system; else they are displayed in the coordinate system of the 
scanner.

Position – determines the position of the documentation object in the 
workspace.
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Description – detailed information about the documentation object.

Hyperlinks – hyperlinks to files or web sites. Add a new hyperlink by entering 
its address into the lower text field, then press Add. You can change the order 
of the hyperlinks with Up / Down, delete them with Remove or open them by 
double-clicking on the list item or by selecting the Open button.

17.4.24 Virtual Scan (3D Picture)

General tab Name – The name of the object. The green traffic light right to the object name 
indicates that corresponding objects have been found in other scans. If 
corresponding references have not been found, no traffic light will be 
displayed.

Use for Place Scans, Correspondence Search and Automatic Name – The 
object will be used for the registration. Correspondence relationships to this 
object are enabled and its name will automatically be changed if 
corresponding objects have been found or the name of a corresponding object 
has been changed. 

Local reference objects will have this option activated by default if their name 
has not been changed by the user manually. 

Use for Place Scans and Correspondence Search – The object will be used for 
registering scans, correspondence relationships to this object are enabled but 
its name will not be changed automatically. This means that the name of this 
object is fixed and corresponding reference objects in other scans will be 
named accordingly. 

Global reference objects and local references which have been (re-)named 
manually will have this option activated by default.

Use for Place Scans – The object will only be used for registering scans but 
excluded from any correspondence search. Its name will not be changed 
automatically. 

Ignore for Place Scans – The object will not be used for registering scans and 
is excluded from any correspondence search. Its name will not be changed 
automatically.

These options are relevant for the automatic correspondence search and for 
the registration of scans which are only available in SCENE.

Layer – The representation layer on which the object is situated.

Scan tab Size – The number of columns and rows. If a scan is loaded in reduced 
resolution, the reduced number of columns and rows is displayed and, in light 
gray underneath, the complete number of columns and rows.

Data loaded –indicates whether the scan is loaded.

Reference Scan –indicates whether the scan is used as a reference scan for 
registration.

Scan Fixed – Mark the scan alignment as fixed and exclude it from further 
automatic registration attempts.

Scanner Dist. Range – range of the scanner.
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Scanner Position – The position of the scanner with the mirror being the point 
of origin.

Orientation Axis – Rotation axis of the scan.

Orientation Angle – The scan’s angle of rotation.

Recording Date – The time the scan was recorded.

Scan Orig info – Additional information on the origin of the scan, for example, 
where it was recorded and information about issues (scanner warnings or 
errors) that occurred during recording of the scan.

Info – Further details that were provided when recording.
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Chapter 18: Error Messages

Chapter 18: Error Messages

The application must be started once by someone with sufficient privilege to 
register controls. Otherwise several modules won't work as expected. You 
should at least have “Power User” rights. – SCENE must be started at least 
once by a power user or administrator to ensure all functions can be executed 
smoothly.

Version of model is not supported – The workspace was saved with a later 
version of SCENE and cannot be read by your version. Use a later version of 
SCENE.

Version of scan is not supported – The scan was saved with a later version 
of SCENE and cannot be read by your version. Use a later version of SCENE.

Failed to rename 'Scan’. Renaming scan files is not permitted! – You 
cannot rename scans.

One or several objects failed to read in successfully. Please check 
properties of marked objects. – The workspace contains scans that do not 
exist as a file.

Not all contents of 'Object' were copied successfully. One or several 
children are bound to their original location. – When copying objects that 
were created by a fit, it is not possible to also copy the fit object to the new 
location. 

The move request was rejected, because either ‘Object’ or one of its 
children is bound to its current location. – Some objects cannot be moved 
or copied to different locations, for example fit objects, or unloaded pictures.
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Chapter 19: Frequently Asked Questions

Why can I not rename scans?

scans in the workspace must have the same name as the corresponding scan 
file on your data medium. You cannot rename the scan file at the same time as 
the scan the in workspace because scans can be used in several workspaces 
simultaneously.

Why do I always get the message “Load data reduced size” when 
loading scans?

Check settings the under Tools > Options > Scan Data. The maximum scan 
size permitted is set there. You can lift the size restriction by setting the setting 
to unlimited.

Why does my license not work any more?

The license is linked to the Ethernet address of your network card. When 
checking the license, SCENE compares the Ethernet address of the network 
card with the saved license. Unfortunately, a lot of network cards hide the 
Ethernet address if you are not physically connected to a network.

Why is the scan loaded even when starting a Quick View?

The Quick View is normally saved in the scan. If this is not the case for a 
scan, SCENE has to first load the scan before it can display the Quick View. If 
the security settings permit it, SCENE then writes the Quick View in the scan, 
so that next time you open the Quick View, it is no longer necessary to load.

When I call the context menu, why do I sometimes get the dialog to 
select the object?

If several objects are lying next to one another or objects are lying within the 
selection, SCENE has to ask which object you mean.

Why can I no longer load some scans?

Some virus scanners have problems with the extensive scan files. Disable the 
virus scanner when working with SCENE.

Why do I get a black window when opening the 3D View?

SCENE requires a graphics card that supports OpenGL 2.0 or higher. If your 
graphics card supports older versions only, the 3D View might not work on it. 
Switching off the advanced textures and/or off-screen rendering under Tools > 
Options > View might solve this. When switching off advanced textures, the 
stereoscopic view is not available anymore. When switching off onscreen 
rendering, the stereoscopic view, the clear view and gap filling are not 
available anymore.

Why is the rendering performance in the 3D View slow or intermittent?

On systems equipped with NVIDIA Quadro graphics processors, rendering 
performance in 3D View might be slow or intermittent. In order to improve 
rendering performance, start the NVIDIA Control Panel application (available 
in the Windows Control Panel) and select the global preset 3D App – Game 
Development from the Global Settings tab.
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Why don’t I get the most current position and orientation when I open an 

fls scan file in a 3rd party application?

Point data and transformation information for scans may be stored in separate 
revisions. If you want to make sure that an fls scan file contains the most 
current transformation, you need to use the command Export as Project in 
the context menu of the scans or scan folders.

Visit the FARO Customer Service area on the Web at www.faro.com to search 
our technical support database.
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Chapter 20: Glossary

Context menu – a menu with commands that can be applied to the object 
selected. It appears if you click an object with the right mouse button.

Fit object – an auxiliary object created by the object fit that stores the 
selection used for the fit and the quality values of the fit.

Folder – an object type which stores any objects other than scans. It is similar 
to the Windows file system folder. The complement to this is the Scan Folder, 
in which scans are received.

Layer – is used to draw a grouping of objects in order to be able to control the 
visibility of objects.

Measurements – in the Structure View a visible object of the workspace. It 
contains the measurement logs.

Menu bar – the top horizontal section in the SCENE screen. The menu bar 
contains all the menus with commands for the general operation. Further 
commands can be found in the toolbars and context menus.

Models – in the Structure View a visible object of the workspace. It contains 
the CAD objects.

Object – Objects are abstract shapes included in a scan, like spheres, planes, 
slabs.

Object fit – ascertaining the best fitting object parameters possible from the 
scan points.

Project Point Cloud – consists of the points of all the scans within a scan 
project and can be seen as a comprehensive point cloud of the complete scan 
project. It is typically created from all the single scans in the project after they 
have been preprocessed, colorized and registered.

Registration – Registration means the process of determining the spatial 
relationship between scans.

References – in the Structure View a visible object of the workspace. It 
contains the reference objects for positioning scans (for example, survey 
coordinates) and should not be renamed.

Scan Folder – An object type that receives scans. It is similar to the Windows 
file system folder. The complement to this is the folder, in which all other 
objects are received.

Scan – A scan is the scan file as it is recorded by the scanner with its millions 
of data records that include position, reflectance, and color for single scan 
points. A scan consists of scan points that were recorded from a single 
scanner location. Its points are organized in a row column order.

Scan Point Cloud – A scan point cloud is an alternative representation of a 
scan. It has to be created from a single scan and is organized in a spatial data 
structure that facilitates fast visualization of scan points and automated point 
loading based on point visibility.

Scan Project – In SCENE a scan project can be seen as a central storage 
which contains all the shared data of a project that all team members can 
access. This includes the project workspace, scan project revisions, the 
project point cloud, SCENE WebShare Cloud data and much more.
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Scans – a visible object of the workspace in the Structure View. It is a kind 
of Scan Folder and contains Scans.

Status bar – the bottom horizontal section on the SCENE screen. The status 
bar displays command details or responses to the last command executed as 
well as scan point data. 

Structure View – shows the structure of the workspace, including subfolders 
and objects.

Target – scan points or objects in a scan which can be used for registration.

Toolbar – a toolbar has buttons with which you can easily start commands. 
SCENE has many toolbars, which you can hide or unhide where necessary. 
Toolbars are mostly situated the in upper area of the screen, below the menu 
bar.

Workspace – the combination of all data required to process and analyze 
scans. This includes scans, CAD data, survey data, measurement results and 
much more.

Project Workspace – is the workspace of the centrally provided scan project. 
It contains the shared data of the scan project.

Local Workspace – contains private and non-shared data owned and is 
maintained by the individual user. It is typically saved to the local hard disk of 
the individual user and is linked to a centrally provided scan project. Changes 
done on the basis of a local workspace will not change the data of the scan 
project until it is explicitly shared with the scan project. Sharing the local 
changes with the scan project will update the project data and the project 
workspace accordingly.
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Appendix A: Technical Support

FARO Technologies, Inc. is committed to providing the best technical support 
to our customers. If you have any problem using one of our products, follow 
these steps before contacting our Technical Support Team:

• Be sure to read the relevant sections of the documentation to find the help
you need.

• Visit the FARO Customer Care area on the Web at www.faro.com to search
our technical support database. This is available 24 hours a day 7 days a
week.

• Document the problem you are experiencing. Be as specific as you can.
The more information you have, the easier the issue will be to solve.

• Email or faxes sent outside regular working hours usually are answered
before 12:00 p.m. In the next working day. Should our staff be on other
calls, leave a voice mail message; calls are always returned within 24
hours. Remember to leave a detailed description of your question. Do not
forget to include your name, fax number, telephone number and extension
so we can reach you promptly.

North America Support Hours (Monday through Friday)

8:00 a.m. to 7:00 p.m. Eastern Standard Time (EST)

email: support@faro.com

Phone: +1 800 736 2771, +1 407 333 3182 (Worldwide)

Mexico: 866-874-1154

Fax: +1 407-562-5294

Europe Support Hours (Monday through Friday)

8:00 a.m. to 5:00 p.m. Central European Standard Time 
(CET)

email: support.emea@faro.com

Phone: +800 3276 7378, +49 7150 9797-400 
(Worldwide)

Fax: +800 3276 1737, +49 7150 9797-9400 (Worldwide)

Asia Support Hours (Monday through Friday)

8:30 a.m. to 5:30 p.m. Singapore Standard Time (SST)

email: supportap@faro.com

Phone: +1 800 511 1360, +65 6511 1350 (Worldwide)

Fax: +65 6543 0111
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End User 
Documents 

All documents related to the Software End User License Agreement, Purchase 
Conditions, and FARO Products Service Policy can be found on the FARO 
Knowledge Base at the following URL: 
knowledge.faro.com/Essentials/General/FARO_End_User_License_Agreeme
nt_Location.

Japan Support Hours (Monday through Friday)

9:00 a.m. to 5:00 p.m. Japan Standard Time (JST)

email: supportjapan@faro.com

Phone: +81 561 63 1411 (Worldwide)

Fax: +81 561 63 1412

China Support Hours (Monday through Friday)

8:30 a.m. to 5:30 p.m. China Standard Time (CST)

email: supportchina@faro.com

Phone: +400.677.6826

Fax: +86 21 6494 8670

India Support Hours (Monday through Friday)

9:30 a.m. to 5:30 p.m. India Standard Time (IST)

email: supportindia@faro.com

Phone: 1800.1028456

Fax: +91 11.4646.5660
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Appendix B: Software License Agreement

This Software License Agreement is part of the Operating Manual for the 
product and software System which you have purchased from FARO 
TECHNOLOGIES, INC. (collectively, the “Licenser”) By your use of the 
software you are agreeing to the terms and conditions of this Software License 
Agreement. Throughout this Software License Agreement, the term 
“Licensee” means the owner of the System.

I. The Licenser hereby grants the Licensee the non-exclusive right to use the
computer software described in this Operating Manual (the “software”). The
Licensee shall have no right to sell, assign, sub-license, rent or lease the
software to any third party without the Licenser’s prior written consent.

II. The Licenser further grants the Licensee the right to make a backup copy
of the software media. The Licensee agrees that it will not decompile,
disassemble, reverse engineer, copy, transfer, or otherwise use the software
except as permitted by this section. The Licensee further agrees not to copy
any written materials accompanying the software.

III. The Licensee is licensed to use the Software only in the manner described
in the Operating Manual. Use of the Software in a manner other than that
described in the Operating Manual or use of the software in conjunction with
any non-Licenser product which decompiles or recompiles the software or in
any other way modifies the structure, sequence or function of the software
code, is not an authorized use, and further, such use voids the Licenser’s set
forth below.

IV. The only warranty with respect to the software and the accompanying
written materials is the warranty, if any, set forth in the Quotation/Purchase
Order pursuant to which the software was purchased from the Licenser.

V. THIS WARRANTY IS IN LIEU OF OTHER WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
WITH RESPECT TO THE SOFTWARE AND WRITTEN MATERIALS. IN NO
EVENT WILL THE LICENSER BE LIABLE FOR DAMAGES, INCLUDING
ANY LOST PROFITS OR OTHER INCIDENTAL OR CONSEQUENTIAL
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
SOFTWARE, NOTWITHSTANDING THAT THE LICENSER HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, THE LICENSER
WILL NOT BE LIABLE FOR ANY SUCH CLAIM BY ANY OTHER PARTY.

VI. In the event of any breach by the Licensee of this Agreement, the license
granted hereby shall immediately terminate and the Licensee shall return the
software media and all written materials, together with any copy of such media
or materials, and the Licensee shall keep no copies of such items.

VII.The interpretation of this Agreement shall be governed by the following
provisions:

A.This Agreement shall be construed pursuant to and governed by the
substantive laws of the State of Florida (and any provision of Florida law
shall not apply if the law of a state or jurisdiction other than Florida would
otherwise apply).

B. If any provision of this Agreement is determined by a court of competent
jurisdiction to be void and non-enforceable, such determination shall not
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affect any other provision of this Agreement, and the remaining provisions 
of this Agreement shall remain in full force and effect. If any provision or 
term of this Agreement is susceptible to two or more constructions or 
interpretations, one or more of which would render the provision or term 
void or non-enforceable, the parties agree that a construction or 
interpretation which renders the term of provision valid shall be favored.

C.This Agreement constitutes the entire Agreement, and supersedes all
prior agreements and understandings, oral and written, among the parties
to this Agreement with respect to the subject matter hereof.

VIII.If a party engages the services of an attorney or any other third party or in
any way initiates legal action to enforce its rights under this Agreement, the
prevailing party shall be entitled to recover all reasonable costs and expenses
(including reasonable attorney’s fees before trial and in appellate
proceedings).
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250 Technology Park

Lake Mary, FL 32746

800-736-2771 U.S. / +1 407-333-3182 Worldwide

Email: support@faro.com

FARO Europe GmbH & Co. KG

Lingwiesenstrasse 11/2

D-70825 Korntal-Münchingen, Germany

FREECALL +800 3276 73 78 / +49 7150/9797-400

FREEFAX +800 3276 1737 / +49 7150/9797-9400

Email: support@faroeurope.com

FARO Singapore Pte. Ltd.

No. 03 Changi South Street 2

#01-01 Xilin Districentre Building B

SINGAPORE 486548

TEL: +65 6511.1350

Email: supportap@faro.com

FARO Japan,c.

716 Kumada, Nagakute-City,

Aichi, 480-1144, Japan

Tel: 0120-922-927, 0561-63-1411

FAX:0561-63-1412

Email: supportjapan@faro.com

FARO (Shanghai) Co., Ltd.

1/F, Building No. 2,

Jux Information Technology Park

188 Pingfu Road, Xuhui District

Shanghai 200231, China

Tel.: 400.677.6826

Email: supportchina@faro.com

FARO Business Technologies India Pvt. Ltd.

E-12, B-1 Extension,

Mohan Cooperative Industria Estate,

New Delhi-110044, India

Tel.: 1800.1028456

Email: supportindia@faro.com
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